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4.1. Introduction

Interpolation
GMS contains a powerful suite of interpolation tools. You can interpolate to TINs, 2D meshes, 2D grids, 3D meshes,
and 3D grids. The following types of interpolation are available in GMS:
•• Linear
•• Inverse Distance Weighted
•• Clough-Tocher
•• Natural Neighbor
•• Kriging
•• Gaussian Field Generator
GMS also supports Jackknifing, which is used to compare interpolation schemes.
In addition to interpolating scalar values, GMS also supports interpolation of materials with T-PROGS. The
T-PROGS software is used to perform transition probability geostatistics on borehole data.
How To Interpolate in GMS Interpolation is performed using the 2D Scatter Points and the 3D Scatter Points. To
interpolate values from a scatter set you either right-click on a scatter set in the Project Explorer and select the
Interpolate to command or select the command from the Interpolation menu. The commands in the Interpolation
menu act on the "active" item in the Project Explorer.

http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Linear
http://www.xmswiki.com/xms/index.php?title=GMS:Inverse_Distance_Weighted
http://www.xmswiki.com/xms/index.php?title=GMS:Clough-Tocher
http://www.xmswiki.com/xms/index.php?title=GMS:Natural_Neighbor
http://www.xmswiki.com/xms/index.php?title=GMS:Kriging
http://www.xmswiki.com/xms/index.php?title=GMS:Gaussian_Field_Generator
http://www.xmswiki.com/xms/index.php?title=GMS:Jackknifing
http://www.xmswiki.com/xms/index.php?title=GMS:T-PROGS
http://www.xmswiki.com/xms/index.php?title=GMS:Boreholes
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Scatter_Point_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Scatter_Point_Module
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Interpolation_Options
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
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Interpolation Commands
Once a 3D interpolation scheme has been selected and the appropriate parameters for the selected scheme have been
input, the dataset of the active scatter point set can be interpolated to another object. During the interpolation
process, a new dataset is constructed for the target object containing the interpolated values. A separate interpolation
command is provided for interpolating to each of the target objects. The interpolation commands are found in the
Interpolation menu. The commands are as follows:
• Interpolate → Active TIN

The Interpolate to Active TIN command interpolates to the vertices of the active TIN.
• Interpolate → 2D Mesh

The Interpolate to 2D Mesh command interpolates to the nodes of the 2D finite element mesh.
• Interpolate → 2D Grid

The Interpolate to 2D Grid command interpolates to the 2D finite difference grid. The interpolation is
done either to the grid nodes or to the grid cell centers depending on whether the grid is a mesh-centered
or cell-centered grid. (See 2D Grid Types)

• Interpolate → 3D Mesh

The Interpolate to 3D Mesh command interpolates to the nodes of the 3D finite element mesh.
• Interpolate → 3D Grid

The Interpolate to 3D Grid command interpolates to the 3D finite difference grid. The interpolation is
done either to the grid nodes or to the grid cell centers depending on whether the grid is a mesh-centered
or cell-centered grid. (See 2D Grid Types)

• Interpolate → MODFLOW Layers

The Interpolate to MODFLOW Layers commmand lets you interpolate from 2D scatter data to
MODFLOW data: top and bottom layer elevations, LPF array data (HK, VK, etc), recharge.

• Interpolate → UGrid

The Interpolate to UGrid command interpolates to the cells of the active UGrid.
•• Gaussian Simulation Options

Gaussian Sequential Simulation (GSS) is a form of Kriging that can only be used for 2D interpolation
and only works when interpolating to 3D cell-centered grids.

•• Jackknifing

3D Jacknifing identical to 2D Jacknifing.
When one of the interpolation commands is selected, the Interpolate dialog appears.

http://www.xmswiki.com/xms/index.php?title=GMS:2D_Grid_Module%23Grid_Types
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Grid_Module%23Grid_Types
http://www.xmswiki.com/xms/index.php?title=GMS:Interpolate_to_MODFLOW_Layers
http://www.xmswiki.com/xms/index.php?title=GMS:Gaussian_Field_Generator
http://www.xmswiki.com/xms/index.php?title=GMS:Jackknifing
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3D Interpolation Options

The 3D Interpolation Options dialog.

3D scatter point sets are used for
interpolation to other data types such
as grids and meshes. Interpolation is
useful for such tasks as iso-surface
rendering or setting up input data for a
model. Since no interpolation scheme
is superior in all cases, several
interpolation techniques are provided
in GMS.

The basic approach to performing an
interpolation is to select an appropriate
interpolation scheme and interpolation
parameters, and then interpolate to the
desired object using one of the
interpolation commands (to 3D Grid,
to 3D Mesh, etc.) described below.

The interpolation options are selected using the 3D Interpolation Options dialog which is accessed through the
Interpolation Options command in the Interpolation menu. Once a set of options is selected, those options are used
for all subsequent interpolation commands. The options in the 3D Interpolation Options dialog are as follows:

Active Dataset
Interpolation is always performed using the active dataset of the active scatter point set. The active dataset is
normally selected in the Project Explorer. The name of the current active dataset is listed at the top of the 3D
Interpolation Options dialog.
If the active dataset is transient then more interpolation options are available. (see Steady State vs. Transient
Interpolation)

Interpolation Methods
The following methods are supported for 3D interpolation in GMS:
•• Inverse Distance Weighted Interpolation
•• Kriging
Log interpolation is also supported.

Anisotropy
Sometimes the data associated with a scatter point set will have directional tendencies. The azimuth and horizontal
anisotropy allow the user to take into account these tendencies.

http://www.xmswiki.com/xms/index.php?title=File%3A3DinterpolationOpts.jpg
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Scatter_Point_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Interpolation
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Datasets
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=GMS:Steady_State_vs._Transient_Interpolation
http://www.xmswiki.com/xms/index.php?title=GMS:Steady_State_vs._Transient_Interpolation
http://www.xmswiki.com/xms/index.php?title=GMS:Inverse_Distance_Weighted
http://www.xmswiki.com/xms/index.php?title=GMS:Kriging
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Interpolation_Options
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Vertical Anisotropy

In 3D, vertical anisotropy is also available. In previous versions of GMS the user could enter a Z scale. Vertical
anisotropy is 1 over the Z scale. This notation was changed to be consistent with Kriging.
Occasionally, scatter point sets are sampled along vertical traces. In such cases, the distances between scatter points
along the vertical traces are an order of magnitude smaller than the distances between scatter points along the
horizontal plane. For example, if the scatter point set was obtained from borehole data, the distance between scatter
points may be a few centimeters, whereas the distance between boreholes may be several meters. This disparity in
scaling causes clustering and can be a source of poor results in some interpolation methods.
The effects of clustering along vertical traces can be minimized using the vertical anisotropy option in the 3D
Interpolation Options dialog. The Z coordinate of each of the scatter points is multiplied by 1 / the vertical
anisotropy parameter prior to interpolation. Thus, if the vertical anisotropy parameter is less than 1.0, scatter points
along the same vertical axis appear farther apart than they really are and scatter points in the same horizontal plane
appear closer than they really are. As a result, points in the same horizontal plane are given a higher relative weight
than points along the Z axis. This can result in improved accuracy, especially in cases where the horizontal
correlation between scatter points is expected to be greater than the vertical correlation (which is typically the case in
soils since soils are deposited in horizontal layers).

Assign default extrapolation value to hidden objects
This option will assign the default extrapolation value to all cells that are hidden using the Hide command in the
Display | Visibility menu option (see Display Menu).

Truncation
When interpolating a set of values, it is sometimes useful to limit the interpolated values to lie between a minimum
and maximum value. For example, when interpolating contaminant concentrations, a negative value of concentration
is meaningless. However, many interpolation schemes will produce negative values even if all of the scatter points
have positive values. This occurs in areas where the trend in the data is toward a zero value. The interpolation may
extend the trend beyond a zero value into the negative range. In such cases it is useful to limit the minimum
interpolated value to zero. Interpolated values can be limited to a given range by selecting the Truncate values option
in the 3D Interpolation Options dialog.

http://www.xmswiki.com/xms/index.php?title=GMS:Display_Menu
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Steady State vs. Transient Interpolation
If the active dataset happens to be a transient dataset, two options are available:
1.1. Steady state interpolation can be performed using only the selected time step of the active dataset.
2.2. Transient interpolation can be performed using all of the time steps.
By default, only the selected time step is used. The time step is shown next to the dataset name at the top of the
dialog. All of the time steps can be selected by selecting the Use all time steps toggle next to the Time step combo
box. If all time steps are chosen, GMS begins with the first time step in the list and repeatedly interpolates from the
scatter point set to the target object, one time step at a time, for all of the time steps. As a result, a dataset is created
on the target object with a set of time steps matching the time steps on the scatter point set.
When performing transient interpolation with the kriging option, special care should be taken with regard to the
variogram. Since each time step represents a separate set of data, technically, a separate variogram (or set of
variograms) should be created for each time step (GMS stores a separate variogram for each step). This can be
accomplished by selecting each time step one at a time using the Time step combo box at the top of the Interpolation
Options dialog, and creating a new variogram for each time step.

http://www.xmswiki.com/xms/index.php?title=GMS:Kriging
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4.2. Linear

Linear
If the linear interpolation scheme is selected, the 2D scatter points are first triangulated to form a temporary TIN.
The TIN is a network of triangles connecting the scatter points together. It is used to interpolate from the scatter
points to another object such as a grid or a mesh.
The equation of the plane defined by the three vertices of a triangle is as follows:

where A, B, C, and D are computed from the coordinates of the three vertices (x1,y1,z1), (x2,y2,z2), & (x3,y3,z3):

The plane equation can also be written as:

which is the form of the plane equation used to compute the elevation at any point on the triangle.
Since a TIN only covers the convex hull of a scatter point set, extrapolation beyond the convex hull is not possible
with the linear interpolation scheme. Any points outside the convex hull of the scatter point set are assigned the
default extrapolation value entered at the bottom of the Interpolation Options dialog. The figure below shows a 2D
scatter point set (small red triangles in GMS) being interpolated to a 2D grid. The green lines represent a TIN
constructed from a scatter point set. The thick blue line represents the convex hull of the dataset. No extrapolation
will occur outside of this thick blue line (picture is not representative of this description).

Convex Hull of a Scatter Point Set

http://www.xmswiki.com/xms/index.php?title=GMS:2D_Scatter_Point_Module
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
http://www.xmswiki.com/xms/index.php?title=File:Linear_eq1.jpg
http://www.xmswiki.com/xms/index.php?title=File%3AConvex_hull.jpg
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4.3. Inverse Distance Weighted

Inverse Distance Weighted

An example of the IDW Interpolation Options dialog.

One of the most commonly used techniques for interpolation of
scatter points is inverse distance weighted (IDW) interpolation.
Inverse distance weighted methods are based on the assumption
that the interpolating surface should be influenced most by the
nearby points and less by the more distant points. The
interpolating surface is a weighted average of the scatter points
and the weight assigned to each scatter point diminishes as the
distance from the interpolation point to the scatter point increases.
Several options are available for inverse distance weighted
interpolation. The options are selected using the IDW Interpolation
Options dialog. This dialog is accessed through the Options
button next to the Inverse distance weighted item in the 2D
Interpolation Options (3D Interpolation Options) dialog. The
options in the dialog are as follows:

•• Shepards Method
•• Gradient Plane Nodal Functions
•• Quadratic Nodal Functions
•• Subset Definition

http://www.xmswiki.com/xms/index.php?title=File%3A3dIDWinterpolationOpts.jpg
http://www.xmswiki.com/xms/index.php?title=GMS:Shepards_Method
http://www.xmswiki.com/xms/index.php?title=GMS:Gradient_Plane_Nodal_Functions
http://www.xmswiki.com/xms/index.php?title=GMS:Quadratic_Nodal_Functions
http://www.xmswiki.com/xms/index.php?title=GMS:Subset_Definition
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Shepards Method
The simplest form of inverse distance weighted interpolation is sometimes called "Shepard's method" (Shepard
1968). The equation used is as follows:

where n is the number of scatter points in the set, fi are the prescribed function values at the scatter points (e.g., the
dataset values), and wi are the weight functions assigned to each scatter point. The classical form of the weight
function is:

where p is an arbitrary positive real number called the weighting exponent and is defaulted to 2. The weighting
exponent can be modified by turning on the Use classic weight function option. hi is the distance from the scatter
point to the interpolation point or

where (x,y) are the coordinates of the interpolation point and (xi,yi) are the coordinates of each scatter point. The
weight function varies from a value of unity at the scatter point to a value approaching zero as the distance from the
scatter point increases. The weight functions are normalized so that the weights sum to unity.
Although the weight function shown above is the classical form of the weight function in inverse distance weighted
interpolation, the following equation is used in GMS:

where hi is the distance from the interpolation point to scatter point i, R is the distance from the interpolation point to
the most distant scatter point, and n is the total number of scatter points. This equation has been found to give
superior results to the classical equation (Franke & Nielson, 1980).
The weight function is a function of Euclidean distance and is radially symmetric about each scatter point. As a
result, the interpolating surface is somewhat symmetric about each point and tends toward the mean value of the
scatter points between the scatter points. Shepard's method has been used extensively because of its simplicity.

3D Interpolation
The 3D equations for Shepard's method are identical to the 2D equations except that the distances are computed
using:

where (x,y,z) are the coordinates of the interpolation point and (xi,yi,zi) are the coordinates of each scatter point.

http://www.xmswiki.com/xms/index.php?title=File:Shep_eq1.jpg
http://www.xmswiki.com/xms/index.php?title=File:Shep_eq2.jpg
http://www.xmswiki.com/xms/index.php?title=File:Shep_eq3.jpg
http://www.xmswiki.com/xms/index.php?title=File:Shep_eq4.jpg
http://www.xmswiki.com/xms/index.php?title=File:Shep_eq5.jpg
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Gradient Plane Nodal Functions
A limitation of Shepard's method is that the interpolating surface is a simple weighted average of the data values of
the scatter points and is constrained to lie between the extreme values in the dataset. In other words, the surface does
not infer local maxima or minima implicit in the dataset. This problem can be overcome by generalizing the basic
form of the equation for Shepard's method in the following manner:

where Qi are nodal functions or individual functions defined at each scatter point (Franke 1982; Watson & Philip
1985). The value of an interpolation point is calculated as the weighted average of the values of the nodal functions
at that point. The standard form of Shepard's method can be thought of as a special case where horizontal planes
(constants) are used for the nodal functions. The nodal functions can be sloping planes that pass through the scatter
point. The equation for the plane is as follows:

where fx and fy are partial derivatives at the scatter point that have been previously estimated based on the geometry
of the surrounding scatter points. Gradients are estimated in GMS by first triangulating the scatter points and
computing the gradient at each scatter point as the average of the gradients of each of the triangles attached to the
scatter point.
The planes represented by the above equation are sometimes called "gradient planes". By averaging planes rather
than constant values at each scatter point, the resulting surface infers extremities and is asymptotic to the gradient
plane at the scatter point rather than forming a flat plateau at the scatter point.

3D Interpolation
The 3D equivalent of a gradient plane is a "gradient hyperplane." The equation of a gradient hyperplane is as
follows:

where fx, fy, and fz are partial derivatives at the scatter point that are estimated based on the geometry of the
surrounding scatter points. The gradients are found using a regression analysis which constrains the hyperplane to
the scatter point and approximates the nearby scatter points in a least squares sense. At least five non-coplanar scatter
points must be used.

http://www.xmswiki.com/xms/index.php?title=GMS:Shepards_Method
http://www.xmswiki.com/xms/index.php?title=File:Gradplanenode1.jpg
http://www.xmswiki.com/xms/index.php?title=File:Gradplanenode2.jpg
http://www.xmswiki.com/xms/index.php?title=File:Gradplanenode3.jpg
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Quadratic Nodal Functions
The nodal functions used in inverse distance weighted interpolation can be higher degree polynomial functions
constrained to pass through the scatter point and approximate the nearby points in a least squares manner. Quadratic
polynomials have been found to work well in many cases (Franke & Nielson 1980; Franke 1982). The resulting
surface reproduces local variations implicit in the dataset, is smooth, and approximates the quadratic nodal functions
near the scatter points. The equation used for the quadratic nodal function centered at point k is as follows:

To define the function, the six coefficients ak1..ak6 must be found. Since the function is centered at the point k and
passes through point k, we know beforehand that ak1=fk where fk is the function value at point k. The equation
simplifies to:

Now there are only five unknown coefficients. The coefficients are found by fitting the quadratic to the nearest NQ
scatter points using a weighted least squares approach. In order for the matrix equation used to solve for the
coefficients to be stable, there should be at least five scatter points in the set.

3D Interpolation

For 3D interpolation, the following equation is added to the quadratic nodal function:

To define the function, the ten coefficients ak1..ak10 must be found. Since the function is centered on point k, we
know that ak1=fk where fk is the data value at point k. The equation simplifies to:

Now there are only nine unknown coefficients. The coefficients are found by fitting the quadratic to a subset of the
neighboring scatter points in a weighted least squares fashion. In order for the matrix equation used to be solve for
the coefficients to be stable, there should be at least ten non-coplanar scatter points in the set.

http://www.xmswiki.com/xms/index.php?title=File:Quadnodef2.jpg
http://www.xmswiki.com/xms/index.php?title=File:Quadnodef3.jpg
http://www.xmswiki.com/xms/index.php?title=File:Quadnodef4.jpg
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Subset Definition
In the IDW Interpolation Options dialog, an option is available for using a subset of the scatter points (as opposed to
all of the available scatter points) in the computation of the nodal function coefficients and in the computation of the
interpolation weights. Using a subset of the scatter points drops distant points from consideration since they are
unlikely to have a large influence on the nodal function or on the interpolation weights. In addition, using a subset
can speed up the computations since less points are involved.
If the Use subset of points option is chosen, the Subsets button can be used to bring up the Subset Definition dialog.
Two options are available for defining which points are included in the subset. In one case, only the nearest N points
are used. In the other case, only the nearest N points in each quadrant are used as shown below. This approach may
give better results if the scatter points tend to be clustered.

The Four Quadrants Surrounding an
Interpolation Point.

The Subset Definition dialog.

If a subset of the scatter point set is being used for
interpolation, a scheme must be used to find the nearest N
points. Two methods for finding a subset are provided in the
Subset Definition dialog: the Global Method and the Local
Method.

Global Method

With the global method, each of the scatter points in the set
are searched for each interpolation point to determine which
N points are nearest the interpolation point. This technique is
fast for small scatter point sets but may be slow for large
sets.

Local Method
With the local methods, the scatter points are triangulated to form a temporary TIN before the interpolation process
begins. To compute the nearest N points, the triangle containing the interpolation point is found and the triangle
topology is then used to sweep out from the interpolation point in a systematic fashion until the N nearest points are
found. The local scheme is typically much faster than the global scheme for large scatter point sets.

http://www.xmswiki.com/xms/index.php?title=File%3AIdw_fig1.gif
http://www.xmswiki.com/xms/index.php?title=File%3ASubsetDefinition.jpg
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Computation of Interpolation Weights
When computing the interpolation weights, three options are available for determining which points are included in
the subset of points used to compute the weights and perform the interpolation: subset, all points, and enclosing
triangle.

Subset of Points
If the Use subset of points option is chosen, the Subset Definition dialog can be used to define a local subset of
points.

All Points
If the Use all points option is chosen, a weight is computed for each point and all points are used in the
interpolation.

Enclosing Triangle
The Use vertices of enclosing triangle method makes the interpolation process a local scheme by taking advantage of
TIN topology (Franke & Nielson, 1980). With this technique, the subset of points used for interpolation consists of
the three vertices of the triangle containing the interpolation point. The weight function or blending function
assigned to each scatter point is a cubic S-shaped function as shown in part a of the figure below. The fact that the
slope of the weight function tends to unity at its limits ensures that the slope of the interpolating surface is
continuous across triangle boundaries.

(a) S-Shaped Weight Function and (b) Delauney Point Group for
Point A.

The influence of the weight function extends over the limits of the Delauney point group of the scatter point. The
Delauney point group is the "natural neighbors" of the scatter point, and the perimeter of the group is made up of the
outer edges of the triangles that are connected to the scatter point as shown in part b. The weight function varies
from a weight of unity at the scatter point to zero at the perimeter of the group. For every interpolation point in the
interior of a triangle there are three nonzero weight functions (the weight functions of the three vertices of the
triangle). For a triangle T with vertices i, j, & k, the weights for each vertex are determined as follows:

Where ||ei|| is the length of the edge opposite vertex i, and bi, bj, bk are the area coordinates of the point (x,y) with
respect to triangle T.
Area coordinates are coordinates that describe the position of a point within the interior of a triangle relative to the
vertices of the triangle. The coordinates are based solely on the geometry of the triangle. Area coordinates are
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sometimes called "barycentric coordinates." The relative magnitude of the coordinates corresponds to area ratios as
shown below:

Barycentric Coordinates for a Point in a Triangle.

The XY coordinates of the interior point can be written in terms of the XY coordinates of the vertices using the area
coordinates as follows:

Solving the above equations for bi, bj, and bk yields:

Using the weight functions defined above, the interpolating surface at points inside a triangle is computed as:

where wi, wj, and wk are the weight functions and Qi, Qj, and Qk are the nodal functions for the three vertices of the
triangle.
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4.4. Clough-Tocher

Clough-Tocher
The Clough-Tocher interpolation technique is often referred to in the literature as a finite element method because it
has origins in the finite element method of numerical analysis. Before any points are interpolated, the scatter points
are first triangulated to form a temporary TIN. A bivariate polynomial is defined over each triangle, creating a
surface made up of a series of triangular Clough-Tocher surface patches.

The Twelve Parameters Used to Define the
Clough-Tocher Triangle

The Clough-Tocher patch is a cubic polynomial defined by twelve
parameters shown in the following figure: the function values, f, and
the first derivatives, fx & fy, at each vertex, and the normal derivatives,
, at the midpoint of the three edges in the triangle (Clough & Tocher,
1965; Lancaster & Salkauskas, 1986). The first derivatives at the
vertices are estimated using the average slopes of the surrounding
triangles. The element is partitioned into three subelements along
seams defined by the centroid and the vertices of the triangle.

A complete cubic polynomial of the form:

is created over each sub-triangle with slope continuity across the seams and across the boundaries of the triangle.
Second derivative continuity is not maintained across the seams of the triangle.
Since the Clough-Tocher scheme is a local scheme, it has the advantage of speed. Even very large scatter point sets
can be interpolated quickly. It also tends to give a smooth interpolating surface which brings out local trends in the
dataset quite accurately.
Since a TIN only covers the convex hull of a scatter point set, extrapolation beyond the convex hull is not possible
with the Clough-Tocher interpolation scheme. Any points outside the convex hull of the scatter point set are assigned
the default extrapolation value entered at the bottom of the Interpolation Options dialog.
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4.5. Natural Neighbor

Natural Neighbor
The basic equation used in natural neighbor interpolation is identical to the one used in IDW interpolation:

As with IDW interpolation, the nodal functions can be either constants, gradient planes, or quadratics. The nodal
function can be selected using the Natural Neighbor Interpolation Options dialog. The difference between IDW
interpolation and natural neighbor interpolation is the method used to compute the weights and the method used to
select the subset of scatter points used for interpolation.
Natural neighbor interpolation is based on the Thiessen polygon network of the scatter point set. The Thiessen
polygon network can be constructed from the Delauney triangulation of a scatter point set. A Delauney triangulation
is a TIN that has been constructed so that the Delauney criterion has been satisfied.

Delauney Triangulation and Corresponding Thiessen Polygon
Network for a Set of Scatter Points.

There is one Thiessen polygon in the network for each scatter point. The polygon encloses the area that is closer to
the enclosed scatter point than any other scatter point. The polygons in the interior of the scatter point set are closed
polygons and the polygons on the convex hull of the set are open polygons.
Each Thiessen polygon is constructed using the circumcircles of the triangles resulting from a Delauney triangulation
of the scatter points. The vertices of the Thiessen polygons correspond to the centroids of the circumcircles of the
triangles.
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Local Coordinates
The weights used in natural neighbor interpolation are based on the concept of local coordinates. Local coordinates
define the "neighborliness" or amount of influence any scatter point will have on the computed value at the
interpolation point. This neighborliness is entirely dependent on the area of influence of the Thiessen polygons of the
surrounding scatter points.
To define the local coordinates for the interpolation point, Pn, the area of all Thiessen polygons in the network must
be known. Temporarily inserting Pn into the TIN causes the TIN and the corresponding Thiessen network to change,
resulting in new Thiessen areas for the polygons in the neighborhood of Pn.
The concept of local coordinates is shown graphically in the following figure. Points 1-10 are scatter points and Pn is
a point where some value associated with points 1-10 is to be interpolated. The dashed lines show the edges of the
Thiessen network before Pn is temporarily inserted into the TIN and the solid lines show the edges of the Thiessen
network after Pn is inserted.

Overlapping Thiessen Polygon Areas Used in Computation of Local
Coordinates.

Only those scatter points whose Thiessen polygons have been altered by the temporary insertion of Pn are included in
the subset of scatter points used to interpolate a value at Pn. In this case, only points 1, 4, 5, 6, & 9 are used. The
local coordinate for each of these points with respect to Pn is defined as the area shared by the Thiessen polygon
defined by point Pn and the Thiessen polygon defined by each point before point Pn is added. The greater the
common area, the larger the resulting local coordinate, and the larger the influence or weight the scatter point has on
the interpolated value at Pn.
If the user defines k(n) as the Thiessen polygon area of Pn and km(n) as the difference in the Thiessen polygon area of
a neighboring scatter point, Pm, before and after Pn is inserted, then the local coordinate lm(n) is defined as:

The local coordinate lm(n) varies between zero and unity and is directly used as the weight, wm(n), in the
interpolation equation. If Pn is at precisely the same location as Pm, then the Thiessen polygon areas for Pn and Pm
are identical and lm(n) has a value of unity. In general, the greater the relative distance Pm is from Pn, the smaller its
influence on the final interpolated value.

http://www.xmswiki.com/xms/index.php?title=File%3ALocalcoord.gif
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Extrapolation
As shown in the figure above, the Thiessen polygons for scatter points on the perimeter of the TIN are open-ended
polygons. Since such polygons have an infinite area, they cannot be used directly for natural neighbor interpolation.
Thus, a special approach is used to facilitate extrapolation with the natural neighbor scheme. Prior to interpolation,
the X and Y boundaries of the object being interpolated to (grid, mesh, etc.) are determined and a box is placed
around the object whose boundaries exceed the limits of the object by approximately 10% (this value can be
modified by the user). Four temporary "pseudo-scatter points" are created at the four corners of the box. The inverse
distance weighted interpolation scheme with gradient plane nodal functions is then used to estimate a data value at
the pseudo-points. From that point on, the pseudo-points with the extrapolated values are included with the actual
scatter points in the interpolation process. Consequently, all of the points being interpolated to are guaranteed to be
within the convex hull of the scatter point set. Once the interpolation is complete, the pseudo-points are discarded.
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4.6. Kriging

Kriging
Kriging is a method of interpolation named after a South African mining engineer named D. G. Krige who
developed the technique in an attempt to more accurately predict ore reserves. Over the past several decades kriging
has become a fundamental tool in the field of geostatistics.
Kriging is based on the assumption that the parameter being interpolated can be treated as a regionalized variable. A
regionalized variable is intermediate between a truly random variable and a completely deterministic variable in that
it varies in a continuous manner from one location to the next and therefore points that are near each other have a
certain degree of spatial correlation, but points that are widely separated are statistically independent (Davis, 1986).
Kriging is a set of linear regression routines which minimize estimation variance from a predefined covariance
model.
The kriging routines implemented in GMS are based on the Geostatistical Software Library (GSLIB) routines
published by Deutsch and Journel (1992). Since kriging is a rather complex interpolation technique and includes
numerous options, a complete description of kriging is beyond the scope of this reference manual. The user is
strongly encouraged to refer the GSLIB textbook for more information:
Deutsch, C.V., & A.G. Journel. GSLIB: Geostatistical Software Library and User's Guide. Oxford University Press,
New York, 1992.
Other good references on kriging include:
Royle, A.G., F.L. Clausen, & P. Frederiksen. Practical Universal Kriging and Automatice Contouring.
Geo-Processing, Vol. 1, No. 4, 1981.
Davis, J.C. Statistics and Data Analysis in Geology. John Wiley & Sons, New York, 1986.
Lam, N.S. Spatial Interpolation Methods: A Review. The American Cartographer. Vol. 10, No. 2, 1983.
Heine, G.W., A Controlled Study of Some Two-Dimensional Interpolation Methods, COGS Computer
Contributions, Vol. 2, No. 2.
Olea, T.A., Optimal Contour Mapping using Universal Kriging. J. Geophys. Research, Vol. 79, No. 5, 1974.
Journel, A.G., & Huijbregts, C.J. Mining Geostatistics. Academic Press, New York, NY, 1978.
A powerful set of kriging techniques with varying degrees of sophistication have been implemented in GMS. The
selection of the Kriging method and the definition of the variograms are accomplished using the Kriging Options
dialog. There are several differences between 2D and 3D Kriging. The supported techniques include:

Ordinary Kriging
The first step in ordinary kriging is to construct a variogram from the scatter point set to be interpolated. A
variogram consists of two parts: an experimental variogram and a model variogram. Suppose that the value to be
interpolated is referred to as f. The experimental variogram is found by calculating the variance (g) of each point in
the set with respect to each of the other points and plotting the variances versus distance (h) between the points.
Several formulas can be used to compute the variance, but it is typically computed as one half the difference in f
squared.

http://www.xmswiki.com/xms/index.php?title=GMS:Kriging_Options
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Kriging
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Experimental and Model Variogram Used in Kriging

Once the experimental variogram is computed, the next step is to define a model variogram. A model variogram is a
simple mathematical function that models the trend in the experimental variogram.
As can be seen in the above figure, the shape of the variogram indicates that at small separation distances, the
variance in f is small. In other words, points that are close together have similar f values. After a certain level of
separation, the variance in the f values becomes somewhat random and the model variogram flattens out to a value
corresponding to the average variance.
Once the model variogram is constructed, it is used to compute the weights used in kriging. The basic equation used
in ordinary kriging is as follows:

Where n is the number of scatter points in the set, fi are the values of the scatter points, and wi are weights assigned
to each scatter point.
This equation is essentially the same as the equation used for inverse distance weighted interpolation (equation 9.8)
except that rather than using weights based on an arbitrary function of distance, the weights used in kriging are based
on the model variogram. For example, to interpolate at a point P based on the surrounding points P1, P2, and P3, the
weights w1, w2, and w3 must be found. The weights are found through the solution of the simultaneous equations:

where S(dij) is the model variogram evaluated at a distance equal to the distance between points i and j. For example,
S(d1p) is the model variogram evaluated at a distance equal to the separation of points P1 and P. Since it is necessary
that the weights sum to unity, a fourth equation is added:

Since there are now four equations and three unknowns, a slack variable, l, is added to the equation set. The final set
of equations is as follows:
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The equations are then solved for the weights w1, w2, and w3. The f value of the interpolation point is then calculated
as:

By using the variogram in this fashion to compute the weights, the expected estimation error is minimized in a least
squares sense. For this reason, kriging is sometimes said to produce the best linear unbiased estimate. However,
minimizing the expected error in a least squared sense is not always the most important criteria and in some cases,
other interpolation schemes give more appropriate results (Philip & Watson, 1986).
An important feature of kriging is that the variogram can be used to calculate the expected error of estimation at each
interpolation point since the estimation error is a function of the distance to surrounding scatter points. The
estimation variance can be calculated as:

When interpolating to an object using the kriging method, an estimation variance dataset is always produced along
with the interpolated dataset. As a result, a contour or iso-surface plot of estimation variance can be generated on the
target mesh or grid.

Simple Kriging
Simple kriging is similar to Ordinary Kriging except that the following equation is not added to the set of equations:

and the weights do not sum to unity. Simple kriging uses the average of the entire data set while ordinary kriging
uses a local average (the average of the scatter points in the kriging subset for a particular interpolation point). As a
result, simple kriging can be less accurate than ordinary kriging, but it generally produces a result that is "smoother"
and more aesthetically pleasing.

Universal Kriging
One of the assumptions made in kriging is that the data being estimated are stationary. That is, as you move from one
region to the next in the scatter point set, the average value of the scatter points is relatively constant. Whenever
there is a significant spatial trend in the data values such as a sloping surface or a localized flat region, this
assumption is violated. In such cases, the stationary condition can be temporarily imposed on the data by use of a
drift term. The drift is a simple polynomial function that models the average value of the scatter points. The residual
is the difference between the drift and the actual values of the scatter points. Since the residuals should be stationary,
kriging is performed on the residuals and the interpolated residuals are added to the drift to compute the estimated
values. Using a drift in this fashion is often called "universal kriging."
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Kriging Options

The Kirging Options dialog.

The kriging options can be edited with the
Kriging Options dialog. This dialog is reached
through the 3D Interpolation Options dialog. The
options in the Kriging Options dialog are as
follows:

Kriging Method

The pull-down list in the kriging method section
is used to select which kriging technique is used.
The options are Simple Kriging or Ordinary
Kriging. (See Kriging)

Drift

The Drift Coefficients dialog.

When performing Universal Kriging, a drift function should be defined. The Drift
button brings up the Drift Coefficients dialog. Each of the toggles in the dialog
represents a single component of the polynomial equation defining the drift.
Initially, all of the toggles off by default. Turning on coefficients enables universal
kriging and defines the drift polynomial. For example, to use a planar drift
function, only the linear terms should be used.

Search Options

The Search Options button brings up the Search Options dialog. The Minimum
and Maximum values in the Number of points to use for kriging controls how many
of the points found in the search radius are actually used in the kriging calculations.
If fewer than the minimum value are found, a default value (-999) is assigned to the
interpolation point. If greater than the maximum value is found, the closest points
are used.

The input data cutoff values are used to screen out data values outside the specified range. Points with values outside
this range are ignored.
If the Octant option is selected in the search type section, a maximum of N points in each of the eight octants (for 2D
a quadrant is used) surrounding the interpolation point are used in the calculations. This method results in better
performance with clustered data. If the Normal method is selected, the octant approach is not used.
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The Search Options dialog.

Search Ellipsoid

The Search Ellipsoid dialog.

The Search Ellipsoid button brings up
the Search Ellipsoid dialog. When a
value is interpolated to an interpolation
point, only a subset of the scatter
points in the vicinity of the
interpolation point are used in the
calculations. The items in the Search
Ellipsoid dialog control the shape of a
"search space" surrounding the
interpolation point. Only points in this
search space are considered candidates
for use in the kriging calculations.

By default, the search space is a circle (sphere in 3D) centered at the point with a radius defined by the Maximum
search radius item. For problems exhibiting anisotropy, the search space can be transformed to an ellipse (ellipsoid in
3D). The anis1 factor and the azimuth angle control the shape and orientation of the ellipse. The azimuth represents
the rotation of the major principal axis clockwise from the +y axis. The anis1 factor represents the ratio of the search
radius along the minor principal axis relative to the search radius (the maximum radius) in the major principal
direction. In most cases, the anis1 factor and the azimuth angle should match the anis factor and azimuth angle
defined in the Variogram Editor.

Editing Variograms
Regardless of which kriging method is selected, a model variogram must be constructed prior to interpolating the
values from the scatter points to the target object. In some cases, multiple variograms must be defined. The basic
steps involved in constructing a model variogram are to first build an experimental variogram and then construct a
model variogram that matches the experimental variogram. Variograms are constructed using the Variogram Editor.
The Variogram Editor is activated by selecting the Edit Variogram button in the Kriging Options dialog.
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3D Kriging
3D Kriging is almost identical to 2D Kriging. All of the basic kriging options, including simple kriging and ordinary
kriging. (See Kriging)

2D vs. 3D
There are several differences in the 2D and the 3D versions of kriging. First of all, if the drift option is turned on,
more drift coefficients are available. In the Search Options dialog, an octant searching scheme can be selected. A
number is entered which represents the maximum number of scatter points from each of the eight octants
surrounding the interpolation point to keep in the subset. Limiting the number of points in each octant can give better
results when the scatter points are clustered.

Modeling Anisotropy
The main difference between the 3D and 2D versions of kriging is the way anisotropy is treated. The third dimension
adds additional angles and factors that must be manipulated. As is the case with 2D kriging, the first step in
modeling anisotropy is to detect anisotropy using experimental variograms. Anisotropy can be modeled in up to
three orthogonal directions. A series of orthogonal variograms are generated at different orientations until the three
experimental variograms corresponding to the three principal axes of anisotropy are found. The combination which
gives the greatest difference in range for the three experimental variograms corresponds to the principal axes. The
axis with the largest range is the major principal axis.
When computing directional experimental variograms in 3D, two angles are used to define the direction vector:
azimuth and dip. To define the rotation of a vector, we assume the unrotated vector starts in the +y direction. The
azimuth angle is the first angle of rotation and it represents a clockwise rotation in the horizontal plane starting from
the +y axis. The dip angle is the second angle of rotation and it represents a downward rotation of the vector from the
horizontal plane. The azimuth and dip angles defined in the experimental variogram dialog can be used to define a
focused experimental variogram in any direction.
Once anisotropy has been detected using the experimental variograms, anisotropy can be modeled with the model
variogram using either the directional variogram method or the anisotropy factor method. The simplest method is the
directional variogram approach. If the directional variogram approach is used, a separate model variogram is
constructed for each of the three orthogonal axes.
If the anisotropy factor method is selected, the azimuth and dip angles corresponding to the major principal axis
should be entered into the angle edit fields in the lower left corner of the Variogram Editor. These fields also allow a
third angle of rotation, the plunge angle, to be specified. The plunge angle represents a rotation or spinning about the
direction vector (which is already rotated by the azimuth and dip). The direction of rotation is defined as clockwise
looking down the direction vector toward the origin. In most cases, the plunge angle can be left at zero.
Once the angles are entered, the model variogram should then be constructed which fits the experimental variogram 
corresponding to the major principal direction. The anis1 and anis2 parameters in the Variogram Editor should then 
be changed to a value other than unity (the default value). Changing these parameters to a value less than unity 
causes three curves to be drawn for the model variogram. The second curve corresponds to the original curve with 
the range parameter multiplied by the anis1 value. The third curve corresponds to the original curve with the range 
parameter multiplied by the anis2 value. The anis1 parameter should be altered until the second curve fits the 
experimental variogram corresponding to the second principal axis of anisotropy. If the principal axis is assumed to 
be the y axis in the unrotated state, this axis is the x axis in the rotated state. The anis2 parameter should then be 
altered until the third curve matches the third principal axis of anisotropy (the z axis in the unrotated state). Once the 
correct anisotropy factors are found, the Variogram Editor should be exited and the angles and anisotropy factors
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should be entered in the Search Ellipsoid dialog to define a search ellipsoid that matches the variogram anisotropy.
For further information on modeling anisotropy in 3D, the user is referred to Deutsch and Journel (1992).

Variogram Editor
Before interpolating a scatter point set using the Kriging option, a model variogram must be defined. The basic steps
involved in constructing a model variogram are to first build an experimental variogram and then construct a model
variogram that matches the experimental variogram. This is accomplished using the Variogram Editor. The
Variogram Editor is activated by selecting the Edit Variogram button in the Kriging Options dialog.

The experimental variograms and the model variogram are plotted in the upper portion of the Variogram Editor. The
items in the upper right portion of the Editor are used to create experimental variograms. The items in the lower half
of the Editor are used to define the model variogram. In a typical study, several experimental variograms may be
constructed and plotted before one is chosen. A model variogram is then designed to fit the chosen experimental
variogram.

Creating Experimental Variograms
A new experimental variogram is computed by selecting the New button under the list of experimental variograms.
This button brings up the Experimental Variogram dialog.

Lags
When computing an experimental variogram, it is impractical to plot a variance for each scatter point with respect to
each of the other scatter points. Therefore, distances are subdivided into a number of intervals called lags as
illustrated in the following figure. The distance between each pair of scatter points is checked to see which lag
interval it lies within. The variances for all pairs of points whose separation distance falls within the same lag
interval are averaged. The resulting average is plotted in the experimental variogram vs. the distance corresponding
to the lag interval. Therefore, there is one point in the experimental variogram plot for each lag. The lag intervals are
defined in the Experimental Variogram dialog by entering a total number of lags, a unit lag separation distance, and
a lag tolerance. In most cases, the lag tolerance should be one half of the unit lag separation distance; the tolerance
can be smaller to allow for data on a pseudo-regular grid. A pair will be included in multiple lags if the tolerance is
greater than one-half of the unit lag separation distance.

http://www.xmswiki.com/xms/index.php?title=GMS:Kriging_Options
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Semivariogram

The semivariogram is the most common type of variogram. The semivariogram value for a lag interval is computed
as:

where N is the number of pairs of points whose separation distance falls within the lag interval and f1i and f2i are the
values at the head and tail of each pair of points. The head and tail are defined as follows:

Naming Convention for Pairs of Scatter
Points.
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Covariance

The covariance is the traditional covariance used in statistics. The covariance value for a lag interval is computed as:

where m-h and m+h are the mean of the head and tail values respectively.

Correlogram

The correlogram is computed by standardizing the covariance by the standard deviation of the head and tail values.

where s-h and s+h are the standard deviation of the head and tail values respectively.

General Relative Semivariogram

This variogram is computed by standardizing the semivariogram computed using equation 9.38 by the squared mean
of the data values in each lag:

Pairwise Relative Semivariogram

With this variogram, each pair is normalized by the squared average of the tail and head values.

Experience has shown that the general relative and pairwise relative semivariograms are effective in revealing spatial
structure and anisotropy when the scatter points are sparse (Deutsch & Journel, 1992). Because of the divisors in
equations 9.41 and 9.42, these semivariograms should only be used on positively skewed datasets.

Semivariogram of Logarithms

This variogram is computed by applying equation 9.38 to the natural logarithms of the data values:

Semirodogram

The semirodogram is similar to the traditional semivariogram except that the square root of the absolute difference is
used rather than the squared difference:
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Semimadogram

The semimadogram is similar to the traditional semivariogram, except that the absolute difference is used rather than
the squared difference:

The semirodogram and the semimadogram are particularly effective for establishing range and anisotropy. They
should not be used for modeling the nugget of semivariograms (Deutsch & Journel, 1992).

Viewing the Experimental Variograms

After setting up the lag interval and choosing a variogram type, the OK button is selected in the Experimental
Variogram dialog. At this point, the experimental variogram is computed. For large scatter point sets, this may take a
significant amount of time.
Once the experimental variogram is computed, it is added to the list of experimental variograms in the upper right
corner of the Variogram Editor and it is displayed in the variogram plotting window. One of the variograms in the
list is always highlighted. The name, color, and symbols (used to plot the variogram) of the highlighted variogram
can be edited. In addition, the display of each variogram can be turned on and off so any combination of
experimental variograms can be plotted. Selecting the Delete button deletes the highlighted variogram. Selecting the
Edit button causes the Experimental Variogram dialog to come up initialized with the values used in the
computation of the highlighted variogram. When the OK button is selected, the values of the variogram are
recomputed.

Creating Model Variograms
Once a set of experimental variograms are computed, one is chosen and a model variogram is constructed to fit the
experimental variogram. The model variogram is constructed using the items in the lower half of the Variogram
Editor.

Model Functions
Four types of model functions are supported for building model variograms. Each of the functions are characterized
by a nugget, contribution, and range.

The Parameters Used to Define a Model Variogram.

The nugget represents a minimum variance. The contribution is sometimes called the "sill" and represents the
average variance of points at such a distance away from the point in question that there is no correlation between the
points. The range represents the distance at which there is no longer a correlation between the points.
The four model functions supported are:

http://www.xmswiki.com/xms/index.php?title=File:Variogrameq7.jpg
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Spherical Model

The Spherical Model is defined by a range -a- and a contribution -c- as:

Exponential Model

The Exponential Model is defined by a parameter -a- and a contribution -c- as:

Gaussian Model

The Gaussian Model defined by a parameter -a- and a contribution -c- as:

Power Model

The Power Model is defined by a power 0 < a < 2 and a slope c as:

Nested Structures

A model variogram is constructed using a combination of one or more model functions. Each instance of a model
function is called a "nested structure". A nested structure is created by selecting the New button in the Nested
Structure section of the dialog. A new structure is created and added to the list of nested structures. The model
variogram plotted in the variogram plot window represents the combination of all of the nested structures in the list.
One of the nested structures in the list is highlighted at all times. The selected structure can be deleted by selecting
the Delete button under the list. The name, model function type, contribution, and range of the selected structure can
be edited (the nugget is the same for all nested structures, i.e., only the contribution and range of each structure are
summed). As the parameters defining the structure are altered by the user, the plot of the model variogram is updated
dynamically in the variogram plot window. This type of instantaneous feedback provides a powerful tool for
"sculpting" a model variogram in an intuitive manner until it fits the selected experimental variogram.
In most cases, a single nested structure is adequate. For cases with complex experimental variograms, using multiple
nested structures to define the model variogram can prove useful.

Modeling Anisotropy
Some datasets exhibit anisotropy, i.e., the correlation between scatter points changes with direction. For example,
due to the depositional history of an alluvial soil deposit, parameters such as porosity and hydraulic conductivity
may be most strongly correlated in one direction. This means the differences in the data values change relatively
little in one direction compared to how much they change with distance in the orthogonal direction. The direction
corresponding to the highest correlation (smallest change) is called the major principal direction and the orthogonal
direction is the minor principal direction.
One of the more powerful features of the kriging method is that anisotropy can be detected by generating
experimental variograms in orthogonal directions and looking for differences. When anisotropy exists, the model
variogram can be constructed to match the anisotropy and ensure that the differences in the continuity of the data
each of the orthogonal directions is accurately modeled in the interpolated dataset.

http://www.xmswiki.com/xms/index.php?title=File:Variogrameq8.jpg
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Detecting Anisotropy
Anisotropy can be detected by generating a focused experimental variogram in each orthogonal direction and
observing whether or not there are significant differences in the resulting variograms. When constructing an
experimental variogram with the Experimental Variogram dialog, directional data corresponding to an axis of
anisotropy can be entered. The meaning of the directional data is illustrated in the following figure:

The Directional Data Used to Detect Anisotropy.

When a scatter point is compared with each of the other scatter points to compute the experimental variogram, only
those points falling within the shaded area shown in the figure above are considered. The shaded area is defined by
the azimuth angle, the azimuth bandwidth, the half window azimuth tolerance, and the lag intervals. For isotropic
conditions, the half window azimuth tolerance should be set to 90o (the default value). This forces all points to be
included in the calculation of the experimental variogram.
Anisotropy is typically detected using a trial and error process. Pairs of experimental variograms are generated, the
pairs being offset from each other by an azimuth angle of 90o. If anisotropy exists, the ranges of the two variograms
will differ as shown below. If the data are isotropic, the azimuth angle will have little effect on the resulting
experimental variograms. The angles which produce the pair of experimental variograms with the largest difference
in ranges represent the principal axes of anisotropy. The variogram with the larger range represents the major
principal axis and the variogram with the shorter range represents the minor principal axis.

Experimental and Model Variograms for Anisotropic Conditions.

http://www.xmswiki.com/xms/index.php?title=File%3AAzimuth.gif
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Anisotropy Method
Once anisotropy has been detected, the next step is to model the anisotropy using the model variogram.
The azimuth angle corresponding to that major principal axis (the one with the longer range) should be entered in the
azimuth angle field in the lower left corner of the Variogram Editor (the dip and plunge fields are for 3D kriging and
are dimmed for 2D interpolation). A model variogram should then be constructed which fits the experimental
variogram corresponding to the major principal direction. The anis1 parameter in the Variogram Editor should then
be changed to a value other than unity (the default value). Changing the anis1 parameter to a value less than unity
causes two curves to be drawn for the model variogram as shown in the above figure. The second curve corresponds
to the original curve with the range parameter multiplied by the anis1 value. In other words, the anis1 parameter
represents the range in the minor direction divided by the range in the major direction. The anis1 parameter should
be altered until the second curve fits the experimental variogram corresponding to the minor principal axis of
anisotropy. Each of the nested structures has an anis1 parameter that can be edited. Once again, as the anis1
parameter is altered, the variogram plot is updated dynamically, allowing a fit to be made in a simple intuitive
fashion. Once the correct anis1 factor is found, the Variogram Editor should be exited and the azimuth and anis1
factors should be entered in the Search Ellipsoid dialog to define a search ellipse that matches the variogram
anisotropy.

Saving Variograms
Once a variogram or set of variograms is defined, the variograms are saved with the dataset files when the project is
saved to disk. Thus, when the project is read back in to GMS, the variograms are ready to be used for interpolation
and do not need to be redefined.

http://www.xmswiki.com/xms/index.php?title=GMS:Kriging_Options


32

4.7. Jackknifing

Jackknifing
Jackknifing is a special type of interpolation which can be useful in analyzing a scatter point set or an interpolation
scheme. When the Jackknifing command is selected, the active scatter point set is interpolated "to itself" using the
currently selected interpolation scheme. Each point in the set is processed one at a time. The point is temporarily
removed and the selected interpolation scheme is used to interpolate to the location of the missing point using the
remaining points. Ideally, the interpolated value should correspond closely to the original measured value at the
point. By interpolating to each point, a new dataset is generated for the scatter point set. This new dataset can be
compared with the original dataset using the Summary command in the Interpolation menu. The command brings up
the Jackknifing Summary dialog.
The user can select an original dataset and then can select the dataset created from jackknifing. The mean error,
mean absolute error, and the root mean squared error are automatically calculated.

Example of the Jackknifing Summary dialog.

http://www.xmswiki.com/xms/index.php?title=File%3AJackknifingSummary.jpg
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5. Modules
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5.1. TIN Module

TIN Module

TIN stands for Triangulated Irregular Network. TINs are used for surface modeling. TINs are formed by connecting
a set of XYZ points with edges to form a network of triangles. TINs can be used to represent the surface of a
geologic unit or the surface defined by a mathematical function.
Several TINs can be modeled at once in GMS. One of the TINs is designated as the "active" TIN. The selection and
editing tools apply to the active TIN only.

http://www.xmswiki.com/xms/index.php?title=File%3ATins.gif
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Creating a TIN

In order to create a TIN in GMS you must have a set of TIN vertices. Then the TIN is created by triangulating the
vertices (connecting the vertices with lines to form triangles). The triangulation algorithm assumes that each of the
vertices being triangulated is unique in the xy plane, i.e., no two points have the same xy location. Duplicate points
can be removed by selecting Find Duplicates from the TINs menu.
TINs can be created 3 different ways in GMS: manually entering the vertex locations and triangulating, converting a
different GMS data type to a TIN, and copying a currently existing TIN.

Manually Creating a TIN
A TIN can be created manually from the following steps:
1. Right-click in the empty space of the Project Explorer and select the New → TIN command.
2. Select the Create Vertices tool from the TIN Tool Palette.
3.3. Create the vertices by clicking inside the Graphics Window at the xy coordinates where you want the vertex

located. (To change the vertex location see: Editing a TIN)
4. Select the Triangulate command from the TINs menu.

Creating a TIN from GMS Data
2D meshes, 2D grids, and 2D scatter points can all be converted to a TIN. This is accomplished by using the
following commands:
•• Mesh to TIN
•• Grid to TIN
•• Scatter Points to TIN
•• Contacts to TIN
•• Watertable to TIN
• Add Contacts to TIN – This command is used to enter a point from a contact into the active TIN . The contact(s)

are first selected and the command is then chosen from the Borehole menu. Typically all contacts which should
be part of a TIN are selected before generating the TIN, but sometimes one is inadvertently left out, or more
boreholes are added later.

Copying a Current TIN
To make a copy of a TIN that currently exists in GMS follow these steps:
1. Select the TIN you wish to copy using the Select TINs tool.
2. Select the Duplicate TIN command from the TINs menu. A dialog appears prompting for the Z-offset of the new

TIN. The Z offset is used to displace the TIN above or below the TIN being duplicated.

http://www.xmswiki.com/xms/index.php?title=GMS:Triangulation
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:Triangulation
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Scatter_Point_Module
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Mesh_Module%23Converting_a_2D_Mesh_to_other_types_of_Data
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Grid_Module%23Converting_2D_Grids
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Scatter_Point_Module%23Converting_2D_Scatter_Points_to_Other_Types_of_Data
http://www.xmswiki.com/xms/index.php?title=GMS:Converting_Borehole_Data
http://www.xmswiki.com/xms/index.php?title=GMS:Converting_Borehole_Data


Editing a TIN 36

Editing a TIN

TINs can be edited several ways. The selection and editing tools apply only to the active TIN. If going to edit
vertices, the user must first turn off the TINs | Lock All Vertices menu command.

Editing TIN Vertices

Creating New TIN Vertices
New vertices can be created using the Create Vertices tool from the TIN Tool Palette. Clicking in the Graphics
Window creates a new vertex at the point clicked (vertices can only be created when in Plan View). The default z
value and other parameters governing the creation of new vertices can be set by selecting the TIN Settings command
from the TINs menu.

Deleting TIN Vertices
Selected TIN vertices can be deleted by hitting the Delete key or by selecting the Delete command from the Edit
menu. If the Confirm Deletions option in the Preferences dialog is on, the user is prompted to confirm each
deletion.

Editing TIN Vertex Coordinates
Two methods of editing TIN vertex coordinates are available. To manipulate vertex coordinates, the Select Vertex
tool must be selected from the TIN Tool Palette.
•• A vertex can be moved to a new position by clicking on the vertex and holding down the mouse button while

dragging the vertex to the desired position. If the current view is plan view, dragging the vertex causes it to move
in the xy plane. GMS does not allow the vertex to be dragged to a position where one of the surrounding triangles
becomes inverted. If the current view is not the plan view, the vertex moves along the z-axis.

• The vertex position and z value can also be manipulated by selecting the vertex and changing the XYZ values that
will appear in the x, y, and z edit boxes in the Edit Window.

Snap Vertices to TIN
It is sometimes useful to snap the vertices of one TIN to another TIN. This is useful when modeling pinch out zones
and truncations. The TIN containing the vertices to be moved should be the active TIN, since vertex selection can
only be done for the active TIN. After the desired vertices have been selected, the Snap Vertices to TIN command of
the TINs menu should be selected. GMS then prompts the user to select the TIN to which the vertices are snapped.
The selected vertices' z coordinate values are then modified such that they lie on the selected TIN.

http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Tool_Palette
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Editing Triangles of a TIN

Create Triangles
The Create Triangles tool is used to manually create new triangles. Triangles are normally created by triangulating a
set of points automatically. However, this tool is useful for manually editing and refining a TIN. To use the Create
Triangles tool:
•• Select the three vertices of the triangle. The vertices can be selected in either clockwise or counter-clockwise

order.
•• Drag a box around three vertices of the triangle.

Deleting Triangles
• Using the Select Triangles tool, the triangles may be selected and deleted.
• Boundary Triangles – The perimeter of the TIN resulting from the triangulation process corresponds to or

approximates the convex hull of the TIN vertices. This may result in some long thin triangles or "slivers" on the
perimeter of the triangulated region. There are several ways to deal with the long thin triangles. Thin triangles can
be selected and deleted using the normal selection procedures. There is also an option for selecting thin triangles
when the Select Triangles tool is selected. If the Control key is held down, it is possible to drag a line with the
mouse. All triangles intersecting the line are selected. Long thin triangles on the perimeter of the TIN can also be
selected by selecting the Select Boundary Triangles command from the TINs menu. The Select Boundary
Triangles command checks triangles on the outer boundary first. If the length ratio of the triangle is less than the
critical length ratio, the triangle is selected and the triangles adjacent to the triangle are then checked. The process
continues inward until none of the adjacent triangles violate the minimum length ratio. The critical length ratio for
selecting thin triangles can be set by selecting the TINs | TIN Settings menu command. The length ratio is
defined as the longest side of the triangle divided by the sum of the two shorter sides.

Changing Triangle Density
The density of a TIN can be quickly increased using the Uniformly Subdivide TIN command in the TINs menu. The
user is prompted for a subdivision factor and the factor is used to uniformly subdivide the TIN into sub-triangles as
shown below:

TIN (a) Before and (b) After Uniform Subdivision.

http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Tool_Palette
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Subdivide TIN
This command can be used to "smooth" a TIN. When using a TIN for contouring, the contours are computed using a
linear interpolation of the triangles. If the vertices are sparse, the contours may not appear to be smooth. The
contours can be smoothed by copying the vertices to a scatter point set, subdividing the TIN into sub-triangles, and
interpolating the z values (or other datasets) from the scatter point set to the new vertices defining the sub-triangles.
Subdivision and smoothing can be accomplished using the following steps:
•• If multiple TINs exist, make sure the TIN is the active TIN.
• Convert the TIN to a scatter point set using the TIN → Scatter Points command in the TINs menu.
• Subdivide the TIN by selecting the Subdivide TIN command from the TINs menu.
• Switch to the 2D Scatter Point module and select an interpolation method using the Interp. Options command in

the Interpolation menu.
• Select the to Active TIN command from the Interpolation menu. This creates a new dataset for the selected TIN.

Adding Breaklines
A breakline is a feature line or polyline representing a ridge or some other feature that the user wishes to preserve in
a mesh made up of triangular elements. In other words, a breakline is a series of edges to which the triangles should
conform to, i.e., not intersect.

Breaklines (a) Triangulated Mesh and Breakline. (b) Triangulated
Mesh After the Breakline has been Processed.

Breaklines can be processed using the Add Breaklines command from the Mesh menu. Before selecting the
command, one or more sequences of nodes defining the breakline(s) should be selected using the Select Node
Strings tool in the 2D Mesh Tool Palette.
As each breakline is processed, the triangles intersected by the breakline are modified by adding new nodes at
necessary locations to ensure that the edges of the triangles will conform to the breakline. The elevations of the new
nodes are based on a linear interpolation of the breakline segments. The locations of the new nodes are determined in
such a way that the Delauney criterion is satisfied.
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TIN Settings

The Preference dialog showing the TINs tab

The settings for the TIN module can be
found in the Preferences dialog under
the TINs item. The Preferences menu
can be reach by using the
Preferences... command in the Edit
menu and then selecting the TINs item;
or it can be reached by using the TIN
Settings... command in the TINs menu.
The following settings are available:

• Retriangulate After Deleting – If
this option is on, the region
surrounding the vertex is
retriangulated as each vertex is
deleted. Otherwise, the triangles
adjacent to the vertex are simply
deleted.

• Adjust Boundary to Include
Exterior Vertices – If this option is on, the boundary of the TIN is changed so that the new vertex becomes part of
the TIN if a new point is added outside the active TIN. If the new vertex is in the interior of the active TIN, the
vertex is automatically incorporated into the TIN.

• Default Z-Value – The default z value is assigned to all new vertices created with the Create Vertex tool.
• Confirm Z-Values – If this option is on, GMS prompts for a z value each time a new vertex is created.
• Interpolate For Default Z On Interior – If this option is on and a new vertex is created in the interior of a TIN, a

default z-value is linearly interpolated from the plane equation defined by the triangle containing the point.
• Extrapolate For Default Z On Exterior – If this option is on and a new vertex is entered outside the TIN

boundary, a default z-value is extrapolated from the TIN to the new vertex.

http://www.xmswiki.com/xms/index.php?title=File%3APreferencesTINs.jpg
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TIN Display Options

The properties of all TIN data that GMS displays on the screen can be controlled through the TIN tab of the Display
Options dialog. This dialog is opened by right-clicking on the  TIN Data entry in the Project Explorer and
selecting the Display Options command. It can also be accessed from the from the Display menu or the  The
following table describes the display options available for the TIN module.

Display Option Description

Vertices If the Vertices item in the TIN Display Options dialog is set, the TIN vertices are displayed each time the Graphics Window is
refreshed. Since it is possible to accidentally drag points, vertices can be "locked" to prevent them from being dragged or edited
by selecting the Lock ALL Vertices command from the TINs menu. Vertices can be unlocked by unchecking the Lock ALL
Vertices command in the TINs menu. Both a "Locked" and "Unlocked" vertex color may be set so that there is a visible
difference when displaying the TIN. (See Editing TINs)

Triangle edges If this item is on the lines that make up each triangle are displayed. The color of the triangle edges can be adjusted according to
the following options:

1. Auto – draws the material color if faces are not displayed. Uses black or white if the faces are displayed.
2. Specified – used the color specified next to the triangle edges
3. Material – displays the material color of the triangle

Triangle faces The Triangle faces item causes the faces of the triangles to be drawn as filled polygons.

Texture map
image to active
TIN

The Texture map image item is used to "drape" an image over the surface of the TIN.

TIN boundary The TIN boundary feature is often used in conjunction with contours in order to display the contours without cluttering the screen
by displaying each triangle. The first image below shows contours displayed together with the TIN triangles. The second image
shows contours displayed with the TIN boundary.

http://www.xmswiki.com/xms/index.php?title=File:TINFolder.GIF
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Thiessen
polygons

If the Thiessen polygons item is set, a Thiessen polygon for each TIN vertex is displayed each time the display is refreshed. The
edges of the Thiessen polygons are formed by the perpendicular bisectors of the edges of the triangles in the TIN. The vertices of
these polygons correspond to the centers of the circumcircles of the Delauney triangulation. Any location inside a Thiessen
polygon is closer to the TIN vertex contained in that polygon than to any other TIN vertex. The red polygons in the image below
correspond to the Thiessen polygons for this TIN.

Circumcircles If the Circumcircles item is set, the circumcircle enclosing the three vertices for each triangle are drawn when the display is
refreshed. Circumcircles provide the basis of a Delauney triangulation since the Delauney criterion is satisfied by ensuring that no
circumcircle encloses a vertex. Displaying circumcircles can aid in the understanding of the triangulation process. The red circles
in the figure are the circumcircles for the TIN.

Vertex numbers If the Vertex numbers item is set, the number of each vertex is displayed adjacent to the vertex.

Scalar values If the Scalar values item is set, the active dataset value of each vertex is displayed adjacent to the vertex.

Contours Most of the objects supported by GMS can be contoured by turning on the Contour Options in the Display Options dialog. When
an object is contoured, the values associated with the active dataset for the object are used to generate the contours.

Vectors If the Vectors item in the Display Options dialog is selected for an object (TIN, Grid, or Mesh), vector plots can be generated
using the active vector dataset for the object. One vector is placed at each node, cell, or vertex.

http://www.xmswiki.com/xms/index.php?title=GMS:Triangulation
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The Display Options dialog showing the TIN tab.
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TIN Tool Palette

The following tools appear in the dynamic portion of the Tool Palette when the TIN module is active. Only one tool
is active at any given time. The action that takes place when the user clicks in the Graphics Window with the cursor
depends on the current tool. The tools are for selection and interactive editing of TINs. The table below describes the
tools in the TIN tool palette.

Tool Tool Name Description

Select
Vertices

The Select Vertices tool is used to select vertices for operations such as deletion, or to drag a vertex to a new location. The
coordinates of selected vertices can also be edited using the Edit Window.

Select
Triangles

The Select Triangles tool is used to select triangles for operations such as deletion.

Select TINs The Select TINs tool is used to select TINs for operations such as deletion. When this tool is active, a TIN icon appears at the
centroid of each TIN. A small letter "A" appears in the icon of the active TIN. A TIN is selected by selecting the icon. A TIN
can be designated as the active TIN by double-clicking on the TIN icon. When a different tool is selected, the icons disappear.

In some cases, several TINs occupy approximately the same location and the icons for the TINs overlap. In such cases, it may
be difficult to select the desired TIN. An alternate way to select TINs is to use the Select From List command in the Edit
menu. This brings up a list of the currently available TINs and a TIN is selected by highlighting the name of the desired TIN
and selecting the OK button.

Select
Vertex
Strings

The Select Vertex Strings tool is used to select one or more strings of vertices. Vertex strings are used for operations such as
adding breaklines to the TIN. The procedure for selecting vertex strings is somewhat different than the normal selection
procedure. Strings are selected as follows:

•• Click on the starting vertex for the string. The vertex selected will be highlighted in red.

•• Click on any subsequent vertices you would like to be part of the string (vertices do not have to be next to each other) and
double-click on the final vertex. The selected vertices are now connected by a solid red line.

To remove the last vertex from a string, press the Backspace key. To abort entering a vertex string, press the ESC key. To end
a vertex string, press Return or double-click on the last vertex in the string. Another vertex string can then be selected.

Create
Vertices

The Create Vertices tool is used to manually add vertices to a TIN. It can only be used in plan view. When this tool is
selected, clicking on a point within the Graphics Window will place a vertex at that point. What happens to the vertex after it
is added (whether and how it is triangulated into the TIN) depends on the settings in the Vertex Options dialog under the
Modify TINs menu.

Create
Triangles

The Create Triangles tool is used to manually create new triangles. Triangles are normally created by triangulating a set of
points automatically. However, this tool is useful for manually editing and refining a TIN. To use the Create Triangles tool:

•• Select the three vertices of the triangle. The vertices can be selected in either clockwise or counter-clockwise order.

•• Drag a box around three vertices of the triangle.

Swap Edges The Swap Edges tool swaps the common edge of two adjacent triangles. To use the tool, simply click on any edge in the TIN.

Contour
Labels

The Contour Label tool manually places numerical contour elevation labels at points clicked on with the mouse. These labels
remain on the screen until the contouring options are changed, until they are deleted using the Contour Label Options dialog,
or until the Graphics Window is refreshed. Contour labels can be deleted with this tool by holding down the Shift key while
clicking on the labels. This tool can only be used when the TIN is in plan view.

http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectVertices.GIF
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http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectTINs.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectVertexString.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_CreateVertices.GIF
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module%23TIN_Settings
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Converting TINS to Other Data Types

TINs may be converted to other types of data used in GMS, such as a 2D mesh or 2D scatter points. TINs can be
converted by right-clicking on the TIN in the Project Explorer, Right-clicking on the TIN in the graphics window, or
using the following commands in the TIN menu:

TIN → 2D Scatter Points
The TIN → 2D Scatter Points command creates a 2D scatter point set from the active TIN . One scatter point is
created for each vertex in the TIN. A copy is made of each of the datasets associated with the TIN and the duplicate
datasets are stored with the new scatter point set.

TIN → 2D Mesh
The TIN → 2D Mesh command creates a 2D finite element mesh from the active TIN . One triangular element is
created for each triangle in the TIN. Any datasets associated with the TIN are copied to the new mesh.

Fill Between TINs → 3D Mesh
See Creating a 3D Mesh.

TIN Boundary → Polygons
This command creates one or more polygons in the active coverage in the Map module corresponding to the outer
boundary of the active TIN.

TIN Thiessen → Polygons
This command calculates the thiessen polygons from the TIN and converts them to feature polygons.

Vertex Strings → Arcs
The Vertex Strings → Arcs command creates an arc in the active coverage of the Map module for each of the
selected vertex strings.

Horizons → Solids
See Horizons → Solids.

Horizons → 3D Mesh
See Horizons → 3D Mesh.

http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:Creating_a_3D_Mesh%23Fill_Between_TINs_%E2%86%92_3D_Mesh
http://www.xmswiki.com/xms/index.php?title=GMS:Map_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Map_Module
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:Horizons_to_Solids
http://www.xmswiki.com/xms/index.php?title=GMS:Horizons_to_3D_Mesh
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Building Solids and 3D Meshes with TINs

TINs can be used to build 3D solid models as well as 3D meshes. This can be done by selecting the following
commands in the Build TIN menu:
• Horizons → Solids
• Horizons → 3D Mesh
• Fill Between TINs → 3D Mesh

See Creating a 3D Mesh
The preferred method for creating solids is the Horizons method mentioned above. The following commands
are legacy operations that are less robust and not supported.

• TINs → Extruded Solid – This command creates a new solid from each of the selected TINs by extruding each
of the TINs up or down to an elevation specified by the user. Extruded TINs are useful in the construction of solid
models of soil stratigraphy.

• Fill Between TINs → Solid – This command provides a quick way to create a solid bounded above and below by
two or more selected TINs. The TIN defining the top of the boundary of the solid should be selected first. The
remaining TIN(s) are then selected. All selected TINs are extruded down to an arbitrary elevation below that of
all the selected TINs. GMS then performs a difference set operation.

TINs can be used to build three-dimensional solid models of the soil layers. The transformation from TINs to solids
is accomplished using a TIN extrusion and set operation procedure illustrated in two dimensions in the following
figure. A two-dimensional cross section of three TINs, labeled p, q, and r, is shown in part (a).
The TINs are converted into temporary solid primitives that represent approximations of the soil layers. The
conversion is accomplished by projecting the outer boundary (perimeter) of each TIN down to a horizontal plane.
This can be thought of as an extrusion process where a two-dimensional surface is extruded into a three-dimensional
solid. A three-dimensional illustration of this process is shown in the figure below.
Boundaries are created around the perimeter of the solid and one large boundary is created at the base of the solid.
The elevation of the horizontal plane is chosen so that the resulting solid is below the lowest point of interest. A
series of two-dimensional cross sections of the primitive solids P, Q, and R formed by extruding the TINs in part (a)
of the figure above is shown in part (b).
The final step of the modeling process consists of combining the primitive solids to form solid models of the soil
layers. This is accomplished using set operations. Portions of the solids that overlap other solids are "trimmed" away
and adjacent solids are forced to match precisely at the boundaries. This step of the modeling process is illustrated in
part c. Primitive Q is subtracted from primitive P to produce the temporary solid P-Q. Primitive R is then subtracted
from P-Q to produce the solid P'. The solid Q' is formed by subtracting primitive R from primitive Q. The primitive
R does not intersect other solids and needs no trimming. Cross sections of the completed solid models of the soil
layers are shown in part (d).
The combination extrusion/set operation process can be simplified in some cases. For example, within GMS it is
possible to create solid P' directly by "filling" between TIN p and the two TINs q and r. GMS accomplishes this by
combining the process described above for creating solid P' into a single operation. The user simply selects TINs p,
q, and r and performs the Fill Between TINs → Solid command in the Build TINs menu of the TIN module.
The combination of TIN editing, TIN extrusion, and set operations represents a powerful and flexible tool that makes 
it possible to model complex stratigraphic relationships such as truncations, faults, embedded seams, and pinchout 
zones. Once the models are constructed, the volumes of the solids can be viewed using the Get Info command in the 
File menu. In addition, the models can be further modified using set operations to simulate complex excavations.

http://www.xmswiki.com/xms/index.php?title=GMS:Horizons_to_Solids
http://www.xmswiki.com/xms/index.php?title=GMS:Horizons_to_3D_Mesh
http://www.xmswiki.com/xms/index.php?title=GMS:Creating_a_3D_Mesh%23Fill_Between_TINs_-.3E_3D_Mesh
http://www.xmswiki.com/xms/index.php?title=GMS:Set_Operations
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Cross sections and fence diagrams can be constructed from the solid models at any location and at any orientation.

Triangulation
A TIN is constructed by triangulating a set of vertices. The vertices are connected with a series of edges to form a
network of triangles. The resulting triangulation satisfies the Delauney criterion. The Delauney criterion ensures that
no vertex lies within the interior of any of the circumcircles of the triangles in the network as shown below:

Two Adjacent Triangles Which (a) Violate and (b) Honor the
Delauney Criterion.

The result of enforcing the Delauney criterion is that long thin triangles are avoided as much as possible.
The vertices associated with the active TIN can be triangulated using the Triangulate command from the TIN menu,
or by right-clicking on the TIN in the Project Explorer and selecting the Triangulate command.

http://www.xmswiki.com/xms/index.php?title=File%3ADel_criterion.gif
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
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TIN Files

TIN files are used for storing Triangulated Irregular Networks. The TIN file format is shown below and a sample file
is shown after. The TIN file format can be used to import a simple set of xyz coordinates since the triangle
information (beginning with the TRI card) does not need to be present. If you have a file of xyz coordinates you only
need to add the TIN, BEGT, and VERT nv cards to the top of the file and the ENDT card at the end.

TIN                /* File type identifier */

BEGT               /* Beginning of TIN group */

TNAM name          /* Name of TIN */

TCOL id            /* TIN material id */

VERT nv            /* Beg. of vertices */

x1 y1 z1 lf1       /* Vertex coords. */

x2 y2 z2 lf2

.

.

.

xnv ynv znv lfnv

TRI nt             /* Beg. of triangles */

v11 v12 v13        /* Triangle vertices */

v21 v22 v23

.

.

.

vnt1 vnt2 vnt3

ENDT               /* End of TIN group */

Sample TIN File:

TIN

BEGT

TNAM Aspen

TCOL 255 255 255

VERT 408

0.0 3.1 7.8 0

5.3 8.7 4.0 1

.

.

2.4 4.4 9.0 1

TRI 408

5 1 4

4 1 2

.

.

4 2 3

ENDT
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Cards used in the TIN file

Card Type TIN

Card ID 3000

Description File type identifier. Must be on first line of file. No fields.

Required YES

Card Type BEGT

Card ID 3000

Description Marks the beginning of a group of cards describing a TIN. There should be a corresponding ENDT card at a latter point in the file. No
fields.

Required YES

Card Type TNAM

Description Provides a name to be associated with the TIN.

Required NO

Format TNAM name

Sample TNAM aspen

Field Variable Value Description

1 name str The name of the TIN.

Card Type TCOL

Description Defines a default color for the triangles of the TIN

Required NO

Format TCOL color_red color_green color_blue

Sample TCOL 255 255 255

Field Variable Value Description

1 color_red 0–255 The red color component of TIN triangles.

2 color_green 0–255 The green color component of TIN triangles.

3 color_blue 0–255 The blue color component of TIN triangles.

Card Type MAT

Description Associates a material id with the TIN. This is typically the id of the material which is below the TIN.

Required NO

Format MAT id

Sample MAT 3

Field Variable Value Description

1 id + The material ID.
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Card Type VERT

Description Lists the vertices in the TIN

Required YES

Format VERT nv
x1 y1 z1 lf1
x2 y2 z2 lf2
.
.
xnv ynv znv lfnv

Sample VERT 4

0.0 3.1 7.8 0

5.3 8.7 4.0 1

2.4 4.4 9.0 1

3.9 1.2 3.6 0

Field Variable Value Description

1 nv + The number of vertices in the TIN

2–4 x,y,z ± Coords. of vertex

5 lf 0,1 Locked / unlocked flag for vertex (optional). 0=unlocked, 1=locked. Repeat fields 2-5 nv times.

Card Type TRI

Description Lists the triangles in the TIN

Required NO ( a set of triangles can be generated from the vertices)

Format TRI nt
v11 v12 v13
v21 v23 v23
.
.
vnt1 vnt2 vnt3

Sample TRI 4

5 1 4

4 1 2

4 2 3

5 4 3

Field Variable Value Description

1 nt + The number of triangles in the TIN.

2–4 v1,v2,v3 + Vertices of triangle listed in a counter-clockwise order. Repeat nt times.
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Card Type ENDT

Card ID 3000

Description Marks the end of a group of cards describing a TIN. There should be a corresponding BEGT card at a previous point in the file. No
fields.

Required YES

TIN Commands
When the TIN module is active, the following commands can be found in the TIN menu:
•• New TIN...

Creates a new TIN and opens the TIN Properties dialog.
•• Lock All Vertices

Since it is possible to accidentally drag points, vertices can be "locked" to prevent them from being
dragged or edited by toggling on this command.

•• TIN Settings...

Opens the Preferences dialog to the settings affecting TINs.
•• Triangulate

Creates triangles from existing vertices on the active TIN using the Delauney criteria. If triangles
already exist, they will be deleted.

•• Subdivide TIN...

Opens the Subdivision Factor dialog letting the user enter a factor by which existing triangles will be
split into smaller triangles.

• TIN → 2D Scatter Points

Creates a new 2D Scatter Point set from the vertices of the active TIN. The scatter points could then be
used for interpolation.

• TIN → 2D Mesh

Creates a new 2D mesh from the active TIN, preserving the triangles.
• Fill Between TINs → 3D Mesh

Creates a 3D mesh, or adds onto an existing 3D mesh, by filling in the space between two TINs. A 2D
mesh must exist and is used as a projection mesh for the 3D elements. Two TINs must be selected.

• Horizons → Solids...

Opens the Horizons to Solids wizard which can be used to create solids from a combination of
boreholes, TINs and conceptual models.

• Horizons → 3D Mesh...

Opens the Horizons to Mesh wizard which can be used to create a 3D mesh from a combination of
boreholes, TINs and conceptual models.

• TIN Boundary → Polygons

Creates a new coverage containing a polygon derived from the outer boundary of the TIN.
• TIN Thiessen → Polygons

Creates a new coverage containing polygons derived from the thiessen polygons of the TIN.

http://www.xmswiki.com/xms/index.php?title=GMS:Creating_a_TIN
http://www.xmswiki.com/xms/index.php?title=GMS:Preferences%23TINs
http://www.xmswiki.com/xms/index.php?title=GMS:Triangulation
http://www.xmswiki.com/xms/index.php?title=GMS:Triangulation
http://www.xmswiki.com/xms/index.php?title=GMS:Editing_a_TIN%23Subdivide_TIN
http://www.xmswiki.com/xms/index.php?title=GMS:Converting_TINS_to_Other_Data_Types%23TIN_-.3E_2D_Scatter_Points
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Scatter_Point_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Converting_TINS_to_Other_Data_Types%23TIN_-.3E_2D_Mesh
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Creating_a_3D_Mesh%23Fill_Between_TINs_-.3E_3D_Mesh
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Horizons_to_Solids
http://www.xmswiki.com/xms/index.php?title=GMS:Solid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Horizons_to_3D_Mesh
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http://www.xmswiki.com/xms/index.php?title=GMS:Converting_TINS_to_Other_Data_Types
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• TIN Contours → Arcs

Creates a new coverage containing feature arcs derived from the linear contours displayed on the TIN.
• Vertex Strings → Arcs

Creates a new coverage containing a feature arc derived from the vertex string on the TIN (if one exists).
• TIN → Extruded Solid

Opens the Extrude/Offset Tin → Solid dialog which is used to extrude the TIN vertically up or down to
form a solid.

• Fill Between TINs → Solid

Creates a solid by extruding one or more TINs to a base elevation and then performing a set operation to
remove the solid portions outside the TINs.

•• Add Breakline(s)

Inserts edges into the TIN from a defined breakline, splitting or swapping triangles as necessary.
•• Select Boundary Triangles

Selects triangles on the outer boundary which meet the "long and thin" criteria specified in TIN settings.
•• Snap Vertices to TIN

Given some selected vertices, moves them so that they are on the surface of a TIN selected from a
dialog.

•• Intersect TINs

Displays the intersection line between two selected TIN surfaces (if they intersect).
• Horizons → HUF

Opens the Horizons → HUF wizard to create MODFLOW HUF data from TINs and boreholes. TINs or
boreholes with horizon data defined are required, along with a MODFLOW simulation which uses the
HUF package.

Related Topics
•• TIN Module

http://www.xmswiki.com/xms/index.php?title=GMS:Building_Solids_and_3D_Meshes_with_TINs
http://www.xmswiki.com/xms/index.php?title=GMS:Solid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Set_Operations
http://www.xmswiki.com/xms/index.php?title=GMS:Editing_a_TIN%23Adding_Breaklines
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http://www.xmswiki.com/xms/index.php?title=GMS:HUF_Package
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
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5.2. Boreholes Module

Boreholes Module

Types of Borehole Data
A borehole can contain either stratigraphy data or sample data or both.

Stratigraphy
Stratigraphy data are used to represent soil layers that are encountered in a soil boring. The soil layers are
represented using contacts and segments as shown below. A segment represents a soil layer and a contact is the
interface between two segments.

Boreholes Representing Soil Stratigraphy With
Contacts And Segments

Sample Data
Sample data represent data obtained by continuous sampling along the length of the hole. Cone penetrometer data
and down-hole geophysical data are examples of sample data. The figure below shows an example of sample data
being displayed. Sample data are stored in datasets which can be manipulated in a similar fashion as other datasets in
GMS.

Boreholes with Sample Data

http://www.xmswiki.com/xms/index.php?title=File%3AHoles1.gif
http://www.xmswiki.com/xms/index.php?title=File%3ASampledata1.gif
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Creating and Editing Boreholes

Boreholes can be created by importing borehole data, importing sample data, or using the borehole tools to manually
enter the boreholes.
To create a borehole data file, make a file with the borehole name, x, y, z, locations and a material ID. The z location
will be the top of the soil layer. Once a borehole has been created and imported, it can be edited in the Borehole
Editor or by using the borehole tools.
When you right click on a borehole in the Project Explorer you can copy the borehole by selecting the Duplicate
command in the pop up menu. This will create a new borehole offset in x and y by 10% of the extents of the current
data in GMS. This command is useful when there is a large gap between boreholes. A new borehole with similar
stratigraphy to neighboring boreholes can be placed in the gap and the contacts can be positioned as desired. Adding
an artificial borehole or a "pseudo-borehole" in the gap gives the user more control over the shape of the TINs and
solids created from the boreholes.
Boreholes can be locked to prevent them from being edited. When the boreholes are locked, all graphical editing is
disabled and a check appears on the menu. This prevents the boreholes, the borehole contacts, and the borehole
segments from being inadvertently dragged with the mouse. Also, the Edit Window becomes disabled. The boreholes
can still be edited using the Borehole Editor. The boreholes can be unlocked by selecting the Lock All Boreholes
command again, and the check in the menu will disappear.

Auto Select
With a large number of boreholes, it may be tedious to individually select all the borehole contacts necessary for an
operation. For this reason, the capability to automatically select multiple contacts is provided with the Auto Select
command. One contact representing a prototype or example is first selected and the Auto Select command is chosen.
The Auto-Select dialog appears showing a close-up of the selected contact and allows for:
•• Matching of the material above, below, or both.
•• Starting the search from the top or the bottom of the borehole.
Since only one contact per borehole is selected, the appropriate combination of the above options is important. Each
borehole is searched from either the top or bottom of the hole until the first match is made. That contact is then
added to the set of selected contacts.
The Auto Select command can also be used with the Select Segment tool in the Borehole Tool Palette to quickly
select all segments matching a selected borehole segment. In this case, the segments are selected automatically and
the Auto Select dialog does not appear.

http://www.xmswiki.com/xms/index.php?title=GMS:Borehole_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
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http://www.xmswiki.com/xms/index.php?title=GMS:Borehole_Tool_Palette
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Borehole Editor
The Borehole Editor can be used to create new boreholes and edit existing boreholes. The existing boreholes are
displayed in a tree window at the top of the dialog, with the currently selected borehole being highlighted. The
currently selected borehole is drawn along the right side of the dialog. Both Hydrogeologic Units (HGU) and Soils
are shown.
The name of the borehole can be changed by clicking on the borehole name in the text window and typing in a new
name.
If the Set water table elevation toggle is on, a water table elevation can be entered. This can be used to display a
water table symbol on each hole.
The borehole's contacts are listed in the spreadsheet in the middle of the dialog. Contacts can be deleted and new
contacts can be inserted above the currently selected contact using the buttons just below the spreadsheet. The
material below the contact is specified by selecting the material name.

Borehole Editor dialog

http://www.xmswiki.com/xms/index.php?title=File%3AHydrogeologic_Unit_IDs.gif
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Borehole Display Options

The properties of all borehole data that GMS displays on the screen can be controlled through the Borehole tab of the
Display Options dialog. This dialog is opened by right-clicking on the  Borehole Data entry in the Project Explorer
and selecting the Display Options command. It can also be accessed from the from the Display menu or the 
Display Options macro. The following table describes the display options available for the Borehole module.

Display Option Description

Borehole edges This option controls the display of the lines that show the outline of the boreholes. The color of the borehole edges can be
adjusted according to the following options:

1. Auto – draws the material color if faces are not displayed. Uses black or white if the faces are displayed
2. Specified – used the color specified next to the borehole edges
3. Material – displays the material color of the borehole segment

Borehole faces If this option is on then the borehole segments are displayed are filled polygons.

Diameter This value determines the display size of the boreholes in the graphics window in world length coordinates.

Num. slices This edit field determines the number of slices to display the borehole. The default is 6 making the boreholes display as
hexagons.

Hole names If the Hole names box is checked, the name of each hole is displayed at the top of the hole.

Water table If the Water table box is checked, an icon representing the water table is displayed at the water table elevation of each
borehole.

Horizon IDs The horizon IDs toggle controls the display of the horizon id next to each borehole contact.

Cross sections edges The horizon ids toggle controls the display of the horizon id next to each borehole contact. 3 options are available for the
cross section edges:

1. Auto – draws the material color if faces are not displayed. Uses black or white if the faces are displayed
2. Specified – used the color specified next to the cross section edges
3. Material – displays the material color of the stratigraphic unit in the cross section

Cross section faces If this option is on then the borehole segments are displayed as filled polygons.

Cross section names If this option is on then the borehole names are displayed above the boreholes.

Material display This radio group determines the display color of the boreholes. The borehole segments can be colored either by the Soil
or HGU assigned.

Cross Section
Highlighting for
Horizon Coverages

Toggle display of the lines showing the part of the cross sections where the material with the horizon ID of the active
horizon coverage exists. This highlighting only appears when you are in plan view and the active coverage is a horizon
coverage.

Points If the Points box is checked, every sample data point is displayed. If the Use color ramp box is checked, the points are
colored according to the current dataset and the current color ramp settings.

Lines If the Lines box is checked, the sample points are connected by a series of line segments. If the Use color ramp box is
checked, the line segments are colored according to the current dataset and the current color ramp settings.

Data plots If the Data plots box is checked, a plot of the current dataset is drawn next to each borehole with sample data. The width
(horizontal length) can be adjusted and the options associated with the plot scale, plot axes, etc., can be accessed by
selecting the Plot Options button.

Data range By default, the minimum color on the color ramp is associated with the minimum dataset value and the maximum color is
associated with the maximum dataset value. The ramp of colors can be confined to a smaller interval defined by the
Maximum and Minimum values. This forces all of the color gradation to be concentrated in a particular range of interest.

http://www.xmswiki.com/xms/index.php?title=GMS:Boreholes
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http://www.xmswiki.com/xms/index.php?title=File:Dispopts.gif
http://www.xmswiki.com/xms/index.php?title=GMS:Color_Ramp
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The Display Options dialog show the Boreholes tab.

http://www.xmswiki.com/xms/index.php?title=File%3ADisplayBorehole.jpg
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Borehole Tool Palette

The following tools are available in the dynamic portion of the Tool Palette whenever the Borehole Module is
activated. Only one tool is active at any given time. The action that takes place when the user clicks in the Graphics
Window depends on the current tool. The following table describes the tools in the borehole tool palette.

Tool Tool
Name

Description

Select
Borehole

The Select Borehole tool is used to select entire boreholes. Information about the selected borehole can be obtained by using the
Get Info command from the File menu. Selected boreholes can be deleted, or dragged with the mouse. In plan view, the
borehole can be dragged anywhere in the XY plane. In other views, the borehole can only be dragged up and down along the Z
axis unless the Control key is held down, in which case the borehole can be dragged anywhere in the viewing plane. The
coordinates of the top of the borehole can be edited in the Edit Window. The name associated with a selected borehole can be
edited by double-clicking on the borehole or by selecting the Attributes command from the Edit menu while the borehole is
selected.

Select
Segment

The Select Segment tool is used to select the region between two contacts. Information about the selected segment can be
obtained by using the Get Info command from the File menu. The selected segment can be deleted unless it is the only segment
on the borehole. In plan view, the segment can be dragged anywhere in the XY plane with the mouse. In other views, the
selected segment can only be dragged up and down along the Z axis, unless the Control key is held down, in which case the
segment can be dragged anywhere in the viewing plane. The coordinates of the top contact on the segment can be edited in the
Edit Window . The material associated with the segment can be changed by double-clicking on the segment or by using the
Attributes command in the Edit menu. Several segments with the same material type can be selected automatically by using the
Auto Select command or they can be selected sequentially while holding down the Shift key.

Select
Contact

The Select Contact tool is used to select the interfaces between soil layers. Selected contacts can be deleted as long as there are
at least two contacts remaining on the borehole after deletion. In plan view, the selected contact can be dragged anywhere in the
XY plane with the mouse. In other views, the selected contact can only be dragged up and down along the Z axis, unless the
Control key is held down, in which case the contact can be dragged anywhere in the viewing plane. The coordinates of the
contact can be edited in the Edit Window. Multiple contacts can be selected sequentially by holding down the Shift key, or they
can be selected automatically using the Auto Select command. Selected contacts can be used to create TINs. A horizon id can
be assigned to a selected contact(s) by selecting the Properties command in the Edit menu.

Select
Cross
Section

The Select Cross Section tool selects existing cross sections by clicking on the selection icon in the GMS graphics window
when this tool is active. See the figure below.

Create
Borehole

The Create Borehole tool can be used to create a new borehole at the location clicked on by the mouse. The user is first
prompted for the missing coordinate (i.e., in plan view, the z coordinate is asked for). Boreholes can not be created in oblique
view. The borehole is given a default name of "New Borehole" and three segments which are ten units long by default. A newly
created borehole can be edited using the other tools in the Tool Palette or the Borehole Editor.

Create
Contact

The Create Contact tool can be used to create a new contact on an existing borehole by clicking on the borehole at the location
where the new contact is to be located. The user is then prompted for the material associated with the contact (the material for
the segment below the contact).

Create
Cross
Section

The Create Cross Section tool creates user defined cross sections between existing boreholes. To create a single cross-section,
the user clicks on the first hole and then double-clicks on the second hole. Multiple panels of a cross section can be created at
once (i.e., a fence diagram) by single-clicking on sequence of boreholes and double-clicking on the last borehole.

The figure below shows a set of borehole cross sections. The cross section selection icon is the black diamond near
the center of each of the cross sections. A cross section can be edited by selecting its corresponding icon and
selecting the Cross Section Editor command from the Borehole menu or by double-clicking on the selection icon.
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Set of borehole cross sections
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Borehole Hydrogeologic Units

Hydrogeologic units (HGUs) can be defined on boreholes. HGUs are typically a simplified representation of the soil
layers from the borehole field data. For example, the borehole log may include several types of sand ("brown sand",
"gray silty sand", "clean sand"), but for modeling purposes, you may want to treat these all as one material, "sand".
Now you can show both the original soils and the simplified HGUs on the boreholes.

Importing Borehole Data
When importing borehole data, both an HGU and Soil ID column can be specified in the input. Files containing only
a single set of materials can be imported to either field and the other field can be populated using the conversion
tools described below.

Creation
The HGU and soil IDs can be edited using the Borehole Editor.

Display
The boreholes can be displayed in the main graphics window using either the HGU IDs or the soil IDs. The ID used
for display can be selected in the Display Options dialog.

Borehole Display Options

Soils → HGUs, HGUs → Soils
A set of soil IDs can be converted to a set of HGU IDs using the Soils→HGUs command in the Borehole menu.
Likewise, a set of HGU IDs can be converted to a set of soil IDs using the HGUs→Soils command.

Building Cross-Sections, Solids
When building cross-sections or solid models using boreholes, the HGU IDs are used by GMS. The soil IDs are used
purely for visualization or for setting up the HGU IDs.
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Converting Borehole Data

Borehole data can be converted to other types of objects with in GMS such as 2D Scatter Points, TINs, 3D Meshes.
Borehole data is converted by using the following commands in the Boreholes menu:
•• Horizons to Solids
•• Horizons to HUF
•• Horizons to 3D Mesh
•• Contacts to TIN

The Contacts → TIN command is used to create a TIN surface from a set of selected contacts.
•• Contacts to 2D Scatter Points

A set of selected contacts can be converted to a 2D scatter point set using the Contacts → 2D Scatter
Points command.

•• Sample Data to 3D Scatter Points
The Sample Data → 3D Scatter Points command brings up the Sample Data → Scatter Points dialog
that is used to create a 3D scatter point set from sample data.

•• Sample Data to Stratigraphy
•• Watertable to 2D Scatter Points

The water table coordinates for a set of boreholes can be converted to a 2D scatter point set using the
Water Table → 2D Scatter Points command.

•• Add Contacts to TIN
The Add Contacts to TIN command is used to enter a point from a contact into the active TIN. The
contact(s) are first selected and the command is then chosen from the Borehole menu. Typically all
contacts which should be part of a TIN are selected before generating the TIN, but sometimes one is
inadvertently left out, or more boreholes are added later.
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Borehole Cross Sections

A borehole cross section is a set of polylines and polygons that define the stratigraphy between two boreholes. A
borehole cross section can be created manually or automatically.

Creation

Automatic creation
Cross sections can be created automatically using the Boreholes | [Auto-Create Blank Cross Sections menu
command. This uses a triangulation process to determine the most likely connections between boreholes. The top
and/or bottom arcs of the new cross sections can be warped to match the elevation of TIN surfaces using the Snap
Cross Sections to TIN dialog which appears when the Boreholes | Auto-Create Blank Cross Sections command is
executed. Snapping the tops and bottoms of cross sections to TIN surfaces can also be done at any time via the
Boreholes | Advanced | Snap Cross Sections to TIN menu command. Keep in mind, however, that warping the top
and bottom of a cross section may interfere with the internal polygons that are defined in the cross section, so
snapping to a TIN is best done before filling in the cross sections.
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Manual creation
Cross sections can be created manually by using the Create Cross Section tool and clicking on boreholes.

Editing
When a borehole cross section is first created, it is made up of a set of default lines. The figure below shows a
default cross section. Notice that "arcs" (polylines) have been created defining the top and bottom of the cross
section and an "arc" (polyline) has been created for each segment in the boreholes.

Default cross section

Automatic editing
The Boreholes | Auto-Fill Blank Cross Sections menu command can be used to automatically fill in all existing
blank cross sections. The command can use either the horizon IDs (preferred) or materials information on the
boreholes.

Manual editing
To edit a cross section manually, the user must use the Select Cross Section tool and select a cross section. The
Cross Section Editor dialog can be then opened by selecting the Cross Section Editor command from the Borehole
menu while the user has either a single or a series of cross sections selected. The user can also launch the Cross
Section Editor dialog by double-clicking on a single cross section. The next figure shows a finished cross section.
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Complete cross section

Borehole Cross Section Editor
The Cross Section Editor can be used to manually construct and view cross sections between boreholes. The Cross
Section Editor in GMS 6.5 has been updated to allow for the display and editing of multiple borehole cross sections.
The Cross Section Editor has a set of tools and toggles used to create, edit, and view the cross sections. The tools
used to create the nodes, polylines, and polygons are similar to the tools available in the Map module used to create
feature objects (points, arcs, and polygons). The following tables describe the tools and display options available in
the Cross Section Editor.

Tools

Tool Tool Name Description

Select Tool Generic selection tool that selects nodes, vertices, arcs, and polygons

Select Point/Node Selection tool that will only select points or nodes

Select Vertex Selection tool that will only select vertices

Select Arc Selection tool that will only select arcs

Select Polygon Selection tool that will only select polygons

Create Vertex Creates new vertices along arcs within the cross section

Create Arc Creates arcs between two nodes or vertices within the cross section

Pan Pans in the viewing area of the Graphics Window

Zoom Magnifies or shrinks the current viewing area
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Frame All Cross
Sections

Frames to the extents of all the cross sections

Frame Current
Cross Section

Frames to the extents of the current cross section

Z-Magnification Adjusts the Z-Magnification factor to increase or decrease the graphical display along the Y (real world Z) axis, making
more or less room at the top and bottom of the screen while maintaining the boreholes and cross sections in the middle
of the screen

Plot Options Adjusts the axes plot options, including: title, background color, font, font color, grid display, axes titles, and axes
display

Delete Deletes the currently selected vertices, nodes, arcs, or polygons

Left Activates the cross section to the left of the current cross section as the current cross section

Right Activates the cross section to the right of the current cross section as the current cross section

Print Prints the current Graphics Window

Auto-Match Cross
Section

Creates a set of straight arcs connecting matching contacts on adjacent boreholes based on the user's selection to use
Horizons or Materials

Build Cross
Section Polygons

Deletes all current polygons, builds new polygons using all of the arcs, and checks to see if every polygon built is valid.
A polygon is valid only if it contains either one arc representing a borehole region or two arcs representing two
matching borehole regions on two holes. Thus, every valid polygon can be assigned one and only one material type. If
every polygon built is valid, the Color Fill toggle will be automatically turned on and all polygons built will be filled
with the color representing the material they are assigned. Otherwise, a dialog saying "Invalid polygons present" will
pop up and all polygons built will be deleted.

Delete All Deletes all of the vertices, nodes, arcs, and polygons in the current cross section

Display Options

Display Toggle Description

Nodes Controls the display of the nodes in the graphics window

Vertices Controls the display of the vertices in the graphics window

Arcs Controls the display of the arcs in the graphics window

Boreholes Controls the display of the arcs in the graphics window

Poly fill Controls the display of the polygons in the graphics window

Mirror view Reverses the order in which the cross sections are displayed

Mark inactive Dims the inactive cross sections

Display axes Controls the display of the plot axes in the graphics window
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Borehole Commands
When the Borehole module is active the Borehole menu become active. The menu has the following commands:
•• New Borehole

Creates a new Borehole.
•• Borehole Editor...

Opens the Borehole Editor.
•• Cross Section Editor...

Brings up the Cross Section Editor dialog where one or multiple 2D cross sections between boreholes
are filled.

•• Lock All Boreholes

Turns off the ability to change the position (drag) of created boreholes.
•• Auto Select Contacts/Segments...

When one contact or segment is selected, automatically selects matching contacts or segments on other
boreholes.

•• Auto-Create Blank Cross Sections...

Automatically connects boreholes with blank borehole cross sections.
•• Auto-Assign Horizons...

Automatically assigns horizon IDs to borehole contacts based on material ordering and adjacent
boreholes.

•• Auto-Fill Blank Cross Sections...

Automatically fills all blank cross sections by connecting the contacts on one borehole to those on the
other.

• Horizons → Solids...

Opens the Horizons to Solids wizard which can be used to create solids from a combination of
boreholes, TINs and conceptual models.

• Horizons → 3D Mesh...

Opens the Horizons to Mesh wizard which can be used to create a 3D mesh from a combination of
boreholes, TINs and conceptual models.

Advanced > submenu

• HGUs → Soils

Copies the HGU material IDs to the soil IDs, overwriting the existing soil IDs.
• Soils → HGUs

Copies the soil material IDs to the HGU IDs, overwriting the existing HGU IDs.
•• Snap Cross Sections to TIN...

Opens a dialog allowing the user to snap the top and/or bottom arcs of the cross sections to TINs.
•• Snap Boreholes to TIN...

Opens a dialog allowing the user to pick a TIN. The selected boreholes (or all, if none are selected) are
moved up or down in the Z direction such that their tops just touch the TIN surface. Multiple TINs can
be selected. If a borehole can be snapped to more than one TIN, it will be snapped to whichever TIN is
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last.
•• Add Contacts to TIN

Inserts a new vertex into the active TIN at the location of every selected borehole contact.
•• Bounding 3D Grid...

Opens the Create Finite Difference Grid dialog with dimensions defaulted such that the new grid will
surround all existing boreholes.

• Contacts → TIN

Creates a new TIN with vertices at the locations of the selected contacts.
• Contacts → 2D Scatter Points...

Creates a new 2D scatter point set with vertices at the locations of the selected contacts.
• Watertable → 2D Scatter Points...

Creates a new 2D scatter point set with vertices at the locations of the water table specified on each
borehole.

• Sample Data → 3D Scatter Points...

Brings up the Sample Data → Scatter Points dialog that is used to create a 3D scatter point set from
sample data.

• Sample Data → Stratigraphy

Opens the Sample Data → Stratigraphy dialog allowing the user to define stratigraphy (borehole
contacts) based on the sample data.

• Horizons → HUF

Opens the Horizons → HUF wizard to create MODFLOW HUF data from TINs and boreholes. TINs or
boreholes with horizon data defined are required, along with a MODFLOW simulation which uses the
HUF package.

Related Topics
•• Boreholes
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5.2.1. Horizons

Horizons
The term “horizon” refers to the top of each stratigraphic unit that will be represented in a corresponding Solid, HUF
unit, or 3D Mesh Layer. Horizons are numbered consecutively in the order that the strata are “deposited” (from the
bottom up). Horizons can be assigned to Boreholes, TINs, and Coverages. Beginning with version 9.0, raster
catalogs can also be used to define horizons.
Once horizons have been assigned to boreholes, TINs, and/or Rasters, the Horizons Wizard can be used to create
solids, 3D mesh, or HUF data.

Assigning Horizons to Boreholes
On boreholes, Horizons are defined at borehole contacts. Each contact that the user wishes to include in the
construction of the solid must have a non-zero horizon ID. If the user wishes to ignore a contact, this can be done by
leaving the horizon ID set to zero. Horizons are numbered in the order that the strata are “deposited” (from the
bottom up). Gaps can exist in the horizon numbering. For example, horizons can be assigned using 1, 2, 3, ect..., or
the user could assign horizons using 10, 20, 30, etc... Using larger numbers with gaps can be useful if more horizons
are added at a later time.

Automatic Assignment
To have GMS automatically assign horizon IDs to boreholes, you can use the Boreholes | Auto-Assign Horizons
menu command. Depending on the number and complexity of your boreholes, this command can take a considerable
amount of time.

Manual Assignment
Horizons are defined at borehole contacts (interface between different materials on a borehole log) by double
clicking on a contact with the Select Contact tool. The Boreholes | Auto Select command can be helpful in
assigning horizons to a large group of boreholes.

Horizons assigned to contacts on boreholes
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Assigning Horizons to TINs
A TIN Horizon is assigned in the TIN properties dialog. This dialog can be accessed by right-clicking on a TIN in
the Project Explorer and selecting the properties command. Each TIN can be assigned one Horizon ID. Each TIN
that the user wishes to include in the horizons algorithm must have a horizon ID. If the user wishes to ignore a TIN,
this can be done by setting the horizon ID to zero.

Horizons assigned to contacts in TIN Properties
Dialog

Assigning Horizons to Rasters
Raster can also be used to define horizons. See the Raster Catalog page for more information on using Rasters with
horizons.
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Horizon Conceptual Model
If the user wishes to explicitly control the areal extent of a solid created from horizons, this can be done using
horizon coverages. GMS has a conceptual model type for horizons. Coverages that are inside of a horizons
conceptual model can be associated with a horizon ID. The polygons in a horizon coverage determine the areal
extent of the solid for the associated horizon. The first figure below shows a horizon coverage for the green material.
The solid associated with this horizon will not extend beyond the boundary of the polygon. The second figure shows
the solid resulting from the boreholes and the horizon coverage. When the Horizons→Solids command is executed
the user may include a Horizons conceptual model as part of the input to the command.

The Horizons algorithm is used to create either solids, HUF units, or 3D Meshes from Borehole and TIN data. How
to use the three Horizon commands are explained in more detail below:
•• Horizons to Solids
•• Horizons to 3D Mesh
•• Horizons to HUF
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Horizons Applications
The horizons method has been applied at a variety of sites to construct solid models of the subsurface. This page
highlights example applications of the Horizons Method.

Modeling a Slope Failure
In this example a combination of boreholes, user defined cross sections, and TINs were used to create solids at a site
with a slope failure.

Borehole data Surface elevations Failure surface

User defined cross sections
One user cross section

Zoomed in on cross sections

Solids created from user data Cross sections from solids Zoomed in on cross sections

http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsectBore.png
http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsectTop.png
http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsectFailure.png
http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsect.png
http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsectUserXsect.png
http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsectZoom.png
http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsectSolids.png
http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsectSolidsXSects.png
http://www.xmswiki.com/xms/index.php?title=File%3ASlopeXsectSolidsXSectsZoom.png


Horizons Applications 71

Vertical Boundary Between Solids
In this application the user wanted to create a set of solids where there would be distinct materials below a river bed
compared to the other materials in the study area. The following cross section shows what the user wanted to create.

Primary TINs
To create solids that would match this cross section, the user created 2 different primary tins and executed the
Horizons→Solids command for each primary TIN. The first TIN covered the area of the river and the second TIN
covered the remainder of the study area as show in the images below.

Solids
The user had TINs that defined the top elevations of the horizon surfaces. There were 3 TINs used in the area around
the river and there were 4 TINs used the remainder of the study area. Solids were created for the river area using the
first TIN as the primary TIN. Solids were also created in remainder of the study area by using the second TIN as the
primary TIN. Notice the the bottom most material matches in both sets of solids. This is because the same TIN with
that horizon was used when creating both sets of solids.

Cross Sections from Solids
These images show the solids together and cross section cut through the solids. Again notice how the bottom most
material matches across both sets of solids.
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Horizons to HUF
The following steps illustrate how to use the Horizons method to create HUF data
1. Create/Import Inputs – There are two main types of inputs for the horizons method:

1. Boreholes – Boreholes can be created by importing borehole data by using the File Import Wizard, importing
sample data after boreholes already exist, or using the borehole tools to manually enter the boreholes. Once a
borehole has been created it can be edited in the Borehole Editor or by using the borehole tools. Also an
existing borehole can be copied. Boreholes can be locked to prevent them from being edited.

2. TINs – TINs can be created 3 different ways in GMS: manually entering the vertex locations and
triangulating, converting a different GMS data type to a TIN, and copying a currently existing TIN. (See
Creating TINs)

3. Raster Catalog – a set of rasters defining the top of each horizon (available beginning in version 9.0).
2. Assign Horizon IDs – The term “horizon” refers to the top of each stratigraphic unit that will be represented in a

corresponding Solid, HUF unit or Material Layer. Horizons are numbered consecutively in the order that the
strata are “deposited” (from the bottom up). Horizons can be assigned to both Boreholes and TINs. (See
GMS:Horizons)

3. Create 3D Grid/MODFLOW model – A 3D Grid and MODFLOW model need to be first created to use the
Horizon rarr; HUF command. The flow package for the MODFLOW model must also be set to use the HUF
package. Before building a MODFLOW simulation, a 3D grid must be created which covers the area to be
modeled. A grid can be created by selecting the Create Grid command in the Grid menu. A suite of tools and
commands for editing grids (inserting rows, changing column widths, etc.) are also provided in the 3D Grid
Module. If the conceptual model approach is used to construct a MODFLOW model, the grid can be
automatically constructed from the conceptual model data using the Grid Frame and the Map → 3D Grid
command in the Feature Objects menu. The grid can be automatically refined around wells and cells outside the
model domain can be inactivated.

4. Setup additional optional inputs – Two additional options exist to help constrain and provide user intervention
in the Horizon modeling process. The two options are to create borehole cross sections or a horizon conceptual
model.
1.1. Including Borehole Cross Sections
2.2. Horizon Conceptual Model

5. Run the Horizons Wizard – Select the Horizons→3D Mesh command in the Borehole or TINs menu.

Horizon → HUF Algorithm

Example of Horizons to HUF

When the Horizon command is executed the horizons specified on the
borehole contacts or TIN nodes are converted to a set of scatter points
with one data set for each horizon. The scatter points are then used to
interpolate a surface for each horizon. Starting with the lowest
numbered horizon, the surface is extruded down to create a HUF layer
The surface corresponding to the next horizon is then extruded down to
fill in the space between that surface and the previous surface. This
process is repeated for each surface. At each step, HUF layer is created
for the current horizon and all previously layers are subtracted from
that layer, resulting in an incremental buildup of the stratigraphy from the bottom to the top. In conclusion the HUF
Package elevation and thickness arrays are generated from the horizon data.
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Horizons Wizard
The Horizons Wizard is used to create solids, a 3D mesh, or HUF layers from horizon data. The wizard is started via
the Horizons → Solids, Horizons → 3D Mesh, and Horizons → HUF commands. These commands are in the TIN
and Boreholes menus.

Step 1
The first step is to define the inputs to be used, which can include boreholes, TINs, and a Horizon Conceptual
Model.
Beginning with GMS 9.0, you can also include a raster catalog as input.

Step 2
The second step is to define the top and bottom of the solid, mesh, or HUF layers. When creating HUF data, you
may also edit the grid elevations.

Step 3
The third step is to define the interpolation method to be used, as well as options specific to creating solids, a mesh,
or HUF package.
Beginning with GMS 7.0, when creating solids, the user can choose the option Preserve projection TIN datasets.
This option will create a new TIN that will have a dataset for each horizon. This is often useful so that the user can
see the result of the interpolation process for each Horizon. The user can then edit the TIN by hand and include the
TIN when executing the Horizons→Solids command.
When creating a 3D mesh for a FEFLOW simulation make sure to turn on the Prevent pinchouts (FEFLOW mesh)
option. This will ensure that the mesh will contain all prism elements and that every mesh layer is continuous
throughout the mesh.
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Horizons to Solids
The following steps illustrate how to use the Horizons method to create solid stratigraphy.
1. Create/Import Inputs – There are two main types of inputs for the horizons method:

1. Boreholes – Boreholes can be created by importing borehole data by using the File Import Wizard, importing
sample data after boreholes already exist, or using the borehole tools to manually enter the boreholes. Once a
borehole has been created it can be edited in the Borehole Editor or by using the borehole tools. Also an
existing borehole can be copied. Boreholes can be locked to prevent them from being edited.

2. TINs – TINs can be created 3 different ways in GMS: manually entering the vertex locations and
triangulating, converting a different GMS data type to a TIN, and copying a currently existing TIN. (See
Creating TINs)

3. Raster Catalog – a set of rasters defining the top of each horizon (available beginning in version 9.0).
2. Assign Horizon IDs – The term “horizon” refers to the top of each stratigraphic unit that will be represented in a

corresponding Solid, HUF unit or Material Layer. Horizons are numbered consecutively in the order that the
strata are “deposited” (from the bottom up). (See Horizons)

3. Create Primary TIN – A TIN must be created or imported into GMS to be used as the Primary TIN for the
Horizons method. The primary TIN defines the boundary of the solids that will be generated. Also, the density of
the triangles in the primary TIN controls the density of the triangles in the solids that are created. (See Creating
TINs)

4. Setup additional optional inputs – Two additional options exist to help constrain and provide user intervention
in the Horizon modeling process. The two options are to create borehole cross sections or a horizon conceptual
model.
1.1. Including Borehole Cross Sections
2.2. Horizon Conceptual Model

5. Run the Horizons Wizard – Select the Horizons→Solids command in the Borehole or TINs menu.

Horizon → Solid Algorithm
When the Horizon command is executed the horizons specified on the borehole contacts or TIN nodes are converted
to a set of scatter points with one dataset for each horizon. The scatter points are then used to interpolate a surface for
each horizon. Starting with the lowest numbered horizon, the surface is extruded down to create a solid. The surface
corresponding to the next horizon is then extruded down to fill in the space between that surface and the previous
surface. This process is repeated for each surface. At each step, a solid is created for the current horizon and all
previously defined solids are subtracted from that solid, resulting in an incremental buildup of the stratigraphy from
the bottom to the top. The entire process is simpler, more intuitive, and more robust than the old set operations
approach.
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Solids created from the horizons method

Cross sections from the solid created via the
horizons method

http://www.xmswiki.com/xms/index.php?title=File%3ASamp_solids.gif
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Horizons to 3D Mesh
The following steps illustrate how to use the Horizons method to create 3D Mesh stratigraphy.
1. Create/Import Inputs – There are two main types of inputs for the horizons method:

1. Boreholes – Boreholes can be created by importing borehole data by using the File Import Wizard, importing
sample data after boreholes already exist, or using the borehole tools to manually enter the boreholes. Once a
borehole has been created it can be edited in the Borehole Editor or by using the borehole tools. Also an
existing borehole can be copied. Boreholes can be locked to prevent them from being edited.

2. TINs – TINs can be created 3 different ways in GMS: manually entering the vertex locations and
triangulating, converting a different GMS data type to a TIN, and copying a currently existing TIN. (See
Creating TINs)

3. Raster Catalog – a set of rasters defining the top of each horizon (available beginning in version 9.0).
2. Assign Horizon IDs – The term “horizon” refers to the top of each stratigraphic unit that will be represented in a

corresponding Solid, HUF unit or Material Layer. Horizons are numbered consecutively in the order that the
strata are “deposited” (from the bottom up). Horizons can be assigned to both Boreholes and TINs. (See Horizons)

3. Create Primary 2D Mesh – A 2D mesh is needed to be used as a projection for the resulting 3D mesh. A 2D
mesh or a meshing coverage needs to be created and selected as the primary mesh. The 2D mesh defines the
boundary of the 3D Mesh. Also, the meshing options assigned to primary coverage controls the elements of the
3D Mesh that is created. (See Creating 2D Meshes)

4. Setup additional optional inputs – Two additional options exist to help constrain and provide user intervention
in the Horizon modeling process. The two options are to create borehole cross sections or a horizon conceptual
model.
1.1. Including Borehole Cross Sections
2.2. Horizon Conceptual Model

5. Run the Horizons Wizard – Select the Horizons→3D Mesh command in the Borehole or TINs menu.

Horizon → 3D Mesh Algorithm
When the Horizon command is executed the horizons specified on the borehole contacts or TIN nodes are converted
to a set of scatter points with one dataset for each horizon. The scatter points are then used to interpolate a surface for
each horizon. Starting with the lowest numbered horizon, the surface is extruded down to create a set of elements in
a 3D Mesh. The surface corresponding to the next horizon is then extruded down to fill in the space between that
surface and the previous surface. This process is repeated for each surface. At each step, a set of elements are created
for the current horizon and all previously defined elements are subtracted from that layer, resulting in an incremental
buildup of the stratigraphy from the bottom to the top. The entire process results in a 3D Mesh with each horizon
layer represented by a Material Zone.

TINs used to create 3D Mesh below 3D Mesh created via the horizons method
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http://www.xmswiki.com/xms/index.php?title=File%3AHor_TINs.gif
http://www.xmswiki.com/xms/index.php?title=File%3AHor_3DMesh.gif


77

5.3. Solid Module

Solid Module

The Solid module of GMS is used to construct three-dimensional models of stratigraphy using solids. Once such a
model is created, cross sections can be cut anywhere on the model to create fence diagrams.

Example of a solid created in GMS

Example of fence diagrams created using solids

Solids are used for site characterization and visualization. Solids can also be used to define layer elevation data for
MODFLOW models using the Solids → MODFLOW command or Solids to HUF and to define a layered 3D mesh
using the Solids → Layered Mesh.

http://www.xmswiki.com/xms/index.php?title=File%3ASolids.gif
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Solid Properties

The Solid Properties dialog allows the user to edit/view attributes of the selected solid. This dialog can be accessed
by selecting a solid from the Project Explorer, right-clicking to access the pop up menu, and selecting the Properties
command. It can also be accessed by double-clicking on a solid in the graphics window, or by selecting a solid and
then selecting the Properties command from the Edit menu.
The following items can be edited in the properties dialog:

Name Name of the solid

Material Material associated with the solid

Begin Layer beginning grid layer assigned to solid used with Solids→MODFLOW

End Layer ending grid layer assigned to solid used with Solids→MODFLOW

Use top cell bias option for using the top cell bias used with Solids→MODFLOW

Top cell bias the percent to bias the thickness of the top cell with Solids→MODFLOW

Target min. cell thickness minimum cell thickness used with Solids→MODFLOW

These items are display as information about the solid:
•• Solid ID
•• Number vertices
•• Number triangles
•• Max z
•• Min z
•• Centroid,x
•• Centroid,y
•• Centroid,z
•• Volume

http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:Solids_to_MODFLOW_Command
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Solid Primitives

To allow the addition of a trench, building, excavation, tunnel, etc. to a solid model, GMS provides the capability of
generating several types of simple solid primitives. The solid primitives can be combined using set operations to
model man made objects or other subsurface features which cannot be conveniently modeled by extruding TINs.

Cube
Simple cubes or, more precisely, hexahedrons whose faces are all parallel to the x, y, and z planes, can be created by
selecting the Cube command from the Solids menu and specifying the center point of the cube and the x, y, and z
dimensions.

Sphere
A sphere can be created by selecting the Sphere command from the Solids menu and inputting the radius of the
sphere, the coordinates of the centroid of the sphere, and the number of subdivisions. The number of subdivisions
determines the density of triangles used to approximate the sphere.

Cylinder
A cylinder can be created by selecting the Cylinder command from the Solids menu and inputting the coordinates of
both ends of the cylinder, the radius of the cylinder, and the number of subdivisions in the cylinder. The number of
subdivisions determines the density of triangles used to approximate the cylinder. The larger the number, the more
accurate the representation will be, however the increased number of triangles will also cause display operations to
be slower.

Prism
A prism can be created by first putting the image into plan view and then selecting the Prism command from the
Solids menu. The user is then prompted to input a polygon. As with other polygons entered in GMS, the Backspace
or Delete key can be used to delete the last point entered, the ESC key can be used to abort the process, and
double-clicking terminates point entry. The user is then prompted to enter a bottom elevation and a top elevation for
the prism. The default values given for the top and bottom elevation represent elevations just above and just below
all of the other solids. The polygon is then extruded from the top to the bottom elevation to create a solid object.

http://www.xmswiki.com/xms/index.php?title=GMS:Set_Operations
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Solid Display Options

The Display Options dialog showing the Solids tab.

The properties of all solid data that
GMS displays on the screen can be
controlled through the Solids tab of the
Display Options dialog. This dialog is
opened by right-clicking on the 
Solid Data entry in the Project
Explorer and selecting the Display
Options command. It can also be
accessed from the from the Display
menu or the  Display Options
macro. The following table describes
the display options available for the
solids module.

Display
Option

Description

Solid edges The Solid edges item is used to display the edges of the solid. The solids are either drawn using the default cell color or the color of
the material associated with each solid.

The color of the solid edges can be adjusted according to the following options:

1. Auto – draws the material color if faces are not displayed. Uses black or white if the faces are displayed
2. Specified – used the color specified next to the solid edges
3. Material – displays the material color of the solid

Solid faces The Solid faces item causes the faces of the solid to be drawn as filled polygons.

http://www.xmswiki.com/xms/index.php?title=File%3ADisplaySolid.jpg
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Solid Module Tool Palette
The following tools are available in the dynamic portion of the Tool Palette whenever the Solid module is activated.
Only one tool is active at any given time. The action that takes place when the user clicks in the Graphics Window
depends on the current tool. The following table describes the tool in the solid tool palette.

Tool Tool
Name

Description

Select
Solid

The 'Select Solid tool is used to select solids for deletion or for set operations. When this tool is active, a solid icon appears at the
centroid of each solid. A solid is selected by selecting the icon. When a different tool is selected, the icons disappear.

Select
Face

The Select Face tool is used to select the faces of a solid.

'Select
Cross
Section

Once a set of cross sections has been created, they can be selected using the Select Cross Section tool. Selected cross sections
can be deleted or made visible or invisible using the Hide and Show commands.

When this tool is active, a cross sections icon appears on each cross section. A cross section is selected by selecting the icon.
When a different tool is selected, the icons disappear. When there are several cross sections, it is often easier to differentiate cross
section icons in plan view (assuming the cross sections were created in plan view). As a general rule, the icons are placed in the
center of the first line segment used to cut the cross section.

Create
Cross
Section'

Cross sections can be created from the solids that are currently being displayed using the Create Cross Section tool. Cross
sections are formed when the user enters a polyline. A polyline is entered by clicking on several points and double-clicking on
the final point when the line is finished. The Delete or Backspace key may be used to remove a point from the polyline, and the
ESC key can be used to abort the process. A cross section or fence diagram is then computed by cutting perpendicular to the
current viewing orientation through the currently visible solids (a solid can purposefully be left out of a cross section by hiding it
before making the cross section). A section or "panel" in the fence diagram is created for each line segment in the polyline. While
most cross sections are created with the solids in plan view, any viewing orientation can be specified.

When cross sections are created, the materials associated with the solids are inherited by cross sections. Cross sections can be
saved to a file if desired.

http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
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Solids to Layered Mesh
The Solids → Layered Mesh command in the Solids menu can be used to quickly build a 3D finite element mesh
that matches the stratigraphy defined by a set of solids. This option is similar to the Boundary Matching option of the
Solids → MODFLOW command except it results in a layered 3D finite element mesh that honors the horizontal
boundaries of the stratigraphic layers defined by a set of solids. The steps involved in using the Solids → Layered
Mesh command are as follows:

1. Create a 2D Projection Mesh
The first step is to create a 2D projection mesh. This mesh represents a plan view of the 3D mesh. Each triangle in
the 2D mesh will result in a column of 3D wedge elements and each quadrilateral in the 2D mesh will result in a
column of 3D hexahedral elements. The 2D mesh can be refined around well locations if desired. This mesh is
typically created using the Map module as part of the FEMWATER conceptual model.

2. Create the Solids
The next step is to create the solids defining the stratigraphy. The boundary of the solids should be slightly larger
than the 2D projection mesh.

3. Assign layer ranges to the Solids
As is the case with the Solids → MODFLOW Boundary Matching option, a layer range should be assigned to each of
the solids. There is one significant difference in assigning layer ranges with the Solids → Layered Mesh command
is that every layer in the 3D mesh must be present in the solids. You can not have "inactive" mesh elements similar
to "inactive" grid cells.

4. Solids → Layered Mesh Command
Unlike the Solids → MODFLOW Boundary Matching option, it is not necessary to create a 3D mesh before selecting
the Solids → Layered Mesh command. The 3D mesh is automatically generated. Each element in the 2D projection
mesh is extruded into a vertical column of cells and the solids are used to assign the elevations to the nodes. The
material ids are assigned to the 3D elements by finding the solid that encompasses the centroid of each 3D element
assigning the material id of that solid to the element.

http://www.xmswiki.com/xms/index.php?title=GMS:2D_Mesh_Module
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http://www.xmswiki.com/xms/index.php?title=GMS:FEMWATER
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Mesh_Module
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Sample Mesh
A sample mesh created with the Solids → Layered Mesh option is shown below. Note that the solids boundaries are
preserved at the tops and bottoms of the solids but the transition along the edges of the solids can be irregular.

Sample mesh created using the Solids → Layered
Mesh command

Solids to HUF
The Solids → HUF command in the Solids menu of the Solid Module can be used to generate the HUF Package
input data from the solids currently in your project.
This command brings up the Solids → HUF dialog. By turning on the Adjust grid cell elevations toggle the user will
adjust the 3D grid cell elevations. The Minimum cell thickness edit field allows the user to specify a minimum cell
thickness. When the elevations are adjusted, if a cell has a thickness less than the minimum the bottom cell in that
column will be inactivated and the cell elevations will be recalculated. The Fraction spreadsheet contains a row for
each layer in the 3D grid. By default, each layer is assigned an equal fraction. The user can edit the fraction assigned
to any layer by checking the Edit toggle and changing the fraction. Any layers that don't have the Edit toggle
checked are evenly distributed so that the sum of the all the fractions is one.
When the user selects OK from the Solids → HUF dialog the solids are intersected by the grid. The intersections of
the solids are then converted into HUF hydrogeologic unit top and thickness arrays.

Example of HUF data created from solids
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Solids to MODFLOW Command
The Solids → MODFLOW command represents a powerful tool for modeling complex stratigraphy in a completely
grid-independent fashion. As part of the overall conceptual model building process, the stratigraphy at a site is
modeled as a set of solids. The solids are built using tools in the Borehole, TIN, and Solids modules. These solids
can represent a wide variety of complex stratigraphic relationships. The user then assigns hydraulic conductivity (Kh
and Kv) and storage coefficients to the solids as material properties and a multi-layer grid is constructed where the
boundary of the grid occupies the same region of the solids in plan view. The Solids → MODFLOW command can
then be used to automatically define the elevation arrays in MODFLOW. If the grid is refined or edited in any way,
this command can be selected again to rebuild the arrays in seconds with no further user intervention. Together with
the feature objects in the Map module, a set of solids can be used to build a completely grid-independent conceptual
model regardless of the complexity of the site.
Following is the set of steps required to use the Solids → MODFLOW command:
1.1. Building the Solids
2.2. Material Properties
3.3. Creating the Grid
4.4. When using Boundary matching, match layers to solids
5. Execute Solids → MODFLOW

Building the Solids
Before executing the Solids → MODFLOW command, a set of solids should be contructed that match the site
stratigraphy. These solids are typically constructed using the horizons approach. When building these solids, it is
best to build the primary TIN with a larger outer polygon boundary than the boundary that is used to define the
MODFLOW conceptual model. This ensures that the stratigraphy will encompass all of the grid.

Material Properties
The next step is to create a set of material properties for the solids using the Material Properties command in the
Solids menu.

Creating the Grid
Once the solids are created and the layer assignments are made, the next step is to create a grid. The grid boundary in
the xy plane (plan view) should either match the boundary of the solids or encompass the solids. The grid can be
refined around wells if desired. The number of layers in the grid should be compatible with the layer assignments
made to the solids. When the grid is first created, the z elevations can be ignored since they will be inherited from
the solids. A sample grid is shown below.
After the grid is created, the cells outside the model domain should be inactivated using the Activate Cells in
Coverage command in Feature Objects menu in the Map module.
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Sample grid created in GMS

Solids → MODFLOW Options
Now you are ready to execute the Solids → MODFLOW command. This command brings up a dialog listing the
three basic options associated with the Solids → MODFLOW command. Each option utilizes a different approach
for converting the solid stratigraphy to the MODFLOW BCF input arrays. The three options are:
1.1. Boundary Matching
2.2. Grid Overlay
3.3. Grid Overlay with Keq

Boundary Matching
One of the three basic options associated with the Solids → MODFLOW command is the Boundary Matching
option. The goal of the boundary matching algorithm is to compute a set of elevation arrays that honor the
boundaries between the stratigraphic units as closely as possible.

Solids and Layer Ranges
Next a layer range must be assigned to each solid. The layer range represents the consecutive sequence of layer
numbers in the MODFLOW grid that are to coincide with the solid model. A sample set of layer range assignments
is shown in the figure below (a). The example in the figure below is a case where each solid is continuous through
the model domain and there are no pinchouts. Each of the solids is given a layer range defined by a beginning and
ending grid layer number. The resulting MODFLOW grid is shown in the figure below (b).

(a) A Set of Simple Solids with Grid Layer
Assignments (b) The MODFLOW Grid Resulting

From the Layer Assignments
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A more complex case with pinchouts is illustrated in the next figure (a). Solid A is given the layer range 1–4, and the
enclosed pinchout (solid B) is given the layer range 2–2. The set of grid layers within the defined range that are
actually overlapped by the model may change from location to location. The layer range represents the set of grid
layers potentially overlapped by the solid anywhere in the model domain. For example, on the left side of the
problem shown in the figure below (a), solid A covers grid layers 1, 2, 3 and 4. On the right side of the model, solid
A is associated with grid layers 1, 3 and 4 since the enclosed solid (solid B) is associated with layer 2. Likewise,
Solid C is associated with grid layers 5 and 6 on the left side of the model but only with layer 6 on the right side of
the model where solid D is associated with layer 5. The resulting MODFLOW grid is shown in the figure below (b).

(a) Grid Layer Assignments for a Set of Solids
with Pinchouts (b) The MODFLOW Grid
Resulting From the Layer Assignments

When assigning layer ranges to solids, care must be taken to define associations that are topologically sound. For
example, since solid B in the figure above (a) is enclosed by solid A, solid B could not be assigned a layer range that
is outside the layer range of solid A.
Layer ranges are assigned using the Solids Properties dialog.

Solids → MODFLOW Command
The final step is to select the Solids → MODFLOW command in the Solids menu. The layer elevations and material
properties for the 3D grid will then be automatically assigned from the solids as shown below.

Grid after using the Solids→MODFLOW
command

The following images represent cross-sections at selected locations of the grid shown above. Notice that the grid
elevations precisely match the stratigraphic boundaries defined by the solids while maintaining the continuous layers
required by MODFLOW.
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Sample cross-section

Sample cross-section

Smoothing Tolerance
When the Solids → MODFLOW command is executed with the Boundary Matching option, it is common to have
seams that occupy only a portion of a layer as shown in the above cross sections. The top and bottom elevations for
cells adjacent to these seams must be adjusted by GMS using a "smoothing" process to ensure that there are not
drastic cell size differences in the horizontal direction from one cell to the next. The smoothing is accomplished by
iteratively changing the elevation of selected cells until the cell elevations change less than the Smoothing Tolerance
specified in the Solids → MODFLOW Options dialog.

Minimum Thickness
This option enables users to avoid extremely thin layers at edges of pinchouts and represents the minimum thickness
of grid cells created from the solids. Solids with thickness less than this amount are ignored and the surrounding
material is used instead. This property is assigned in the solids Properties dialog. The figure below demonstrates the
application of this property.

Small minimum thickness

Larger minimum thickness
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Top Cell Bias
The top cell bias is the percentage of the thickness which is assigned to the top layer of the MODFLOW grid create
from the solids. The thickness of the top layer increases as the top cell bias increases. A large top cell bias can be
used to prevent top-layer cells from going dry. This property is assigned in the solids properties dialog.

Grid Overlay
The Grid Overlay option is one of the three basic options for the Solids → MODFLOW command. The Grid
Overlay option is similar to the Boundary Matching option. While the Boundary Matching option precisely matches
stratigraphic boundaries, it does have some drawbacks. It can result in very thin layers at certain locations in the grid
such as transition points at the boundary of a solid that pinches out to a sharp edge. In some cases, these thin layers
can cause stability problems with MODFLOW or with a subsequent transport analysis. For such cases, the Grid
Overlay method or the Grid Overlay with Keq method may provide superior results.
With the Grid Overlay option, no layer range assignments are necessary. Once the solids and grid are created, the
Solids → MODFLOW command can be immediately selected. For each vertical column of cells, GMS intersects a
vertical ray through the cell center and finds the highest and lowest intersection, i.e. the top and bottom of the entire
set of solids. These elevations become the top and and bottom elevation of the entire grid. The elevations of any
intermediate layer boundaries are then linearly interpolated between these two extremes. The material properties are
then assigned by computing the xyz coordinates of the center of each cell and determining which solid encloses the
cell center. The material properties from that solid are then assigned to the cell. The result is shown in the following
figure (compare this to the example shown in the Boundary Matching topic). Note that the boundaries of the solids
are not preserved as accurately as they are with the boundary matching algorithm. However, the cell sizes are much
more consistent and extremely thin cells are avoided.

http://www.xmswiki.com/xms/index.php?title=GMS:Solid_Module%23Solid_Properties
http://www.xmswiki.com/xms/index.php?title=GMS:Solids_to_MODFLOW_Command
http://www.xmswiki.com/xms/index.php?title=GMS:Boundary_Matching
http://www.xmswiki.com/xms/index.php?title=GMS:Grid_Overlay_with_Keq
http://www.xmswiki.com/xms/index.php?title=GMS:Boundary_Matching
http://www.xmswiki.com/xms/index.php?title=File%3AOverlaygrid.gif
http://www.xmswiki.com/xms/index.php?title=File%3AOverlayxsect2.gif


Solids to MODFLOW Command 89

Minimum Thickness
In some cases, the set of solids used with the Grid Overlay method may have thin sections where the vertical
thickness of the entire set of solids becomes extremely small. In such cases, the resulting grid cells become very thin
as they are "squeezed" in this thin region. The cell thickness in these regions can be controlled using the Minimum
Thickness value in the Solids Attributes dialog. When each vertical column of cells is processed, the height of the
cells in the column is compared to the minimum thickness. If the cell height is less than the minimum, one or more
cells at the bottom of the grid are inactivated until the minimum thickness is satisfied.

Grid Overlay with Keq
The Grid Overlay option is one of the three basic options for the Solids → MODFLOW command. This option is
very similar to the Grid Overlay option. One of the problems with the Grid Overlay option is that if there is a
relatively thin layer in the solids and the layer does not happen to encompass any cell centers or it encompasses few
cell centers, the layer will be under-represented in the MODFLOW grid. This becomes particularly important if the
layer is meant to represent a low permeability layer. For such cases, the Grid Overlay with Keq option may give
superior results. The Grid Overlay with Keq method is identical to the Grid Overlay method in terms of how the
elevations of the grid cells are defined. The two methods differ in how the material properties are assigned. Rather
than simply assigning materials based on which solid encompasses the cell centers, the Keq method attempts to
compute a custom Kh and Kv value for each cell. When assigning the material properties to a cell, GMS computes the
length of each solid in the cell (from a vertical line at the cell center that intersects the solids) and computes an
equivalent Kh, Kv, and storage coefficient for the cell that takes each of the solids in the cell into account. Thus, the
effect of a thin seam in a cell would be included in the Kh and Kv values for the cell.
The equivalent Kh is computed as follows:

where Khi is the Kh of a solid and Mi is the length of the same solid intersected at the cell center.
The equivalent Kv is computed as follows:

where Kvi is the Kv of a solid and Mi is the length of the same solid intersected at the cell center.
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A horizontal cross-section through a sample grid defined via the Grid Overlay with Keq method is shown below. The
colors represent the resulting Kh values. Note how the K values transition at the boundaries of the solids.

Parameter Estimation
Caution should be taken when using the Grid Overlay with Keq method when performing automated parameter
estimation. The "key value" approach to defining parameter zones for PEST requires that the values assigned to the
zones be unique within each zone. With the Boundary Matching and Grid Overlay methods, the key values could be
assigned to the solids and the values would be properly inherited by the grid cells. With the Grid Overlay with Keq
method, the parameter values are "blurred" at the edges of the solids and the key values assigned by the user to the
solids would be lost.

Solid Commands
When the Solids module is active, the Solids menu become available. The Solids menu has one submenu; the
Advanced submenu. Below is a list of commands in the Solids menu:
•• Cube...

Creates a new 3D cube object.
•• Sphere...

Creates a new 3D sphere object.
•• Cylinder...

Creates a new 3D cylinder object.
•• Prism...

Creates a new 3D prism object.
•• Group Faces

Adds selected solid faces to a new group. Thereafter selecting any face in the group will select all faces
in the group. Useful for assigning properties to solid faces for ADH.

•• Ungroup Faces

Eliminates the selected face group so that faces in the group can be selected individually.
• Solids → MODFLOW...

Opens the Solids → MODFLOW dialog allowing the user to map solids to MODFLOW layer elevations.
• Solids → HUF...

Opens the Solids → HUF dialog allowing the user to map solids to MODFLOW HUF units.
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Advanced> submenu

• Solids → Layered Mesh...

Using a 2D mesh for to project from, builds a 3D mesh matching mesh elements to the solid geometry.
•• Set Operations...

Deprecated. Union, difference, and intersection operations on solids.

Related Topics
•• Boreholes
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5.4. 2D Mesh Module

2D Mesh Module

The 2D Mesh module is used to construct two-dimensional finite element meshes. Numerous tools are provided for
automated mesh generation and mesh editing. 2D meshes are used for SEEP2D modeling and to aid in the
construction of 3D meshes. The figures below show an example of a SEEP2D model and a 3D mesh created using
the 2D Mesh Module.

3D Mesh Created by Extruding a 2D Mesh Sample SEEP2D Problem
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Creating a 2D Mesh

2D Meshes can be created 3 different ways in GMS: using an automatic meshing technique, manually entering the
node locations and triangulating, or converting a different GMS data type to a 2D Mesh.

Using an Automatic Meshing Technique
Map → 2D Mesh is the preferred method for mesh generation in GMS.

Manually Creating a 2D Mesh
In order to create a 2D Mesh in GMS you must have a set of 2D Mesh nodes. Elements can be created by using one
of the Create Element tools in the 2D Mesh Tool Palette and then selecting the mesh nodes to create elements. A 2D
Mesh can also be created by triangulating the nodes. The triangulation algorithm assumes that each of the vertices
being triangulated is unique in the xy plane, i.e., no two points have the same xy location. Duplicate points can be
removed by selecting Find Duplicates command from the Mesh menu. The user is prompted to input a tolerance to
be used when checking for duplicate nodes. Two nodes are considered to be duplicates if the XY distance between
them is less than or equal to the specified tolerance. The user can also specify whether the duplicate nodes are to be
deleted or simply displayed in red.
A 2D Mesh can be created manually from the following steps:
1. Select the Create Nodes tool from the 2D Mesh Tool Palette.
2.2. Create the Nodes by clicking inside the Graphics Window at the xy coordinates where you want the vertex

located. (To change the node location see Editing 2D Meshes)
3. Select the Create Linear Triangle Element tool from the 2D Mesh Tool Palette.
4. Select the Triangulate command from the Mesh menu.

Creating a 2D Mesh from GMS Data
TINs, 2D grids, 2D scatter points, and 3D meshes can all be converted to a 2D Mesh. This is accomplished by using
the following commands:
• TIN → 2D Mesh
• 2D Grid → 2D Mesh
• 2D Scatter Points → 2D Mesh Nodes
• 3D Mesh → 2D Mesh

After using the Scatter Points → Mesh Nodes command you must triangulate the nodes to create the 2D Mesh.
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Editing 2D Meshes

Editing Nodes

Insert Node
New nodes in a 2D mesh are created by selecting the Create Nodes tool from the 2D Mesh Tool Palette and clicking
where the new node is to be located. The default parameters governing the creation of new nodes can be specified
using the 2D Mesh Settings command in the Mesh menu. This brings up the Node Options dialog.

Delete Node
A set of selected nodes can be deleted by hitting the Delete key or selecting the Delete command from the Edit
menu. If the deleted node is connected to one or more elements, the action taken when the node is deleted depends
on the status of the options in the 2D Mesh Settings dialog.
If the Retriangulate voids when deleting option is turned on, the void created when a node and the elements
surrounding the node are deleted is re-triangulated or filled in with triangles. This feature makes it possible to
selectively "unrefine" a region of the mesh or reduce the density of the nodes in a region of the mesh without having
to completely recreate all of the elements in the region.
If the Retriangulate voids when deleting item in the Node Options dialog is not set, the selected node and the
elements surrounding the node are simply deleted and the resulting void is not filled in with triangles.
If the Confirm Deletions option in the Edit menu is active, GMS will prompt the user to confirm each deletion. This
feature is helpful in preventing accidental deletions. The Confirm Deletions item is toggled by selecting it from the
menu.

Move Node
The coordinates of a 2D Mesh node can be edited by selecting the mesh node and entering the new coordinates in the
edit boxes in the Edit Window. It is also possible to drag an existing node to a new location by clicking on the node
and moving the mouse with the button held down until the node is in the desired position.
If the Snap to Grid option in the Drawing Grid Options dialog is set, the node will move in increments
corresponding to the drawing grid. If the node being dragged is connected to one or more elements, GMS will not
allow the node to be dragged to a position where one of the surrounding elements would become ill-formed.
Since it is possible to accidentally drag points, nodes can be "locked" to prevent them from being dragged by
selecting the Lock All Nodes item from the Mesh menu. The nodes can be unlocked by unselecting Lock All Nodes
from the Mesh menu.
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Editing Elements

Convert Between Linear and Quadratic
Linear elements (three node triangles and four node quadrilaterals) can be converted to quadratic elements (six node
triangles and eight node quadrilaterals) and vice versa by selecting the Convert Elements item from the Mesh menu.
If there are both linear and quadratic elements in the mesh (as may be the case with a disjoint mesh), the user is
prompted to specify the type of conversion desired, linear to quadratic or quadratic to linear.

Merging Triangles
The triangulate operation creates a mesh composed entirely of triangles. In some cases it is desirable to have the
mesh composed primarily of quadrilateral elements. Quadrilateral elements result in a more concise mesh which
leads to faster solutions, and quadrilateral elements are often more stable numerically. To address this need, two
options are provided for converting triangular elements to quadrilateral elements: The Merge Triangles command,
the Merge/Split Tool.

The Merge Triangles Command

The Merge Triangles command in the Modify Mesh menu can be used to automatically merge pairs of adjacent
triangular elements into quadrilateral elements. Upon selecting the Merge Triangles command, the user is prompted
to input a minimum interior angle. This angle should be between 0o and 90o. If no elements are selected, all of the
triangular elements in the mesh are then processed. If some elements have been selected, only the selected elements
are processed. The conversion process works as follows:
1.1. The set of elements to be processed is traversed one element at a time. Each triangular element that is found is

compared with each of its three adjacent elements. If the adjacent element is a triangle, the trapezoid formed by
the triangle and the adjacent triangle is checked.

2.2. Each of the four interior angles of the trapezoid is computed and compared to a minimum interior angle. If all of
the angles are greater than the user-specified minimum interior angle, then the two triangles are merged into a
single quadrilateral element.

This process is repeated for all of the elements. The merging scheme will not always result in a mesh composed
entirely of quadrilateral elements. Some triangular elements are often necessary in highly irregular meshes to provide
transitions from one region to the next.

The Merge/Split Tool

The other option for merging triangles involves the use of the Merge/Split tool in the 2D Mesh Tool Palette. This
tool can be used to manually merge triangles one pair at a time rather than using the automatic scheme described
above.
The manual method is also useful to edit or override the results of the automatic merging scheme in selected areas.
The Merge/Split tool can also be used to undo a merge. A quadrilateral element can be split into two triangles by
clicking anywhere in the interior of the element. This tool is useful if a pair of triangles is inadvertently merged.

Splitting Quadrilaterals
Occasionally it is necessary to split quadrilateral elements into triangular elements. For example, in order for new
nodes to be automatically inserted into a mesh, the elements in the region where the node is inserted must be
triangular. Also, in order to process a breakline, the elements in the region of the breakline must be triangular. In
such situations, it may be necessary to split a group of quadrilateral elements into triangular elements. Two options
are provided for splitting quadrilateral elements:
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• The Split Quads Command – The Split Quads command in the Mesh menu can be used to split a group of
quadrilateral elements into triangular elements. If no elements are selected, all of the quadrilateral elements in the
mesh are split. If some elements have been selected, only the selected quadrilateral elements are split.

• The Merge/Split Tool – The other option for splitting quadrilateral elements involves the use of the Merge/Split
tool in the 2D Mesh Tool Palette. If the Merge/Split tool is selected, clicking anywhere in the interior of a
quadrilateral element with the mouse cursor will cause the element to be split into two triangles. The shortest
diagonal through the quadrilateral is chosen as the common edge of the two new triangular elements.

Refining Elements
In some cases, a mesh does not have enough elements in a particular region of the mesh to ensure stability. Rather
than inserting supplemental nodes and re-creating the mesh, it is possible to refine a selected region of the mesh
using the Refine Elements command in the Mesh menu. This increases the mesh density of a selected area of the
mesh. If no elements are selected, the entire mesh is refined. The elevations of the new nodes are interpolated from
the existing nodes.

Change Element Materials
Elements can have a material ID associated to it. The Materials command in the Edit menu brings up the Material
Editor dialog. The material ID associated with the element can be changed using the Properties command in the Edit
menu. (See Materials)

Boundary Triangles
The perimeter of the TIN resulting from the triangulation process corresponds to or approximates the convex hull of
the TIN vertices. This may result in some long thin triangles or "slivers" on the perimeter of the triangulated region.
There are several ways to deal with the long thin triangles. Thin triangles can be selected and deleted using the
normal selection procedures. There is also an option for selecting thin triangles when the Select Triangles tool is
selected. If the Control key is held down, it is possible to drag a line with the mouse. All triangles intersecting the
line are selected. Long thin triangles on the perimeter of the TIN can also be selected by selecting the Select
Boundary Triangles command from the TINs menu. The Select Boundary Triangles command checks triangles on
the outer boundary first. If the length ratio of the triangle is less than the critical length ratio, the triangle is selected
and the triangles adjacent to the triangle are then checked. The process continues inward until none of the adjacent
triangles violate the minimum length ratio. The critical length ratio for selecting thin triangles can be set by selecting
the TINs | TIN Settings menu command. The length ratio is defined as the longest side of the triangle divided by the
sum of the two shorter sides.

Breaklines (a) Triangulated Mesh and Breakline.
(b) Triangulated Mesh After the Breakline has

been Processed.

Breaklines

A breakline is a feature line or polyline representing a ridge or some
other feature that the user wishes to preserve in a mesh made up of
triangular elements. In other words, a breakline is a series of edges to
which the triangles should conform to, i.e., not intersect.
Breaklines can be processed using the Add Breaklines command from
the Mesh menu. Before selecting the command, one or more sequences
of nodes defining the breakline(s) should be selected using the Select
Node Strings tool in the 2D Mesh Tool Palette.

http://www.xmswiki.com/xms/index.php?title=GMS:2D_Mesh_Tool_Palette
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As each breakline is processed, the triangles intersected by the breakline are modified by adding new nodes at
necessary locations to ensure that the edges of the triangles will conform to the breakline. The elevations of the new
nodes are based on a linear interpolation of the breakline segments. The locations of the new nodes are determined in
such a way that the Delauney criterion is satisfied.

2D Mesh Settings

The Preference dialog showing the 2D Mesh tab

New nodes in a 2D mesh are created
by selecting the Create Nodes tool
from the 2D Mesh Tool Palette and
clicking where the new node is to be
located. The default parameters
governing the creation of new nodes
can be specified using the 2DMesh
Settings command in the Mesh menu.
This brings up the 2D Mesh tab of the
Preferences dialog. The options in the
dialog are as follows:

Default Z

If the check box entitled Interpolate for
default z on interior is selected when a
new node is inserted in the interior of
the mesh, the element enclosing the

node is linearly interpolated to get the Z value. If the node is on the exterior of the mesh, the default z value is used.
If the toggle is not selected, the default Z is used everywhere.
The options in the center of the dialog are used to specify whether to use a default Z value for all new nodes or to
have GMS prompt the user for the Z value every time a new node is created.

Insert Nodes into Triangulated Mesh
If the check box entitled Insert nodes into triangulated mesh is selected, any new node that lies in a region of the
mesh consisting of triangular elements will automatically be incorporated into the mesh. New nodes will not be
automatically incorporated into quadrilateral meshes.

Check for Coincident Nodes
If the check box entitled Check for coincident nodes is selected, any new node created using the Create Nodes tool
will be checked to see if it lies on top of an existing node.

http://www.xmswiki.com/xms/index.php?title=GMS:Triangulation
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2D Mesh Display Options 98

2D Mesh Display Options

The properties of all 2D mesh data that GMS displays on the screen can be controlled through the 2D Mesh tab of the
Display Options dialog. This dialog is opened by right-clicking on the  2D Mesh Data entry in the Project
Explorer and selecting the Display Options command. It can also be accessed from the from the Display menu or
the  Display Options macro. The following table describes the display options available for the 2D Mesh module.

Display
Option

Description

Nodes The Nodes item is used to display mesh nodes. A small circle is drawn at each node.

Element
edges

The Elements item is used to display the edges of elements. The elements can be drawn using either the default color for elements
or using the color of the material associated with each element.

The color of the element edges can be adjusted according to the following options:

1. Auto – draws the material color if faces are not displayed. Uses black or white if the faces are displayed.
2. Specified – used the color specified next to the cell edges
3. Material – displays the material color of the cell

Element faces This option fills the elements with the material color.

Texture map
image

The Texture Map Image Item is used to "drape" an image over the surface of the 2D Mesh.

Mesh
boundary

The Mesh boundary item is used to display a solid line around the perimeter of the mesh. Displaying the boundary is useful when
contours are being displayed with the element edges turned off.

Node
numbers

The Node Numbers item is used to display the ID associated with each node next to the node.

Element
numbers

The Element numbers item is used to display the ID associated with each element at the centroid of the element.

Thin elements If the Thin elements item is set, triangular elements with small aspect ratios are highlighted. The minimum aspect ratio can be set
using the Aspect Ratio command in the Modify Mesh menu.

Scalar values The Scalar Values item is used to display the scalar values of the active dataset for each node next to the node.

Contours Most of the objects supported by GMS can be contoured by turning on the Contour Options in the Display Options dialog. When an
object is contoured, the values associated with the active dataset for the object are used to generate the contours.

http://www.xmswiki.com/xms/index.php?title=GMS:2D_Mesh_Module
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The Display Options dialog showing the 2D Mesh tab.

http://www.xmswiki.com/xms/index.php?title=File%3ADisplay2Dmesh.jpg


2D Mesh Tool Palette 100

2D Mesh Tool Palette

The following tools are contained in the dynamic portion of the Tool Palette when the 2D Mesh Module is active.
Only one tool is active at any given time. The action that takes place when the user clicks in the Graphics Window
depends on the current tool. The following table describes the tools in the 2D Mesh tool palette.

Tool Tool Name Description

Select Nodes The Select Nodes tool is used to select a set of nodes for some subsequent operation such as deletion. The coordinates of
a selected node can be edited by dragging the node while this tool is active. The coordinates of selected nodes can also
be edited using the Edit Window. A node can also be selected by using the Find Node command in the Mesh menu. The
user is prompted for a node ID and the node is selected. Any previously selected nodes are unselected.

Select Elements The Select Elements tool is used to select a set of elements for operations such as deletion or assigning a material type.
An element can also be selected by using the Find Element command in the Mesh menu. The user is prompted for an
element ID and the element is selected. Any previously selected elements are unselected.

Select Node
Strings

The Select Node Strings tool is used to select one or more strings of nodes. Node strings are used for operations such as
adding breaklines to the mesh.

The procedure for selecting node strings is somewhat different than the normal selection procedure. Strings are selected
as follows:

•• Click on the starting node for the string. The node selected will be highlighted in red.

•• Click on any subsequent nodes you would like to add to the string (nodes do not have to be adjacent). The selected
nodes are now connected by a solid red line.

To remove the last node from a string, press the Backspace key. To abort entering a node string, press the ESC key. To
end a node string, press Return or double-click on the last node in the string. Another node string can then be selected.

Create Nodes The Create Nodes tool is used to manually add nodes to a mesh. When this tool is selected, clicking on a point within
the Graphics Window will place a node at that point. What happens to the node after it is added (whether and how it is
triangulated into the mesh) depends on the settings in the Node Options dialog in the Modify Mesh menu.

Create Linear
Triangle Element

Four types of elements are supported by the 2D Mesh module:

1.  Three node triangles (linear triangles).
2.  Six node triangles (quadratic triangles).
3.  Four node quadrilaterals (linear quadrilaterals).
4.  Eight node quadrilaterals (quadratic quadrilaterals).
Elements can be created using automatic meshing techniques such as triangulation. However, it is often necessary to
edit a mesh by creating elements one at a time using the four Create Element tools.

See the Creating an Element section below.

Create Quadratic
Triangle Element

Create Linear
Quadrilateral
Element

Create Quadratic
Quadrilateral
Element

Merge/Split If the Merge/Split tool is selected, clicking on a triangle edge with the mouse cursor will cause the two triangular
elements adjacent to the edge to be merged into a quadrilateral element provided that the quadrilateral shape formed by
the two triangles is not concave.

The Merge/Split tool can also be used to undo a merge or to "unmerge" a quadrilateral element. A quadrilateral element
can be split into two triangles by clicking anywhere in the interior of the element. This tool is useful if a pair of triangles
are inadvertently merged.

Swap Edges If the Swap Edges tool is selected, clicking on the common edge of two adjacent triangles will cause the edge to be
swapped as long as the quadrilateral shape formed by the two triangles is not concave.

Occasionally, it is useful to interactively or manually swap the edges of two adjacent triangles. This can be thought of as
a quick and simple alternative to adding breaklines to ensure that the edges of the triangular elements honor a
geometrical feature that needs to be preserved in the mesh.
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Contour Labels The Contour Label tool is used to manually place numerical contour elevation labels at points clicked on with the
mouse. These labels remain on the screen until the contour options are changed, until they are deleted using the Contour
Labels dialog, or until the mesh is edited in any way. Contour labels can be deleted with this tool by holding down the
Shift key while clicking on the labels. This tool may only be used when the 2D mesh is in plan view.

Creating an Element
A single element can be constructed from a set of existing nodes using the following steps:
1.1. Select the tool corresponding to the type of element to be created.
2.2. Select the nodes corresponding to the corner nodes of the element in consecutive order around the perimeter of

the element. The nodes can be selected in either clockwise or counter-clockwise order. It is also possible to build
an element by dragging a rectangle to enclose the nodes making up the new element rather than selecting each
node one by one. A beep will sound if the wrong number of nodes for the current element type are selected.

If the current element type is a quadratic element (six or eight node element), the midside nodes of the element are
created automatically. If the new element is adjacent to an existing element, the midside node of the existing element
is used for the new element and a new midside node is not created, i.e. midside nodes are not duplicated.The
coordinates of midside nodes cannot be edited. Midside nodes are always assumed to be located at the midpoint of
the two adjacent corner nodes. When a corner node is edited, the coordinates of the adjacent midside nodes are
updated accordingly.

GMS performs several checks when a new element is constructed. The new element is checked to see whether or not
it is ill-formed (the element has a twist in it or is self intersecting). The element is also checked to see if it overlaps
any of the elements adjacent to the nodes comprising the new element. In addition, the elements adjacent to a new
element are checked to ensure that the elements are conforming, i.e. linear elements (three and four node elements)
are not allowed to be placed adjacent to quadratic elements (six and eight node elements). If any of the above checks
fail, the construction of the new element is aborted

http://www.xmswiki.com/xms/index.php?title=File:Tool_ContourLabels.GIF
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Converting a 2D Mesh to other types of Data

2D Meshes may be converted to other types of data used in GMS, such as a TIN or 2D scatter points. 2D Meshes are
converted by using the following commands in the Grid menu:

Mesh → 2D Scatter Points
The Mesh → 2D Scatter Points command in the Mesh menu is used to create a new scatter point set using the nodes
in a mesh. A copy is made of each of the datasets associated with the mesh and the datasets are associated with the
new scatter point set.

Mesh → TIN
A new TIN can be created from a 2D finite element mesh by selecting the Mesh → TIN command from the Build
Mesh menu. A triangle is created from each triangular element in the mesh and two triangles are created from each
quadrilateral element in the mesh by splitting the quadrilateral element along the shortest diagonal.

Mesh → 3D Tets
The Mesh→3D Tets command in the Mesh menu is used to convert a 2D mesh to a 3D mesh of tetrahedron.
This command brings up the Mesh→3D Tets dialog. At the top of the dialog the user selects two data sets that will
represent the Top elevation and the Bottom elevation of the 3D mesh. In general the top elevation dataset should be
completely above the bottom elevation dataset. The user also selects how the 3D mesh will be extruded. There are
two options: Constant number of layers and Layers distributed by depth. When using Constant number of layers,
the user simply enters the number of layers in the edit field. When using the Layers distributed by depth, the user
enters a maximum layer thickness for each material present in the 2D mesh in the spread sheet.

How it works

The user specifies a top and bottom elevation dataset and the 3D mesh is extruded between the two datasets. This
process is illustrated in the figures below.

Two surfaces defining the top and bottom of the
3D mesh

Two methods are available for determining the number of 3D mesh
nodes to place between the two surfaces: Constant number of layers
and Layers distributed by depth.
•• The first option is a constant number of layers. The figure above

was created by specifying 4 layers between the top and bottom
surface. In this case five 3D mesh nodes are created between the top
and bottom elevation datasets creating 4 layers.

•• The second option uses the materials assigned to the 2D mesh. The
user then specifies a maximum layer thickness for each of the

materials. Then as the 3D mesh is extruded the number of nodes will vary depending on the material and the
distance between the top and bottom elevation. This is illustrated in the figures below. The first figure show a 2D
mesh with 3 materials assigned to it.

http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
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Tet mesh extruded between the top and bottom
datasets

2D mesh with 3 materials

3D tet mesh created with materials and max layer
thickness

A maximum layer thickness was assigned to each of the materials: red-
14.0 ft., blue- 10.0 ft., and green- 6.0 ft. The resulting 3D mesh is
shown below.

http://www.xmswiki.com/xms/index.php?title=File%3ATet_mesh.gif
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Element types
Element types used in XMS software. See also XMDF elements [1].

Element Type Image Faces

1D linear element with 2 nodes

1D linear element with 3 nodes

transition element

2D linear triangle

2D quadratic triangle

2D linear quadrilateral

2D quadratic quadrilateral

2D quadratic quadrilateral with center node

3D linear tetrahedron
FaceID Node Indices

1 2,3,4

2 1,4,3

3 1,2,4

4 1,3,2

http://www.aquaveo.com/xmdf/doc1.6/group__d4d8d2d.html
http://www.xmswiki.com/xms/index.php?title=File:Elem_1d_linear.png
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http://www.xmswiki.com/xms/index.php?title=File:Elem_2d_linear_quad.png
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3D linear prism
FaceID Node Indices

1 1,3,2

2 4,5,6

3 1,2,5,4

4 2,3,6,5

5 3,1,4,6

3D linear hexahedron
FaceID Node Indices

1 1,4,3,1

2 5,6,7,8

3 1,2,6,5

4 2,3,7,6

5 3,4,8,7

6 4,1,5,8

3D linear pyramid
FaceID Node Indices

1 1,4,3,2

2 1,2,5

3 2,3,5

4 3,4,5

5 4,1,5

Back to XMS
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2D Mesh Polygon Attributes

This dialog is used to set the attributes for feature polygons with a SEEP2D or FEMWATER coverage. Attributes
that can be specified for each polygon include:

Mesh Type
Set the meshing type to be used to fill the interior of the polygon. The options include (different options are given
according the coverage type):

None
This results in a hole in the finite element network (no elements are created inside the polygon).

Adaptive Tessellation
Adaptive tessellation is a mesh generation technique used to fill the interior of a polygon. A polygon is
assigned to be adaptive tessellation in the Polygon Attributes dialog and is filled with the Map → 2D Mesh
command.

Example mesh created using adaptive tessellation

Adaptive tessellation uses the existing spacing on the polygons
to determine the element sizes on the interior. Any interior arcs
and refine points are forced into the new mesh. If the input
polygon has varying node densities along its perimeter, GMS
attempts to create a smooth element size transition between these
areas of differing densities. By altering the size bias, the user can
indicate whether GMS should favor the creation of large or small
elements. Decreasing the bias will result in smaller elements;
increasing the bias will result in larger elements. In either case,
the elements in the interior of the mesh will honor the arc edges

and the element sizes specified at nodes. The bias simply controls the element sizes in the transition region.

Patch
Map Patches

Patching is a mesh generation technique used to fill the interior of a polygon. A polygon is assigned to
be a patch in the polygon attributes dialog and is filled with the Feature Objects | Map → 2D Mesh
command.
The coordinates of the new nodes on the interior of the patch are computed by constructing a partial
bicubic Coons patch using the polygon as patch edges. This ensures that interior nodes are smoothly
interpolated from the nodes making up the perimeter of the patch. Patches are applicable when the data
points are gathered along parallel lines, such as cross sections in a river.

Rectangular Patches

The following are some hints when using rectangular patches:
The curvature of the patch can change somewhat, but it should not switch directions. If it does, then the
patch should be split at the inflection point of the curve.

http://www.xmswiki.com/xms/index.php?title=GMS:SEEP2D
http://www.xmswiki.com/xms/index.php?title=GMS:FEMWATER
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Although opposite sides in the rectangular patch are not required to have the same number of nodes, the
best patches occur when this is close. In the example shown above, the two ends have the same number
of nodes and the two sides only differ by three nodes.

Triangular Patches

All three sides of a triangular patch must have the same number of nodes.
Errors

When the patch is previewed in the polygon attributes dialog, the elements in a new patch are checked to
make sure they do not overlap each other. If any problems are detected, an error message is given and
the patch is not created. Errors may occur especially when the region is highly irregular in shape. In
such cases, the region can either be divided into smaller patches, or it can be filled using a different
mesh generation technique.
If a polygon cannot be patched, a help string under the preview window in the polygon attributes dialog
explains what needs to be changed.

Paving
With paving the polygon boundary is "paved" inward until the interior is filled. The mesh triangles created
from this method are aligned to the boundary.

Example of a mesh created using paving

Polygon Type/Material
Polygons can be assigned a Material type.

Graphical Tools
The Polygon Attributes dialog includes a preview window on the left side. This window shows the arcs and nodes of
the selected polygon and allows the user to interact with that definition. The Preview button generates the elements
that will be created for the polygon. It is recommended that the preview is used with the patch and adaptive
tessellation options only due to the time required performing density meshing. There are several tools for modifying
the existing polygon. Zooming, panning and framing work in the preview window just as they normally would in the
graphics window of GMS. They are used to facilitate the selection tools.
All entities are selected by clicking on the entity or by dragging a box to select several entities after selecting the
tool. The graphical tools are described in the following table.

http://www.xmswiki.com/xms/index.php?title=File%3APaving.gif
http://www.xmswiki.com/xms/index.php?title=GMS:Materials
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Tool Tool Name Description

Select Vertex Select a vertex in the window (red point on arc). Drag the vertex to move it.

Create Vertex Create a vertex by clicking on a red arc.

Select Point/Node Select a large blue or red node in the window.

Select Arc Selects arcs in the preview window.

Arc Options
The options dealing with selected arc(s).
• Use original n nodes. Use the original vertices on the arc (before entering the dialog). If a vertex is moved,

deleted, or created using the above tools, clicking this option will not undo the vertex.
• Distribute n nodes. Specify the number of nodes and vertices to put on the arc (minimum of 2). The nodes are

evenly spaced if the Bias is 1.0. A Bias of 2.0 will space the nodes more densely to one side; the last space will be
twice as big as the first space. A Bias of 0.5 swaps this; the first space is twice as big as the last.

Node Options

Example of the node options

The options dealing with selected node(s). These options are used for
patches. Patches require 3 or 4 edges. An edge is an arc segment from one
blue point to another blue point.
• Split. Split two merged arcs. This turns the node blue.
• Merge. Merge two arcs. This turns the node red.
• Degenerate Edge. This works with 4-sided patches. The degenerate

node is treated as an edge, as shown in the figure below.

http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectVertex.gif
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2D Mesh Commands
When the 2D Mesh module is active, the Mesh menu becomes available. The Mesh menu has two submenus:
Convert To and Advanced. Below is a list of all commands in the Mesh menu:
•• New 2D Mesh

Creates a new, empty 2D mesh.
•• 2D Mesh Settings...

Opens the 2D mesh settings which include: default z values for new nodes, options for deleting triangles
etc.

•• Lock All Nodes

Since it is possible to accidentally drag points, nodes can be "locked" to prevent them from being
dragged or edited by toggling on this command.

•• Find Element...

Selects an element given the element ID.
•• Find Node...

Selects a node given the node ID.
•• Triangulate

Creates triangular elements from all or selected nodes using the Delauney criteria. If triangles already
exist, they will be deleted.

•• Renumber

Renumbers mesh nodes eliminating gaps in numbering. Optionally a node string can be created and used
to guide the renumbering.

Convert To> submenu

• Mesh → 2D Scatter Points

A new 2D scatter point set is created from the 2D mesh nodes.
• Mesh → TIN

A new TIN is created from the 2D mesh.
• Contours → Arcs

Creates a new coverage containing feature arcs derived from the linear contours displayed on the 2D
mesh.

Advanced> submenu

•• Select Thin Triangles

Selects triangles which meet the "thin triangle aspect ratio" specified in the 2D mesh settings.
•• Find Duplicate Nodes...

Selects nodes that are close to each other within a user specified tolerance.
•• Merge Triangles

Used to convert triangular elements into quadratic elements.
•• Split Quadrilaterals

Used to convert quadrilateral elements into triangular elements.
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•• Add Breaklines

Inserts the node strings into the mesh as a new edge, creating new elements and nodes.
•• Convert Elements

Converts linear elements to quadratic and quadratic elements to linear.
•• Refine Elements

Subdivides elements into smaller elements.
•• Relax Elements...

Moves mesh nodes in order to improve the quality (element shape and size) of the mesh.
• Mesh → 3D Tets

Creates a 3D mesh consisting of tetrahedron from the 2D mesh.
•• Export

Exports a 2D mesh to a file (*.2dm, *.fem etc).

Related Topics
•• 2D Mesh Module
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5.5. 2D Grid Module

2D Grid Module

The 2D Grid module is used for creating and editing two-dimensional Cartesian grids. 2D grids are primarily used
for surface visualization and contouring. This is accomplished by interpolating to the grid. The figure below is an
example of interpolating contaminant concentration data to a 2D grid.

Concentration Data Interpolated to a 2D Grid Watertable Elevations From a MODFLOW Simulation
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http://www.xmswiki.com/xms/index.php?title=GMS:Interpolation
http://www.xmswiki.com/xms/index.php?title=File%3AGrid_interp.gif
http://www.xmswiki.com/xms/index.php?title=File%3ASample_water_table.GIF


2D Grid Types 112

2D Grid Types

Two types of grids are supported in the 2D Grid module: mesh-centered grids and cell-centered grids. With a
mesh-centered grid, the data values are stored at the corners of the grid cells. With a cell-centered grid, data values
are stored at the cell centers.
When a dataset is imported to a cell-centered grid, there is one value in the dataset for each cell. The contouring and
fringing functions use scalar values at the cell corners. Therefore, whenever contouring or fringing is performed, the
values at the cell centers are interpolated to the cell corners. Interpolation to cell corners is only done for
visualization purposes. All computations performed using the data calculator are performed on the original values at
the cell centers. With mesh-centered grids, all visualization and computations are performed at the cell corners and
no interpolation is necessary.
Grids in GMS are Cartesian grids. That is, the row and column spacing in the grid can vary, but the row and column
boundaries are straight. Each cell center or grid node can have a unique elevation. The grid can also be rotated about
the Z axis if desired.

Types of 2D Grids Supported in GMS. (a)
Mesh-Centered Grid (b) Cell-Centered Grid.

http://www.xmswiki.com/xms/index.php?title=GMS:Datasets
http://www.xmswiki.com/xms/index.php?title=GMS:Contour_Options
http://www.xmswiki.com/xms/index.php?title=File%3AGridType1.gif


Creating and Editing 2D Grids 113

Creating and Editing 2D Grids

Creating 2D Grids
Two types of 2D grids are supported by GMS, mesh centered and cell centered. The two main techniques used to
create 2D grids are: the Create Grid command and the Map → 2D Grid command. A 2D grid can also be created
from an existing 3D grid using the Grid → 2D Grid command in the Grid menu of the 3D Grid Module. A GIS grid
may also be imported.

Create Grid
A new grid can be created by selecting the Create Grid command from the Grid menu. This command brings up the
Create Grid dialog. The options in the dialog are as follows:
Origin, Length, Rotation – By default, the rows and columns of 2D grids are aligned with the x and y axes.
However, grids can be rotated about the z-axis, if desired. Thus, the information needed to determine the overall size
and location of the grid is the xy coordinates of the lower left corner of the grid (the lower left corner prior to
rotation), the length of the grid in the x and y directions, and the rotation angle. The xy coordinates of the origin are
entered in the Origin edit fields, the dimensions are entered in the Length fields, and the angle of rotation is entered
in the field entitled Rotation about Z-axis.
Bias – Several options are available for defining the number and locations of the cell boundaries. A bias can be
defined which controls how the cell size varies from one cell to the next. For example, an X bias of 1.5 causes each
cell to be 50% larger than the previous cell when moving in the positive x direction.
Number of Cells – The total number of cells in each direction (number of rows or columns) can be defined by
explicitly entering a number or by entering a base cell size and a limit cell size. The base and limit cell size options
are used when a bias other than 1.0 is specified. The base cell size is the size of the first cell in the sequence. The
cells are then generated by altering the cell size according to the bias until the limit cell size is reached. The
remainder of the cells are constructed using the limit cell size.
Type and Orientation – The controls at the bottom of the Create Grid dialog are used to define the type and
orientation of the grid. The user can specify whether the grid should be a mesh-centered grid or a cell-centered grid.
The orientation of the ij axes with respect to the XY axes can also be specified.

Map → 2D Grid
The Map → 2D Grid command is used to construct a 2D grid using the feature objects in a 2D Grid Coverage. When
the Map → 2D Grid command is selected, the Create Grid dialog appears. If a grid frame has been defined, the size
and location of the grid frame are used to initialize the fields in the Create Grid dialog. In most cases, these values
will not need to be changed and the user can simply select the OK button to create the grid. If a grid frame has not
been defined, the size and location of the grid are initialized so that the grid just surrounds the currently defined
feature objects. If desired, the grid dimensions can be edited prior to selecting the OK button to create the grid.
If one or more refine points are defined in the conceptual model, the number of rows and columns in the grid will be
automatically determined when the grid is created. Thus, these fields cannot be edited by the user and will be
dimmed. If refine points are not defined, the user must enter the number of rows and columns.
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Editing 2D Grids
Each of the cells in a 2D grid can be active or inactive. An inactive cell is ignored when contours, fringes, or vectors
are displayed on the mesh.
Each cell in the grid has an associated material type. When a new grid is created, the material type for each cell
corresponds to the default material type. The default material type can be set using the Materials Editor command in
the Edit menu. A new material can be assigned to a cell or a set of cells by selecting the cell(s) and then selecting the
Properties command from the Edit menu.

Inserting Rows and Columns
Rows and columns can be added to an existing 2D grid by using the Add i Boundary tool and the Add j Boundary
tool. Also, the interface between a row and a column can be moved by using the Move Boundary tool. (See 2D Grid
Tool Palette)

Merging Rows and Columns
Rows or columns can be merged together by selecting the rows or columns using the Select i  or Select j  tools,
right-clicking and selecting the Merge command from the pop-up menu. This command is the same as the Merge
Cells command in the Grid menu in the main menu bar.

http://www.xmswiki.com/xms/index.php?title=GMS:Materials
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2D Grid Display Options

The properties of all 2D Grid data that GMS displays on the screen can be controlled through the 2D Grid tab of the
Display Options dialog. This dialog is opened by right-clicking on the  2D Grid Data entry in the Project Explorer
and selecting the Display Options command. It can also be accessed from the from the Display menu or the 
Display Options macro. The following table describes the display options available for the 2D Grid module.

Display
Option

Description

Nodes The Nodes item is used to display grid nodes depending on the Grid Type . If the grid is cell-centered, a dot is displayed at the cell
centers. If the grid is mesh-centered, a dot is displayed on the cell corners.

Cell edges The Cell edges item is used to display the edges of grid cells. The cells are either drawn using the default cell color or the color of
the material associated with each cell.

In addition to turning the display of cells on or off, you can temporarily hide grid cells.

The color of the cell edges can be adjusted according to the following options:

1. Auto – draws the material color if faces are not displayed. Uses black or white if the faces are displayed.
2. Specified – used the color specified next to the cell edges
3. Material – displays the material color of the cell

Cell faces The Cell faces item causes the faces of the grid cells to be drawn as filled polygons.

Inactive cells The Inactive cells item is used to display cells which are inactive. If this option is turned off, inactive cells are not displayed.
Inactive cells must be displayed before they can be selected.

Grid
boundary

The Grid boundary item is used to display a solid line around the perimeter of the grid. Displaying the boundary is useful when
contours are being displayed with the cell edges turned off.

Cell numbers The Cell Numbers item is used to display the ID of each grid cell.

Node
numbers

The Node Numbers item is used to display the ID of each grid node.

Scalar values The Scalar Values item is used to display the scalar values of the active dataset for each node next to the node.

IJ indices The IJ indices item is used to display the ij indices of each cell or node.

IJ triad The IJ triad item is used to display a symbol at one of the corners of the grid showing the orientation of the ij axes.

Texture map
image

The Texture map image item is used to "drape" an image over the surface of the 2D Grid.

Contours Most of the objects supported by GMS can be contoured by turning on the Contour Options in the Display Options dialog. When an
object is contoured, the values associated with the active dataset for the object are used to generate the contours.

Vectors If the Vectors item in the Display Options dialog is selected for an object (TIN, Grid, or Mesh), vector plots can be generated using
the active vector dataset for the object. One vector is placed at each node, cell, or vertex.
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The Display Options dialog showing the 2D Grid tab.
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2D Grid Tool Palette

The following tools are contained in the dynamic portion of the Tool Palette when the 2D Grid Module is active.
Only one tool is active at any given time. The action that takes place when the user clicks in the Graphics Window
depends on the current tool. The following table describes the tools in the 2D Grid tool palette.

Tool Tool
Name

Description

Select Cell The Select Cell tool is used to select individual grid cells or grid nodes. Multi-selection can be performed by holding down the
SHIFT key while selecting or by dragging a rectangle to enclose the cells to be selected. The ij indices of the selected cell are
displayed in the Edit Window.

Only visible cells can be selected. Cells which have been hidden cannot be selected. Inactive cells can only be selected when
they are being displayed by turning on the Inactive Cells item in the Display Options dialog.

To select specific cell based on the ij of the cell or by cell ID you can use the Find Cell command in the Grid menu. The Find
Grid Cell dialog provides edit fields for both an ID or an IJ value. Entering a value for ID will automatically update the IJ fields.
Likewise, entering a value for the IJ location will automatically update the ID. When the OK button is selected, the indicated
cell will be selected in the grid.

In addition to selecting one cell at a time, the Find Grid Cell Dialog can select an entire row column or layer. A zero may be
entered in either of the I or J fields indicating that all cells in that direction will be selected. The ID of the cells that will be
selected is also displayed as static text at the top of the dialog.

Select i The Select i tool is used to select an entire "row" (set of cells with the same i index) of cells at once. Multi-selection can be
performed by holding down the SHIFT key. The i index of the selected row is displayed in the Edit Window.

Select j The Select j tool is used to select an entire "column" (set of cells with the same j index) of cells at once. Multi-selection can be
performed by holding down the SHIFT key. The j index of the selected column is displayed in the Edit Window.

Select
Node

The Select Node tool is used to select nodes and interactively edit cell boundary coordinates by clicking on the intersection of
two cell boundaries and dragging the boundaries with the mouse button held down. The coordinates of the cell boundary
intersection are displayed in the Edit Window as the boundaries are dragged. If the current view is not the plan view, the
dragging movement is constrained to follow the Z axis. The coordinates of a selected boundary intersection can also be edited
by directly entering the coordinates in the Edit Window.

Add i
Boundary

The Add i Boundary tool is used to insert a new i boundary into the grid. The new boundary is inserted at the cursor location
when the mouse button is clicked. Inserting a new cell boundary changes the dimensions of the grid and all data sets associated
with the grid are deleted. If the control key is held down while executing this command, the row will be evenly divided.

Add j
Boundary

The Add j Boundary tool is used to insert a new j boundary into the grid. The new boundary is inserted at the cursor location
when the mouse button is clicked. Inserting a new cell boundary changes the dimensions of the grid and all data sets associated
with the grid are deleted. If the control key is held down while executing this command, the column will be evenly divided.

Contour
Labels

The Contour Label tool manually places numerical contour elevation labels at points clicked on with the mouse. These labels
remain on the screen until the contour options are changed, until they are deleted using the Contour Labels dialog, or until the
grid is edited in any way. Contour labels can be deleted with this tool by holding down the SHIFT key while clicking on the
labels. This tool can only be used in plan view.
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Converting 2D Grids

2D Grids may be converted to other types of data used in GMS, such as a TIN, 2D mesh, or 2D scatter points. 2D
Grids can be converted by using the following commands in the Grid menu:

Grid → 2D Scatter Points
The Grid → 2D Scatter Points command in the Grid menu is used to create a new scatter point set using the nodes
or cells of a 2D grid. A copy is made of each of the datasets associated with the grid and the datasets are associated
with the new scatter point set.

Grid → TIN
A new TIN can be created from a 2D grid by selecting the Grid → TIN command from the Grid menu. Two
triangles are created from each cell in the grid.

Grid → 2D Mesh
A new 2D finite element mesh can be created from a 2D grid by selecting the Grid → 2D Mesh command from the
Grid menu. A four node quadrilateral element is created from each cell in the grid.

Contours → Arcs
Creates a new feature coverage containing arcs derived from the linear contours on the 2D grid. The command only
works if linear contours are being displayed.
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2D Grid Commands
When the 2D Grid module is active, the Grid menu becomes active. The Grid menu contains one submenu; the
Convert To submenu. The following commands are found in the Grid menu:
•• Create Grid...

Brings up the Create Finite Difference Grid dialog.
•• Merge Cells

Merges selected grid rows or columns into one grid row or column.
•• Find Cell...

The Find Cell command in the Grid menu opens a dialog that lets you find a grid cell or node by ID or
by IJ (for 2D Grids) or IJK (for 3D Grids) indices. The cell or node is selected and highlighted. If there
is no cell or node with the given ID or IJK, the one closest to it is selected.

•• Find Node...

Selects a node given an ID or IJ coordinate.

Convert To> submenu

• Grid → 2D Scatter Points

Creates a scatter point set with a point on the center of each cell with the value of the cell.
• Grid → TIN

Creates a TIN based on cell centers of the grid.
• Grid → 2D Mesh

Creates a mesh typically from the cell centered values in the grid for the different layers. The first dialog
allows the user to choose between the cell centers or the cell corners to create the mesh. A disclaimer is
given that data values are given at the cell center and that datasets will not be converted.

• Contours → Arcs

Converts layer contours into arcs that can be manipulated as drawing objects.

Related Topics
•• 2D Grid Module
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5.6. 2D Scatter Point Module

2D Scatter Point Module

The 2D Scatter Point module is used to interpolate from groups of 2D scattered data to other objects (meshes, grids,
TINs). Several interpolation schemes are supported, including kriging.
Interpolation is useful for setting up input data for analysis codes and for site characterization. The two figures below
show examples of using interpolation.

Interpolation of Modflow Layer Elevations to a 3D Grid Sample Interpolation for Site Characterization
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Creating and Editing 2D Scatter Point Sets

Each of the points from which values are interpolated are called scatter points. A group of scatter points is called a
scatter point set. Each of the scatter points is defined by a set of xy coordinates.
Each scatter point set has a list of scalar datasets. Each dataset represents a set of values which can be interpolated to
a TIN, mesh, or grid.
Multiple scatter point sets can exist at one time in memory. One of the scatter point sets is always designated as the
"active" scatter point set. Interpolation is performed from the active dataset of the active scatter point set only.

Creating Scatter Points
Scatter point sets can be created in one of three ways: interactively creating scatter points, converting from other data
types, or importing from a file.

Interactively Creating Scatter Points
The Create scatter point tool is used to click out new scatter points in the GMS Graphics Window. The new scatter
points are added to the active scatter point set. If you want the new points in their own scatter point set then select
the Scatter Points | New Scatter Point Set command.

Converting from Other Types
Scatter point sets are often created by converting from other data types (TINs, meshes, grids, boreholes). The
following commands are available to convert an object to a Scatter Point Set:
• TIN → 2D Scatter_Points
• Contacts → 2D Scatter Points
• Watertable → 2D Scatter Points
• Grid → 2D Scatter Points
• Mesh → 2D Scatter_Points
• Map → 2D Scatter Points
• Modflow Layers → 2D Scatter_Points

Importing Tabular Scatter Point Data
In most cases, scatter point sets are created by importing a text file through the File Import Wizard.

Editing Scatter Points
The location of a scatter point can be edited by selecting the scatter point and dragging it to a new location or by
typing in the new coordinates in the Edit Window.
The dataset value associated with a scatter point can be edited using the edit field labeled "F:" in the Edit Window.
Dataset values can also be edited using a spreadsheet dialog by selecting the Edit Values button in the Dataset Info
dialog.
In addition to the dataset values, each scatter point has three properties that can be edited on a point by point basis:
•• label
•• material
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•• activity
•• Fixed pilot point
The label is a text string that can be displayed by turning on the ID option in the Display Options dialog. The
material type is used for indicator simulations.
The fixed pilot point property is used with PEST(See Automated Parameter Estimation). If this option is on, then the
value at this point is not estimated during the parameter estimation process.
The scatter point properties can be edited by double-clicking on a point or by selecting a set of points and selecting
the Properties command in the Edit menu.

Deleting Scatter Points
Individual scatter points can also be deleted. This command results in the removal of the point from all the datasets
associated to the scatter point set.

2D Scatter Point Display Options

The Display Options dialog showing the 2D Scatter Point Set tab.

The properties of all 2D scatter data
that GMS displays on the screen can be
controlled through the 2D Scatter tab
of the Display Options dialog. This
dialog is opened by right-clicking on
the  2D Scatter Data entry in the
Project Explorer and selecting the
Display Options command. It can also
be accessed from the from the Display
menu or the  Display Options
macro. The following table describes
the display options available for the 2D
Scatter Point module.

Display
Option

Description

Active scatter
point set

The name of the active scatter point set is listed at the top of the dialog. The symbol selected using the Scatter point symbols
option (described below) applies to the active scatter point set. This makes it possible to use a different set of symbols for the
points in each set so that the sets are easily distinguishable.

Scatter point
symbols

The Scatter point symbols item is used to display a symbol at the location of each scatter point. The widget to the left of the toggle
is used to bring up a dialog listing the available symbols. The color of each of the scatter points in a set may be changed in this
dialog also.

The color of the scatter points can be adjusted according to the following options:

1. Specified – uses the color specified next to the scatter point symbols
2. Data – the color ramp is used to assign a color to each of the symbols according to the value of the active scalar dataset

Contours Individual scatter points can be colored based on the current dataset by using contour options.
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Inactive scatter
points

Individual scatter points can either be active or inactive. The Inactive scatter points option can be used to control the display of the
inactive points.

Scatter point
scalar values

The Scatter point scalar values option is used to display the value of the active data set next to each of the scatter points.

Scatter point
labels

The Scatter point labels item is used to display the scatter point label next to each scatter point.

Scatter point
numbers

The Scatter point IDs item is used to display the scatter point ID next to each scatter point.

Symbol legend The Symbol legend item is used to display a symbol legend listing each of the scatter point sets by name and showing the symbol
associated with the scatter point sets.

2D Scatter Point Tool Palette
The following tools are active in the dynamic portion of the Tool Palette whenever the 2D Scatter Point Module is
active. Only one tool is active at any given time. The action that takes place when the user clicks in the Graphics
Window with the cursor depends on the current tool. The table below describes the tools in the 2D Scatter Set tool
palette.

Tool Tool
Name

Description

Select
Scatter
Point

The Select Scatter Point tool is used to select individual scatter points for editing using the Edit Window. Scatter points can also
be dragged with the mouse. Scatter points can be deleted. With extremely large sets of scatter points, it may become difficult to
identify a scatter point with a particular ID, even if the scatter point IDs are being displayed. In such cases, the Find Point
command in the Scatter Points menu can be used to quickly locate a point. The command prompts the user for the ID of the
desired point and the point is selected.

Select
Scatter
Point Set

The Select Scatter Point Set tool is used to select entire scatter point sets for deletion or to designate the active scatter point set.
When this tool is active, an icon appears at the centroid of the set for each of the scatter point sets. A scatter point set is selected
by selecting the icon for the set.

Create
Scatter
Point

This tool is used to interactively create scatter points by clicking in the GMS graphics window.
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Interpolating with 2D Scatter Points

Scatter point sets are used for interpolation to other data types such as TINs, grids, and meshes. A 2D grid can be
created which will just enclose the scatter points by using the Bounding Grid command in the Scatter Points menu.
Interpolation is useful for such tasks as contouring or setting up input data to a model. Since no interpolation scheme
is superior in all cases, several interpolation techniques are provided in GMS.
The basic approach to performing an interpolation is to select an appropriate interpolation scheme and interpolation
parameters, and then interpolate to the desired object using one of the 2D interpolation commands.
The interpolation options are selected using the Interpolation Options dialog accessed through the Interp. Options
command in the Interpolation menu. Once a set of options is selected, those options are used for all subsequent
interpolation commands.
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Converting 2D Scatter Points to Other Types of
Data

2D Scatter Points may be converted to other types of data used in GMS, such as a TIN, 2D Mesh Nodes, or
Observation Points. 2D Scatter Points are converted by using the following commands in the Scatter Points menu:
• Scatter Points → TIN

The Scatter Points → TIN command creates a set of TIN vertices. These vertices are automatically
triangulated to form a TIN.

• Scatter Points → Mesh Nodes

The Scatter Points → Mesh Nodes command creates a set of 2D finite element nodes from the points in the
active scatter point set.

• Scatter Points → Obs. Pts.

The Scatter Points → Obs. Pts command creates one observation point for each of the scatter points in the
active scatter point set. The active dataset values become the measured values for the observation points. You
must create a coverage with a measurement before executing this command.

• Scatter Points → 3D Scatter Points

The Scatter Points → 3D Scatter Points command creates a 3D scatter point set from the 2D scatter points. All
of the datasets are copied to the 3D scatter points. The Z (elevation) of the 3D scatter points is set to the Z of
the 2D scatter points at the time of conversion.

http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
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Gaussian Field Generator
GMS includes an interpolation option associated with the 2D scatter point module called Gaussian Sequential
Simulation (GSS). This option is used to generate a set of scalar datasets (Gaussian fields) using a Gaussian
sequential simulation. This is somewhat similar to indicator kriging or T-PROGS in that it generates a set of equally
probable results which exhibit heterogeneity and are conditioned to values at scatter points. However, the resulting
arrays are floating point scalar datasets, rather than the integer arrays produced by T-PROGS and indicator kriging.
The results of a GSS can be used in combination with the new Multiplier Array option for parameters. It is now
possible to associate one or more scalar datasets with an array-based parameter. When MODFLOW is executed, the
parameter starting value is multiplied by the dataset to produce the input array. This makes it possible to use the
results of the Gaussian sequential simulation as input for parameter fields for a stochastic (Monte Carlo) simulation.

Gaussian Simulations
The new GSS tool is based on the FIELDGEN code developed by John Doherty. John Doherty describes GSS as
follows:
The process of stochastic field generation by sequential simulation is very easy to understand. At each field point an
expected field value and a field standard deviation pertaining to that point are first determined. These are calculated
through kriging from points to which field values have already been assigned, as well as from points at which
conditioning data exists (if available). Using the expected value and standard deviation calculated in this way, a
random field value is generated based on the assumption of a Gaussian probability distribution. The field value thus
obtained can then be used in generating expected values and standard deviations at other field points at which field
generation then takes place in the same way.

GSS is a form of Kriging but it is listed in the GMS interface as a new interpolation scheme. This new option will
differ from Kriging in the following ways:
1. GSS uses the FIELDGEN utility developed by John Doherty to perform the interpolation rather than the GSLIB

code used by kriging. FIELDGEN is a modified version of the sgsim utility in GSLIB so many of the options are
quite similar to those used for normal kriging.

2.2. As is the case with T-PROGS, the user enters the number of desired simulations and FIELDGEN produces N
arrays, rather than one array.

3.3. It can only be used for 2D interpolation and it will only work when interpolating to 3D cell-centered grids.
4.4. It can work with or without a scatter point set. If a scatter point set is provided, the resulting fields are

conditioned to the values at the scatter points. Otherwise the user defines a mean and a variogram and the values
are randomly generated.

http://www.xmswiki.com/xms/index.php?title=GMS:Multiplier_Arrays_for_Parameters
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Gaussian Simulation Options
The first step in setting up a GSS is to import a set of scatter points with the values to which you intend to condition
your simulation. This step can be skipped if you have no conditioning data. The next step is to select the Gaussian
Simulation Options command in the Interpolation menu in the 2D Scatter Point module. This brings up the
following dialog:

The Solution name at the top is the
name that will be applied to the set of
Gaussian fields. The Number of
realizations item is the desired number
of Gaussian fields. The original GSLIB
code was designed to work with
uniform grids (constant cell sizes). The
Non-uniform grid option controls how
the data are converted to a non-uniform
grid (if necessary). The Edit
Variogram button should be selected to
set up a model variogram using the
GMS variogram editor. A model
variogram must be defined whether or
not you have scatter points for
conditioning.

Running the Simulation

Once the GSS options are selected, the next step is to run the simulation. This is accomplished by selecting the Run
Gaussian Simulation command in the Interpolation menu. During the simulation, you should see a window
displaying the progress of the simulation:

Viewing the Results

Once the simulation is finished, you should see a new
folder appear in the Project Explorer window which has
the name of the simulation and contains a set of dataset
arrays:
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Clicking on each dataset icon makes it the active dataset for contouring. The
dataset properties can be viewed by double-clicking on the icon. The following
image represents a sample Gaussian realization:

http://www.xmswiki.com/xms/index.php?title=File%3AGaussian_sim_results.gif
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Active/Inactive Points

Each scatter point has an active/inactive status. A scatter point with an inactive status can be displayed, but the
dataset value at the point is ignored when interpolation takes place. As a result, interpolation proceeds as if the point
did not exist.
The active/inactive flags for scatter points are particularly useful when dealing with transient data. For example,
suppose that a set of scatter points represents TCE concentrations measured at a series of observation wells over a
year's time. The locations of the wells and the measured concentrations can be imported to GMS as a scatter point set
with a transient dataset. Once they are imported, the transient dataset can be interpolated to a grid and a film loop
showing color shaded contours can be generated to illustrate how the plume has changed with time. However, in
preparing the data for import, it is discovered that some of the data values are missing. One approach is to make up a
dummy value for the missing sample and enter the entire dataset anyway. The problem with this approach is that it is
difficult to determine an appropriate dummy value. Another option is to enter this value as a "non-detect". This
causes the point to become inactive for the time step where the sample is missing. GMS disregards the point for that
time step and performs the interpolation using the remaining active points.
Active/inactive flags are stored with datasets. If the active dataset is changed, the active/inactive flags will be
reassigned based on the flags in the new active dataset. Not all datasets contain active/inactive flags. If a dataset does
not contain flags, all points are assumed to be active.
The following methods can be used for controlling or assigning the active/inactive status of points:

Tabular Scatter Point Input
If the scatter points are imported using the File Import Wizard then a special data value can be designated as
NONDETECT. This value is typically assigned to a number not likely to be encountered such as -999. Then, as the
dataset columns are being read, any value with the NONDETECT value is assumed to be inactive and the status flag
is set accordingly.

Active/Inactive Flags Dialog
After a scatter point set has been imported to GMS, the active/inactive status flags for the active dataset can be edited
by selecting the Edit Inactive Flags button in the Dataset Info dialog accessed from the Dataset Properties dialog
(this dialog is accessed from the Project Explorer). This brings up the Active/Inactive Flags dialog. This dialog is
used to either delete all of the current active/inactive flags (making all points active), or enter one or more key values
(ex., -999) which are used to inactivate all points with the listed values.

http://www.xmswiki.com/xms/index.php?title=GMS:Datasets
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The Active/Inactive Flags dialog.

2D Interpolation Options
The interpolation options are selected using the Interpolation Options dialog accessed through the Interp. Options
command in the Interpolation menu. Once a set of options is selected, those options are used for all subsequent
interpolation commands. The items in the 2D Interpolation Options dialog are as follows:

Active Dataset
Interpolation is always performed using the active dataset of the active scatter point set. The active dataset is
normally selected in the Project Explorer. The name of the current active dataset is listed at the top of the 2D
Interpolation Options dialog. The active dataset can not be changed with this dialog.
If the active dataset is transient then more interpolation options are available. (see Steady State vs. Transient
Interpolation)

Interpolation Method
The following 2D interpolation methods are supported by GMS:
•• Linear
•• Inverse Distance Weighted
•• Clough-Tocher
•• Natural Neighbor
•• Kriging

Log Interpolation
When interpolating chemical data, it is not uncommon to have a small "hot spot" somewhere in the interior of the 
data where the measured concentrations are many orders of magnitude higher than the majority of the other 
concentrations. In such cases, the large values dominate the interpolation process and details and variations in the 
low concentration zones are obliterated. One approach to dealing with such situations is to use log interpolation. If 
this option is selected, GMS takes the log of each data value in the active scatter point set prior to performing 
interpolation. By interpolating the log of the dataset, small values are given more weight than otherwise. Once the 
interpolation is finished, GMS takes the anti-log (10x) of the interpolated dataset values before assigning the dataset
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to the target grid or mesh.
Note that it is impossible to take the log of a zero or negative value. When the log interpolation option is turned on, a
value must be entered by the user to assign to scatter points where the current data value is less than or equal to zero.
Typically, a small positive number should be used.

Anisotropy
Sometimes the data associated with a scatter point set will have directional tendencies. The azimuth and horizontal
anisotropy allow the user to take into account these tendencies.

Extrapolation
Although they are referred to as interpolation schemes, most of the schemes supported by GMS perform both
interpolation and extrapolation. That is, they can estimate a value at points both inside and outside the convex hull of
the scatter point set. Obviously, the interpolated values are more accurate than the extrapolated values. Nevertheless,
it is often necessary to perform extrapolation. Some of the schemes, however, perform interpolation but cannot be
used for extrapolation. These schemes include Linear and Clough-Tocher interpolation. Both of these schemes only
interpolate within the convex hull of the scatter points. Interpolation points outside the convex hull are assigned the
Default extrapolation value.

Truncation
When interpolating a set of values, it is sometimes useful to limit the interpolated values to lie between a minimum
and maximum value. For example, when interpolating contaminant concentrations, a negative value of concentration
is meaningless. However, many interpolation schemes will produce negative values even if all of the scatter points
have positive data values. This occurs in areas where the trend in the data is toward a zero value. The interpolation
may extend the trend beyond a zero value into the negative range. In such cases it is useful to limit the minimum
interpolated value to zero. Interpolated values can be limited to a given range by selecting the Truncate values option
in the Interpolation Options dialog. The range can be user-defined or automatically set to the maximum and
minimum values of the dataset being interpolated.
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2D Scatter Point Commands
The Scatter Point menu becomes available when the 2D Scatter Point module is active. The menu has one submenu:
the Interpolation submenu. Below are the commands available in this menu.
•• New Scatter Point Set

Creates a new dataset.
•• Lock All Scatter Points

Prevents adjusting the location of scatter points.
•• Scatter Point Settings...

Opens the Scatter sets tab under the Preferences dialog.
•• Find Point...

User may find a point based on ID number or text label.
• Interpolation >

•• Interpolation Options...

Opens the 2D Interpolation Options dialog.
• Interpolate → Active TIN

Interpolate the active dataset on the active scatter set to the active TIN.
• Interpolate → 2D Mesh

Interpolate the active dataset on the active scatter set to the 2D mesh.
• Interpolate → 2D Grid

Interpolate the active dataset on the active scatter set to the 2D grid.
• Interpolate → 3D Mesh

Interpolate the active dataset on the active scatter set to the 3D mesh.
• Interpolate → 3D Grid

Interpolate the active dataset on the active scatter set to the 3D grid.
• Interpolate → MODFLOW Layers

Interpolate datasets on the active scatter set to MODFLOW arrays like top and bottom elevation, starting
head etc.

• Interpolate → UGrid

Interpolate the active dataset on the active scatter set to the Active UGrid.
•• Gaussian Simulation Options...
•• Run Gaussian Simulation
•• Jackknifing...
•• Summary...

Brings up the Jacknifing Summary dialog.
•• Bounding 2D Grid...

Creates a 2D Grid that bounds or contains all of the scatter points in the active set.
•• Bounding 3D Grid...

Creates a 3D Grid that bounds or contains all of the scatter points in the active set.
• Scatter Points → TIN

http://www.xmswiki.com/xms/index.php?title=GMS:Interpolation_Commands
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Creates a TIN from the active scatter point set.
• Scatter Points → Mesh Nodes

Creates nodes from the scatter points for a 2D mesh.
• Scatter Points → Obs. Pts.

Creates Observation Points from the active dataset. A coverage that is set for observation data must
already exist.

•• Merge

Merges points from selected scatter sets together to form one scatter set, combining datasets.
•• Activate

"Activates" selected scatter points by changing the active flags in the active dataset, or in all datasets. A
dialog asks the user whether they wish to change only the active dataset or all datasets. If the datasets
are transient, all time steps will be changed.

•• Inactivate

Same as the Activate command but in reverse. Inactive points can be selected only if they are displayed
via the option in the Display Options dialog.

Related Topics
•• 2D Scatter Point Module

http://www.xmswiki.com/xms/index.php?title=GMS:2D_Scatter_Point_Module
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5.7. 3D Mesh Module

3D Mesh Module

The 3D Mesh module is used to create and edit 3D finite element meshes. Once a mesh is constructed, the
FEMWATER interface can be used to assign boundary conditions and analysis parameters and perform a
FEMWATER analysis.

Iso-surface of Pressure Head from a FEMWATER Simulation

http://www.xmswiki.com/xms/index.php?title=GMS:FEMWATER
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3D Element Types

Four types of 3D elements are supported by GMS: eight node hexahedra, six node prisms or wedges, four node
tetrahedra, and five node pyramids. Hexahedra and wedges are created by projecting a 2D mesh. Tetrahedral
elements are constructed with the Tessellate command or they can be created elsewhere and imported into GMS.

Types of 3D Elements Supported by GMS

http://www.xmswiki.com/xms/index.php?title=File%3AElemTypes1.gif
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Creating a 3D Mesh

In order to create a 3D Mesh in GMS you must have a set of 3D Mesh nodes. Elements can be created by using one
of the create element tools and then selecting the mesh nodes to create elements. Duplicate points can be removed by
selecting Find Duplicates command from the Mesh menu. If a node is found that is within a user specified tolerance
of another node, the node is either selected or deleted.
3D Meshes can be created 2 different ways in GMS: converting a different GMS data type to a 3D Mesh and using
an automatic meshing technique.

Converting GMS data to a 3D Mesh
3D Grids and 3D Scatter Points can be converted to a 3D Mesh. This is accomplished by using the following
commands:

Grid → 3D Mesh
A 3D grid can be converted into a 3D mesh. If the 3D grid is a mesh-centered grid, the grid nodes are simply
converted into a mesh nodes. If the 3D grid is a cell-centered grid, a mesh node is placed at the centroid of each cell
to form the 3D mesh. An eight node quadrilateral element is created from each cell in the grid.

Scatter Points → Mesh Nodes
The Scatter Points → Mesh Nodes command is used to convert each of the scatter points to a 3D mesh node. The
nodes can then be used to generate a mesh using the Tessellate command in the Mesh menu in the 3D Mesh module.

Automated Meshing
3D finite element meshes are not always constructed within the 3D Mesh module. The following methods are
available for the construction of 3D Meshes:

Fill Between TINs → 3D Mesh

3D Mesh With Multiple Zones

3D meshes are often constructed using a combination of tools in the
TIN module and the 2D Mesh module. Portions of the mesh
corresponding to "zones" or stratigraphic units are constructed one at a
time as shown below. Each of these zones is bounded above and below
by a surface and consists of one or more layers of 3D elements.

Before constructing a zone of elements, a 2D mesh must be created or
imported using the 2D Mesh Module. A pair of TINs must also be
created which represent the top and the bottom of the zone. These TINs
are typically constructed from borehole data or from scatter points. The
zone is then created by selecting the two TINs and selecting the Fill Between TINs → 3D Mesh command in the
TINs menu. At this point, the user is prompted to enter the number of layers of elements to be created between the
TINs and the material that will be associated with the elements in the zone. Each of the elements in the 2D mesh is
then "projected" through the two TINs to create a vertical column of 3D elements as shown below. For example, if N

layers are specified, N 3D wedge elements are created from each of the triangular elements in the 2D mesh, and N 
3D hexahedral elements are created from each of the quadrilateral elements in the 2D mesh. The Z coordinates of the
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nodes created for the 3D elements are distributed uniformly between the top and the bottom TINs.

Projection Technique for Creating 3D Meshes

This process is repeated for each of the zones in the mesh. In order for
the nodes at the bottom of one zone to match the nodes at the top of
another zone, the same TIN should be used at the bottom of the upper
zone and at the top of the lower zone. If the vertices of the TIN are
edited in any way after one layer is generated but before an adjacent
layer is generated, a gap may be introduced between the two zones of
3D elements.
Classify Elements

One way to model features such as a clay seam is to create all of the layers in the mesh and then change the
material type of selected elements. The Classify Elements command in the Mesh menu can be used to
accomplish the same task using solid models of the soil stratigraphy. Using this command, a solid model can
be constructed and used to change the material type of a set of elements corresponding to a complicated
geometric feature. When the Classify Elements command is selected, the centroid of each element in the 3D
mesh is computed and the centroid is checked with each of the solid models to determine which solid the
centroid lies within. The material type of the element is then changed to correspond to the material type of the
solid containing the element centroid. If the centroid of an element does not lie in the interior of any of the
solids, the material type of the element is unaltered.

Modeling a Clay Seam Using Zones of Elements

The advantage of this construction procedure for 3D meshes is that it is
simple and it is fast. The disadvantage of the procedure is that
truncations or pinchout zones in the stratigraphy are not directly
modeled. However, such features can be simulated by selecting
elements and changing the material type associated with the elements
once a zone of elements has been created. For example, suppose an
aquifer contains a clay lens that extends partially into the aquifer as
shown in part a of the figure below. A zone of elements could be
created for the clay layer which extends over the entire XY range of
the model (part b). The elements in this set of clay elements that are
not in the region actually occupied by the clay layer could be selected
and assigned the material type of the aquifer (part c). This can also be
accomplished with a Solid Model and the Classify Elements
command.

Creating 3D Meshes From Solid Models
Unlike the Solids → MODFLOW Boundary Matching option, it is not necessary to create a 3D mesh before
selecting the Solids → Layered Mesh command. The 3D mesh is automatically generated. Each element in the 2D
projection mesh is extruded into a vertical column of cells and the solids are used to assign the elevations to the
nodes. The material ids are assigned to the 3D elements by finding the solid that encompasses the centroid of each
3D element assigning the material id of that solid to the element.

http://www.xmswiki.com/xms/index.php?title=File%3AExtrusion1.gif
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Creating 3D Meshes From Mesh Nodes
A mesh can be automatically constructed from a set of 3D nodes with the Tessellate command in the Mesh menu of
the 3D Mesh module. This command performs the three-dimensional equivalent of the Delauney triangulation
process. The Tesselation algorithm assumes that each of the vertices being tesselated is unique in xyz, i.e., no two
points have the same xyz location. The result is a mesh composed entirely of tetrahedra. The region that is meshed
corresponds to the convex hull of the nodes.

http://www.xmswiki.com/xms/index.php?title=GMS:Triangulation
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Editing a 3D Mesh

Editing Nodes
3D mesh nodes can be:
• Moved – The coordinates of a 3D mesh node can be edited by selecting the node and dragging it to its new

location or by typing the new coordinates in the Edit Window.
• Locked – Once a mesh has been created and edited as desired, the locations of all of the mesh nodes can be

locked using the Lock All Nodes command. This is generally done to avoid inadvertent movement of the nodes
while assigning boundary conditions and manipulating the view. Once the nodes can be unlocked by unselecting
Lock All Nodes command.

• Deleted – 3D mesh nodes can be deleted by selecting the node and then the Delete command from the Edit menu
or the Delete key.

• Renumbered – As a 3D mesh is constructed within GMS, the nodes and elements in the mesh are numbered
arbitrarily. If any nodes or elements are deleted, gaps are created in the numbering sequence. Such gaps can be
removed and an optimal numbering sequence can be achieved by selecting the Renumber command in the Mesh
menu. Prior to selecting the Renumber command, the user should select a series of boundary faces of the 3D
mesh. These faces represent the location where the numbering process is to begin. In most cases, it is best to
select all of the faces on an entire side of the mesh. This can be accomplished using the Select Face tool with the
Control key held down. The renumbering process renumbers the nodes and elements in a logical order that tends
to minimize the node and element bandwidth (which leads to more efficient solutions with some finite element
solvers). The process begins by ordering the nodes and faces of the selected group of faces. This is essentially a
2D renumbering process. The longitudinal and lateral directions of the region of selected faces are determined and
the numbering proceeds by sweeping along rows oriented in the lateral direction while progressing from row to
row in the longitudinal direction. Once the nodes and faces of the selected region are renumbered, the layer of
elements adjacent to the faces are numbered in a similar sequence. This process is repeated by sweeping outward
from the selected region, one layer of elements at a time, until the entire mesh is renumbered. The results of the
renumbering process can be reviewed by turning on the display of node and/or element numbers in the Display
Options dialog. The results can also be viewed by right-clicking on the 3D Mesh Data Folder in the Project
Explorer and selecting the Properties command. The node and element bandwidths are listed in the dialog that
comes up. If the objective of renumbering the mesh is minimizing the node and element bandwidths, the best
results are generally achieved by selecting a side of the mesh corresponding to one of the two "ends" of the major
or longitudinal axis of the mesh.

Refine Elements
3D mesh elements can be refined. Increasing the density of mesh elements can be accomplished by selecting a set of
elements and selecting the Refine Elements command from the Mesh menu. This brings up the Refine Elements
dialog.

Elements to Refine

The top portion of the dialog is used to specify which elements in the mesh are to be refined. If the Refine all 3D
mesh elements option is selected, all elements in the mesh are refined regardless of which elements are selected. If
the Refine selected 3D mesh elements option is selected, only the selected elements of the mesh are refined.
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Even if the Refine selected 3D mesh elements option is selected, a few elements that were not selected must also be
altered. This is due to the fact that the elements that were selected for refinement are refined, disjoint faces are
created between the selected elements and the non-selected elements directly adjacent to the selected elements. To
eliminate these disjoint faces, some transition elements are identified and refined. Transition elements are defined as
any non selected element that shares at least one node with an element that is selected for refinement.

Refinement Method

There are three methods of refinement that can be used. The difference among the three methods is the shape of the
resulting mesh elements. Each of the three methods is described below.

Vertical Column

Vertical column refinement of (a) hexahedra and
(b) wedges

Vertical column refinement is used to split hexahedra and wedges in
the X and Y directions only, as shown on the right.
Vertical column refinement was designed to be used with meshes
created by extruding a 2D mesh through several layers. Meshes created
in this manner are composed strictly of hexahedra and wedges and can
be made by following the mesh extrusion procedure.
Depending upon the type and orientation of the elements in a 3D mesh,
vertical column refinement may not be possible. When the Refine
Elements options is selected from the Mesh menu, the entire mesh is
checked to see if it can be refined using vertical column refinement. If
vertical column refinement is not possible, the Vertical column
refinement option is dimmed. In order for vertical column refinement
to be possible, the following conditions must be met.

1.1. If the entire mesh is to be refined, all elements in the mesh must be either hexahedra or wedges.
2.2. If only a selected portion of the mesh is to be refined, all selected elements must be either hexahedra or wedges.
3.3. All wedges to be refined must be oriented in space such that their top and bottom faces correspond to the

triangular faces of the wedge.
4.4. Both the top and bottom faces of each element to be refined must be on the boundary or adjacent to other

elements that are also to be refined.
5.5. All transition elements (i.e., elements not intended to be refined but share at least one node with an element that

was selected for refinement) must also satisfy conditions 2 and 3 above.

All Elements To Tetrahedra

All elements to tetrahedra fine method of
refinement of (a) hexahedra, (b) wedges, (c)

pyramids, and (d) tetrahedra

All element types to tets refinement is used to convert any of the four
basic element types to tetrahedra. This option is especially useful since
some finite element solvers require meshes to be composed strictly of
tetrahedra.
The Coarse refinement and Fine refinement options are used to specify
the degree of refinement to be applied. If the Fine refinement option is
selected, each tetrahedron is divided into eight smaller tetrahedra, each
pyramid is divided into 16 smaller tetrahedra, each wedge is divided
into 24 smaller tetrahedra, and each hexahedron is divided into 48
smaller tetrahedra. As with vertical column refinement, it is possible to refine either the entire mesh or selected
portions of a mesh using the Fine refinement method.
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If the Coarse refinement option is selected, each pyramid is divided into two smaller tetrahedra, each wedge is
divided into either three, or eight tetrahedra, and each hexahedra is divided into five, six, or twelve tetrahedra as
shown below. Tetrahedra are not refined. Unlike the Fine refinement method, it is not possible to refine only a
selected portion of a mesh when using the coarse method. The entire mesh gets refined.

All elements to tetrahedra coarse method of
refinement of (a) hexahedra, (b) wedges, and (c)

pyramids

Retain Element Types

Retain element types refinement of (a) hexahedra,
(b) wedges, (c) pyramids, and (d) tetrahedra.

Retain element types refinement is used to convert any of the four
basic element types to smaller elements of the same type. For example,
each hexahedra is divided into eight smaller hexahedra as shown
below. Pyramids are the exception since they are divided into five
smaller pyramids and four tetrahedra. It is possible to divide a pyramid
into four smaller pyramids, but the resulting pyramids are of poor
quality.
Like vertical column refinement, it is possible to refine only selected
portions of a mesh when using Retain element types refinement. However, it is not always possible to retain element
types in the transition elements. If the original mesh is composed of strictly tetrahedra, any selected region of the
mesh can be refined without introducing elements other than tetrahedra. However, if the mesh contains any element
type other than tetrahedra, pyramids and wedges will be introduced into the transition region.
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3D Mesh Display Options

The properties of all 3D Mesh data that GMS displays on the screen can be controlled through the 3D Mesh tab of
the Display Options dialog. This dialog is opened by right-clicking on the  3D Mesh Data entry in the Project
Explorer and selecting the Display Options command. It can also be accessed from the from the Display menu or
the  Display Options macro. The following table describes the display options available for the 3D Mesh module.

Display
Option

Description

Nodes The Nodes item is used to display the mesh nodes.

Element
edges

The Elements item is used to display the edges of elements. The elements are drawn using the color of the material associated with
each cell. An option is included to display all of the edges or only the edges on the boundary of each material. Element can also be
temporarily hidden.

The color of the element edges can be adjusted according to the following options:

1. Auto – draws the material color if faces are not displayed. Uses black or white if the faces are displayed.
2. Specified – used the color specified next to the cell edges
3. Material – displays the material color of the cell

Element faces This option fills the elements with the material color.

Texture map
image

The Texture Map Image Item is used to "drape" an image over the top surface of the 3D Mesh.

Mesh shell The Mesh shell item is used to display an edge for each of the edges on the exterior of the set of all elements (visible or invisible)
which corresponds to a discontinuity in the mesh exterior. This display option provides a helpful spatial context when displaying
iso-surfaces or cross sections.

Feature angle The Mesh shell feature angle is used only when the Mesh Shell option is selected. This angle represents a threshold angle at which
an edge of the shell will be displayed. If for example, an angle of 45 degrees is defined, any edge of the mesh which divides two
element faces that are at an angle greater than 45 degrees to each other will not be displayed.

Node
numbers

The Node numbers item is used to display the ID associated with each node next to the node. The numbers are only displayed on
the front-facing faces of exterior elements.

Element
numbers

The Element numbers item is used to display the ID associated with each element at the centroid of the element. The numbers are
only displayed on the front-facing faces of exterior elements.

Scalar values The Scalar Values item is used to display the scalar values of the active dataset for each node next to the node.

Contours Most of the objects supported by GMS can be contoured by turning on the Contour Options in the Display Options dialog. When an
object is contoured, the values associated with the active dataset for the object are used to generate the contours.

Vectors If the Vectors item in the Display Options dialog is selected for an object (TIN, Grid, or Mesh), vector plots can be generated using
the active vector dataset for the object. One vector is placed at each node, cell, or vertex.

Iso-surfaces If the Iso-Surfaces item in the Display Options dialog is selected for an object (3D Grid or 3D Mesh), iso-surfaces will be
generated. An iso-surface is the 3D equivalent of a contour line. While a contour line is a line of constant value extracted from a
surface, an iso-surface is a surface of constant value extracted from a 3D dataset.
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The Display Options dialog showing the 3D Mesh tab.
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3D Mesh Tool Palette

The following tools are contained in the dynamic portion of the Tool Palette when the 3D Mesh Module is active.
Only one tool is active at any given time. The action that takes place when the user clicks in the Graphics Window
depends on the current tool. The following table describes the tools in the 3D Mesh tool palette.

Tool Tool Name Description

Select
Boundary
Nodes

The Select Boundary Nodes tool is similar in function to the Select Nodes tool except that it selects only nodes that are on the
boundary of the mesh. This tool is useful when assigning nodal boundary conditions.

All of the standard multi-selection techniques are available with this tool. In addition, if the Control key is depressed when a
selection is made, all nodes on the same "side" of the mesh as the selected node are automatically selected. This option is
useful when the same boundary condition is to be assigned to all nodes on the selected mesh side. The extent of the selected
"side" is determined by feature breaks on the exterior of the mesh. If the angle between two adjacent element faces on the
mesh is sharp, the common edge of the faces is assumed to be a feature break and is the boundary of a mesh side.

Select
Boundary
Faces

The Select Boundary Faces tool is similar in function to the Select Boundary Nodes tool except that it selects faces of
elements on the boundary of the mesh. This tool is useful when assigning flux type boundary conditions.

All of the standard multi-selection techniques are available with this tool. In addition, if the Control key is depressed when a
selection is made, all element faces on the same "side" of the mesh as the selected face are automatically selected. This
option is useful when the same boundary condition is to be assigned to all faces on the selected mesh side. The extent of the
selected "side" is determined by feature breaks on the exterior of the mesh. If the angle between two adjacent element faces
on the mesh is sharp, the common edge of the faces is assumed to be a feature break and is the boundary of a mesh side.

Select
Material
Zones

The Select Material Zones tool is used to select all elements of the mesh that have the same material type. This tool is useful
for hiding or isolating zones in the mesh corresponding to a material type. When this tool is active, an icon appears on the
mesh display for each of the material types. A material zone is selected by selecting the icon.

Select
Elements

The Select Elements tool is used to select individual elements. Elements are typically selected for hiding, or for changing the
material type associated with the element. Multi-selection can be performed by holding down the Shift key while selecting or
by dragging a rectangle to enclose the elements to be selected. The ID of the selected element is displayed in the Edit
Window. Only visible elements can be selected. Elements which have been hidden cannot be selected. Hidden elements can
be made visible by selecting the Show command in the Display menu. When selecting elements by dragging a box, all
elements that lie within the box are selected. When selecting elements by clicking on individual elements with the cursor,
only elements on the exterior of the visible portion of the mesh are selected. Elements in the interior of the mesh can be
selected individually by first hiding the elements surrounding the elements to be selected. An element can also be selected by
using the Find Element command in the Mesh menu user is prompted for an element ID and the element is selected. Any
previously selected elements are unselected.

Select Nodes The Select Nodes tool is used to select individual nodes for editing. Multi-selection can be performed by holding down the
Shift key while selecting or by dragging a rectangle to enclose the nodes to be selected. The ID of the selected node is
displayed in the Edit Window. The coordinates of the selected node are also displayed in the Edit Window and can be edited
by typing in new coordinates and selecting the TAB or Return key. Nodal coordinates can also be edited by dragging a node
using the Select Nodes tool. When in plan view, nodes can be dragged in the XY plane. In any other view, nodes are
constrained to move along the Z axis when they are being dragged. Since it is possible to accidentally drag points, nodes can
be "locked" to prevent them from being dragged by selecting the Lock All Nodes command from the Mesh menu. The nodes
can be unlocked by selecting Unlock All Nodes from the Mesh menu. A node can also be selected by using the Find Node
command in the Mesh menu. The user is prompted for a node ID and the node is selected. Any previously selected nodes are
unselected.
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Select Node
Strings

The Select Node Strings tool is used to select one or more strings of nodes. Node strings are used for operations such as
adding breaklines to the mesh.

The procedure for selecting node strings is somewhat different than the normal selection procedure. Strings are selected as
follows:

•• Click on the starting node for the string. The node selected will be highlighted in red.

•• Click on any subsequent nodes you would like to add to the string (nodes do not have to be adjacent). The selected nodes
are now connected by a solid red line.

To remove the last node from a string, press the Backspace key. To abort entering a node string, press the ESC key. To end a
node string, press Return or double-click on the last node in the string. Another node string can then be selected.

Select Wells The Select Wells tool is used to select nodes which have a well (point source/sink) type boundary condition assigned to them.
Since wells are often assigned to nodes in the interior of the mesh, it may be difficult to select the node that a well has been
assigned to using the Select Nodes tool due to the large number of nodes in a mesh. This tool makes this type of selection
easier since only well nodes can be selected when the tool is active.

Select Cross
Sections

Once a set of cross sections has been created, they can be selected using the Select Cross Sections tool. Selected cross
sections can be deleted, or they can be made visible or invisible using the Hide and Show commands.

When this tool is active, a cross section icon appears on each cross section. A cross section is selected by selecting the icon.
When a different tool is selected, the icons disappear. When there are several cross sections, it is often easier to differentiate
cross section icons in plan view (assuming the cross sections were created in plan view). As a general rule the icons are
placed in the center of the first line segment used to cut the cross section.

Select
Particle
Starting
Locations

Particle Starting Locations, used in particle tracking, can be selected with the Select Particle Starting Locations tool. Selected
particles can be deleted. Statistical information for the selected particles, such as the path length and time, is displayed in the
status bar.

Create Cross
Section

Cross sections can be created from a 3D mesh using the Make Cross Section tool. Cross sections are formed when the user
enters a polyline. A polyline is entered by clicking on several points and double-clicking on the final point when the line is
finished. The Delete or Backspace key may be used to remove a point from the polyline, and the ESC key can be used to
abort the process. A cross section or fence diagram is then computed by cutting perpendicular to the current viewing
orientation through the currently visible elements of the mesh. While most cross sections are created with the mesh in plan
view, any viewing orientation can be specified.

Once cross sections are created, they can be deleted, hidden, or shown using the Select Cross Sections tool. Datasets are
automatically interpolated from the 3D mesh to the cross sections for generation of contour and color fringe plots.

Define
Tetrahedron

Four tools are provided for interactively creating the four types of elements supported in GMS. While it is not practical to
create an entire mesh with these tools, they are often useful for editing an existing mesh. The following steps are taken to
construct individual elements:

•• Click on the first node. The node will be highlighted in red.

• Click on the remaining nodes, one at a time, in the standard order for the element type.

If the wrong node is selected, hitting the Delete or Backspace key backs the process up by one node. Hitting the ESCAPE
key aborts the entire process.

Define
Pyramid
Element

Define
Wedge
Element

Define
Hexahedron
Element
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Classify Material Zones
The Classify Material Zones dialogs allows the user to assign materials to a grid or mesh. The source of the materials
can be solids or a different grid or mesh.

Select background object
The background object defines the source of the materials to be assigned to the grid or mesh.

Classify algorithm
Two options are available to assign materials to the grid or mesh: Centroid and Predominant material.
When the Centroid method is used, the centroid of the grid cell or mesh element is calculated. Then the location of
the calculated centroid is found in the background object (grid, mesh, or solid) and the material at that location in the
background object is assigned to the grid cell or mesh element. If the calculated centroid is outside of the
background object then the material of the grid cell or mesh element is not changed.
When the Predominant material method is used to assign materials to a grid from a solid the following process
occurs. A vertical ray from the center of the cell is intersected with the Solids. The top and bottom of the grid cell is
then compared with intersected solids to determine the length of each solid within the cell. Then all of the "solid
lengths" with the same material id are combined. The material id with the greatest length in the cell is assigned to the
cell. If more than one material has the same length in the cell then the material with the lowest id is assigned to the
cell.

Material set name
The material set name is used to specify the name of the new material set as it appears in the project explorer.
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Iso Surfaces
Iso-surface rendering is a powerful tool for visualizing 3D datasets. Iso-surfaces can be generated for 3D grids and
3D meshes. An iso-surface is the 3D equivalent of a contour line. While a contour line is a line of constant value
extracted from a surface, an iso-surface is a surface of constant value extracted from a 3D dataset.

Defining Iso-values
Iso-surfaces are computed using the active scalar data set for the grid or mesh. The Iso-surface Options dialog is
accessed through the Iso-surface Options command in the Data menu or through a button in the 3D Grid Display
Options or 3D Mesh Display Options dialogs. The items in the Iso-surface Options dialog are as follows:

Active Dataset

At the top of the dialog the active scalar dataset and active time step is listed. The maximum and minimum dataset
values are also listed.

Iso-Values

In the next section of the dialog the number of iso-surfaces and the iso-values are defined. A maximum of 12
iso-surfaces may be created. The Default button can be used to automatically set up a number of iso-values. For
example, if the number of iso-surfaces is three and the button is selected, three iso-values, equally spaced between
the maximum and minimum dataset values are generated.

Fill Between

The Fill Between boxes to the right of the iso-values are used to generate surfaces on the exterior of the mesh or grid
between two iso-values. For example, in part a of the figure shown below, two iso-surfaces have been generated
using two iso-values. The image shown in part b was computed using the same iso-values and with the Fill Between
box checked similar to figure d below. This causes the region of the mesh or grid boundary between the two
iso-values to be defined as surfaces. The image shown in part c was generated using a single iso-value with the Fill
Between box checked on the line after the iso-value like figure e. This causes the boundary with dataset values
greater than the specified value to be defined as surfaces.
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(d)

(e)

Iso-Surfaces (a) No Fill (b) Fill Between Two Iso-Values (c) Fill Above or Below an Iso-Value (d) Filling between 2
iso-surfaces (e) Filling above an iso-surface.

Transparency

Transparency can be specified for each Iso-surface. Transparency affects the display of iso-surface faces.

Define as Cross-Section
Like contour lines, iso-surfaces are temporary in nature. In other words, if the active dataset is changed, the current
iso-surfaces are deleted and new iso-surfaces are computed using the new dataset values. In some cases, it is useful
to create an iso-surface as a permanent object. This can be accomplished by selecting the Define as cross section
option in the Iso-surface Options dialog. This causes the computed iso-surfaces to be treated as cross sections. As
cross sections, these iso-surfaces can be saved to a file, hidden, or deleted. In addition, if a new dataset is selected,
the iso-surfaces are not deleted. In fact, the values associated with the new dataset are interpolated to the cross
section iso-surfaces and can be displayed on the iso-surfaces as color fringes or contours. This makes it possible to
effectively display two datasets at once.

Interior Edge Removal
By default, whenever an iso-surface is computed from a mesh or a grid, the lines corresponding to the intersection of
the iso-surface with the cell or element boundaries are displayed on the iso-surfaces. If the Interior edge removal
option is selected, only the edges on the iso-surface corresponding to a feature angle break greater than the specified
value are displayed on the iso-surface. For example, if the feature angle were set at 30.00 degrees, the angle formed
by the two polygonal faces adjacent to each edge in the iso-surface would be checked and only those edges where the
computed angle is less than 180 - 30 = 150 degrees would be displayed. Typically, a small value (e.g., 0.001) is used
so that only the edges adjacent to two coplanar faces are removed (made invisible).
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Visible Region Only Option
If the Compute for visible region only option is chosen, the iso-surfaces are not computed in regions where the cells
or elements are not visible. Otherwise, iso-surfaces are computed for all regions of the mesh or grid.

Iso-Surface Edges
If this option is on, the lines that make up the iso-surface are displayed.

Iso-Surface Faces
If this option is on, the iso-surface is displayed a color-filled surface.

Specify Range
The specified range command allows the user to control the minimum and maximum value used to define the colors
assigned to the iso-surfaces.

Isosurface Volumes
The volume within an iso-surface or the volume between two iso-surfaces is computed using the Iso-Surface
Volume command in the Data menu. This command brings up a dialog with a list of iso-values and volumes. The
listed iso-values correspond to the iso-values defined in the Iso-Surface Options dialog. The listed volumes represent
the volumes between each of the iso-values. For example, the first volume represents the volume below (on the
"low" side of) the lowest iso-value, the second volume represents the volume between the first and second
iso-values, etc. The total volume listed at the bottom of the dialog should correspond to the total volume of the grid
or mesh.
Beginning with GMS 7.0 the Isosurface Volumes dialog has changed to display a single volume associated with each
isosurface. In addition to showing a single volume, the user can also view the volume of the cells (or elements) that
are less than the isovalue, the volume of the cells that are greater than the isovalue, and the volume of the cells
intersected by the isosurface by turning on the Display additional volume information toggle. In some cases GMS is
unable to compute the volume of the isosurface. In those cases the user can still have an estimate of the isosurface
volume by looking at the volume of the cells. The volume of the cells should be close to the volume of the isosurface
when the grid (or mesh) is composed of very "small" cells. The difference between the isosurface volume and the
volume of the cells decreases as the size of the cells decreases.
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Converting 3D Meshes to Other Data Types

3D Mesh Nodes can be converted to 3D Scatter Points bye using the following command in the Mesh Menu:

Mesh to 3D Scatter Points
The Mesh → Scatter Points command in the Mesh menu is used to create a new scatter point set using the
nodes in a mesh. A copy is made of each of the datasets associated with the mesh and the datasets are
associated with the new scatter point set.
This command is useful for comparing the solutions from two separate simulations from different meshes. For
example, if two simulations have been performed with slightly different meshes (base vs. plan) it may be
useful to generate iso-surfaces or a fringe plot showing the difference between the solutions. It is possible to
generate a dataset representing the difference between two datasets using the data calculator. However, the two
datasets must be associated with the same mesh before the data calculator can be used. The datasets from one
of the meshes can be transferred to the other mesh as follows:

1.1. Load the first mesh and its dataset into memory.
2. Convert the mesh to a scatter point set using the Mesh → Scatter Points command.
3. Delete the first mesh by selecting the Delete All command from the Edit menu.
4.4. Load the second mesh and its dataset into memory.
5. Switch to the 3D Scatter Point module and select an interpolation scheme using the Interpolation Options

command in the Interpolation menu.
6. Interpolate the dataset to the second mesh by selecting the to 3D Mesh command from the Interpolation menu.

At this point, both datasets will be associated with the second mesh and the Data Calculator can be used to
compute the difference between the two datasets. This same sequence of steps can be used to interpolate a
dataset from a 3D grid to a 3D mesh, or vice versa.

3D Mesh to 2D Mesh
This command creates a 2D mesh from the upward facing elements of the 3D mesh. The materials of the 3D
elements are preserved on the 2D mesh. The datasets associated with the 3D mesh are NOT transferred to the
2D mesh.
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Building the 3D Mesh from the FEMWATER
Conceptual Model
Once the FEMWATER conceptual model is constructed, the next step is to use the conceptual model to build a 3D
finite element mesh. This is accomplished by first building a 2D mesh, then building the 3D mesh by extruding each
of the 2D elements in 3D elements.

Map → 2D Mesh
The first step in building the 3D mesh is to select the Map → 2D Mesh command in the Feature Objects menu. This
command creates a 2D mesh by automatically filling in the interior of the conceptual model with nodes and
elements. The size and spacing of the elements is controlled by the spacing of the vertices on the arcs and by the
refine point attribute assigned to any wells in the interior of the conceptual model.
An example of the Map → 2D Mesh command is shown in the following figure. A sample FEMWATER conceptual
model is shown in part a. The 2D mesh resulting from execution of the Map → 2D Mesh command is shown in part
b.

Converting a FEMWATER Conceptual
Model (a) Conceptual Model (b) 2D
Mesh Created with Map → 2D Mesh
Command (c) 3D Mesh Created by

Extruding 2D Mesh (d) 3D Mesh after
Map → FEMWATER Command.

Creating the 3D Elements
Once the 2D mesh is created, the next step is to create the 3D mesh by extruding each of the 2D elements into a
series of 3D elements. The elevations of the 3D elements can be defined from a set of boreholes, a set of TINs, or a
set of Solids.
For sites with relatively simple stratigraphy, the Regions → 3D Mesh command in the Borehole module can be
used.
For sites with more complex stratigraphy, the Fill Between TINs → 3D Mesh command in the TIN module should
be used.
A mesh can also be created using the Solids → Layered Mesh command in the Solid module.

http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_2D_Mesh
http://www.xmswiki.com/xms/index.php?title=File%3AMeshgenc.gif
http://www.xmswiki.com/xms/index.php?title=GMS:Converting_Borehole_Data
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module%23Building_Solids_and_3D_Meshes_with_TINs
http://www.xmswiki.com/xms/index.php?title=GMS:Solids_to_Layered_Mesh
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3D Mesh Commands
The Mesh menu is available when the 3D Mesh module is active. The menu has one submenu: the Convert To
submenu. The menu contains the following commands:
•• New 3D Mesh

Creates a new, empty 3D mesh.
•• Lock All Nodes

Since it is possible to accidentally drag points, nodes can be "locked" to prevent them from being
dragged or edited by toggling on this command.

•• Find Duplicate Nodes...

Selects nodes that are close to each other within a user specified tolerance.
•• Find Element...

Selects an element given the element ID.
•• Find Node...

Selects a node given the node ID.
•• Tessellate

3D equivalent of Delauney triangulation. Creates a 3D tet mesh from mesh nodes.
•• Renumber

Renumbers mesh nodes eliminating gaps in numbering. Optionally a node string can be created and used
to guide the renumbering.

•• Repack Nodes...
•• Refine Elements...

Subdivides elements into smaller elements.
•• Classify Elements

Element materials are assigned based on the solid the element centroid is within.
•• Iso-surface Options...

Brings up the Iso-surface Options dialog.
•• Iso-surface Volumes...

Brings up the Iso-surface Volumes dialog.
• Convert To >

• Mesh → 3D Scatter Points

A new 3D scatter point set is created from the 3D mesh nodes.
• 3D Mesh → 2D Mesh

Creates a 2D mesh from the upward facing elements of the 3D mesh.
•• New Material Set

Creates a new material set in the project explorer.
•• Export

Exports a 3D mesh to a file (*.3dm, *.fem etc).

http://www.xmswiki.com/xms/index.php?title=GMS:Creating_a_3D_Mesh
http://www.xmswiki.com/xms/index.php?title=GMS:Creating_a_3D_Mesh%23Creating_3D_Meshes_From_Mesh_Nodes
http://www.xmswiki.com/xms/index.php?title=GMS:Editing_a_3D_Mesh
http://www.xmswiki.com/xms/index.php?title=GMS:Editing_a_3D_Mesh%23Refine_Elements
http://www.xmswiki.com/xms/index.php?title=GMS:Creating_a_3D_Mesh
http://www.xmswiki.com/xms/index.php?title=GMS:Converting_3D_Meshes_to_Other_Data_Types
http://www.xmswiki.com/xms/index.php?title=GMS:Converting_3D_Meshes_to_Other_Data_Types
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Related Topics
•• 3D Mesh Module

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Mesh_Module
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5.8. 3D Grid Module

3D Grid Module

The 3D Grid module is used to create 3D Cartesian grids. These grids can be used for interpolation, iso-surface
rendering, cross sections, and finite difference modeling.
Interfaces to the following 3D finite difference models are provided in this module:
•• MODFLOW
•• MODPATH
•• MT3DMS
•• RT3D
•• SEAM3D

Sample MT3D Simulation

http://www.xmswiki.com/xms/index.php?title=GMS:Interpolation
http://www.xmswiki.com/xms/index.php?title=GMS:Iso_Surfaces
http://www.xmswiki.com/xms/index.php?title=GMS:Cross_Sections
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW
http://www.xmswiki.com/xms/index.php?title=GMS:MODPATH
http://www.xmswiki.com/xms/index.php?title=GMS:MT3DMS
http://www.xmswiki.com/xms/index.php?title=GMS:RT3D
http://www.xmswiki.com/xms/index.php?title=GMS:SEAM3D
http://www.xmswiki.com/xms/index.php?title=File%3ASamp_mt3d.gif
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3D Grid Types

Two types of 3D grids are supported in GMS: cell centered and mesh centered. When computations are performed
on a mesh-centered grid, the computation points are the grid nodes or the corners of the grid cells. With a
cell-centered grid, computations are performed at the cell centers.
When a dataset is imported to a cell-centered grid, there is one value in the dataset for each cell. To use contouring
or fringing the values at the cell corners must be known. Therefore, whenever contouring or fringing is performed,
the values at the cell centers are interpolated to the cell corners. Interpolation to cell corners is only done for
visualization. All computations performed using the Data Calculator are performed on the original values at the cell
centers. With mesh-centered grids, all visualization and computations are performed at the cell corners and no
interpolation is necessary.
All of the model interfaces in the 3D Grid module are based on cell-centered grids. Mesh-centered grids are useful
for interpolation and iso-surface visualization since no extra interpolation is necessary.

(a) Cell Centered Grid (b) Mesh Centered Grid

http://www.xmswiki.com/xms/index.php?title=Data_Calculator
http://www.xmswiki.com/xms/index.php?title=File%3AGridType2.gif
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Creating and Editing 3D Grids

Creating 3D Grids
Two techniques are available for creating 3D grids: the Create Grid command in the 3D Grid Module and the Map
→ 3D Grid command in the Map Module. When a 3D Cell Centered Grid is created two different viewing modes are
available.

Create Grid

A new grid can be created by selecting the Create Grid command from the Grid menu. This command brings
up the Create Grid dialog. The options in the dialog are as follows:
Origin, Length, Rotation – By default, the rows and columns of 2D grids are aligned with the x and y axes.
However, grids can be rotated about the z-axis, if desired. Thus, the information needed to determine the
overall size and location of the grid is the xy coordinates of the lower left corner of the grid (the lower left
corner prior to rotation), the length of the grid in the x and y directions, and the rotation angle. The xy
coordinates of the origin are entered in the Origin edit fields, the dimensions are entered in the Length fields,
and the angle of rotation is entered in the field entitled Rotation about Z-axis.
Bias – Several options are available for defining the number and locations of the cell boundaries. A bias can
be defined which controls how the cell size varies from one cell to the next. For example, an X bias of 1.5
causes each cell to be 50% larger than the previous cell when moving in the positive x direction.
Number of Cells – The total number of cells in each direction (number of rows or columns) can be defined by
explicitly entering a number or by entering a base cell size and a limit cell size. The base and limit cell size
options are used when a bias other than 1.0 is specified. The base cell size is the size of the first cell in the
sequence. The cells are then generated by altering the cell size according to the bias until the limit cell size is
reached. The remainder of the cells are constructed using the limit cell size.
Type and Orientation – The controls at the bottom of the Create Grid dialog are used to define the type and
orientation of the grid. The user can specify whether the grid should be a mesh-centered grid or a cell-centered
grid. The orientation of the ij axes with respect to the XY axes can also be specified.

Map → 3D Grid

Once the feature object coverages defining a conceptual model have been completely defined, the conceptual
model is ready to be converted to a numerical model. The first step in this conversion process is to create a
grid using the Map → 3D Grid command. Typically, the Grid Frame command is used prior to this command
to define the location and dimensions of the grid.
When the Map → 3D Grid command is selected, the Create Grid dialog appears. If a grid frame has been
defined, the size and location of the grid frame are used to initialize the fields in the Create Grid dialog. In
most cases, these values will not need to be changed and the user can simply select the OK button to create the
grid. If a grid frame has not been defined, the size and location of the grid are initialized so that the grid just
surrounds the currently defined conceptual model. Once again, in most cases, no changes will need to be made
and the user can typically immediately select the OK button to create the grid.
If one or more refine points are defined in the conceptual model, the number of rows and columns in the grid
will be automatically determined when the grid is created. Thus, these fields cannot be edited by the user and
will be dimmed. If refine points are not defined, the number of rows and columns must be entered.

http://www.xmswiki.com/xms/index.php?title=GMS:2D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Grid_Frame
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When refine points are specified you must enter the Base size, Bias and Max size. The base size is the size you
want the cell to be right at the refine point. The Max size is the largest size that you would like your cells to be
in the entire grid. The bias determines how quickly the cell size will vary as you move away from the refine
point. If you use a bias of 1.1 then the row next to the refine point will be 1.1 times the base size. The next row
will be 1.1 size the previous row.

Editing 3D Grids
Each cell in a 3D grid has attributes associated with it. Each grid cell can be specified as active/inactive and each cell
has a material associated with it. To edit the cell attributes associated with a numerical model see Cell Properties.
Rows, columns, or layers can be added or removed from a 3D grid. A row, column, or layer may be added to the grid
by using one of the following tools found in the 3D Grid Tool Palette:
•  Add i Boundary
•  Add j Boundary
•  Add k Boundary
The boundary of a cell can also be moved to a new location by using the Select Node tool. Existing rows, columns,
or layers can be deleted by using the Merge Selected command in the Grid menu which is used to merge two or
more selected rows, columns, or layers into a single row, column, or layer. Since the dimensions of the grid are
changed, this command causes all datasets to be deleted. However, MODFLOW input parameters are preserved.

3D Grid Display Options

The Display Options dialog showing the 3D Grid dialog.

The properties of all 3D grid data that
GMS displays on the screen can be
controlled through the 3D Grid tab of
the Display Options dialog. This dialog
is opened by right-clicking on the 
3D Grid Data entry in the Project
Explorer and selecting the Display
Options command. It can also be
accessed from the from the Display
menu or the  Display Options
macro. The following table describes
the display options available for the 3D
Grid module.

http://www.xmswiki.com/xms/index.php?title=GMS:Active/Inactive_Cells
http://www.xmswiki.com/xms/index.php?title=GMS:Materials
http://www.xmswiki.com/xms/index.php?title=GMS:Cell_Properties
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=File:Tool_AddIRow.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_AddJRow.GIF
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http://www.xmswiki.com/xms/index.php?title=File:Dispopts.gif
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Display Option Description

Nodes The Nodes item is used to display grid nodes depending on the Grid Type . If the grid is cell-centered, a dot is displayed at the
cell centers. If the grid is mesh-centered, a dot is displayed on the cell corners.

Cell edges The Cell edges item is used to display the edges of grid cells. The cells are either drawn using the default cell color or the color
of the material associated with each cell.

In addition to turning the display of cells on or off, you can temporarily hide grid cells.

The color of the cell edges can be adjusted according to the following options:

1. Auto – draws the material color if faces are not displayed. Uses black or white if the faces are displayed
2. Specified – used the color specified next to the cell edges
3. Material – displays the material color of the cell

Cell faces The Cell faces item causes the faces of the grid cells to be drawn as filled polygons.

Inactive cells The Inactive cells item is used to display cells which are inactive. If this option is turned off, inactive cells are not displayed.
Inactive cells must be displayed before they can be selected.

Named layer
ranges legend

A legend showing the material and named layer ranges can be turned on.

Cell numbers The Cell Numbers item is used to display the ID of each grid cell.

Node numbers The Node Numbers item is used to display the ID of each grid node.

Scalar values The Scalar Values item is used to display the scalar values of the active dataset for each node next to the node.

IJK indices The IJK indices item is used to display the ijk indices of each cell or node.

IJK triad The IJK triad item is used to display a symbol at one of the corners of the grid showing the orientation of the ijk axes.

True layer display With MODFLOW models, a special option called the True Layer mode is available. If this mode is selected, the user provides a
set of top and bottom elevation arrays for each layer. These arrays can be used to display the vertical variations in the
stratigraphy when in one of the side views in orthogonal viewing mode or when in oblique view in general mode.

Layer borders The Grid boundary item is used to display a solid line around the perimeter of the grid layers.

Grid shell The Grid shell item is used to display a solid cube around the extents of the grid. Displaying the boundary is useful when
iso-surfaces are being displayed with the cell edges turned off.

Texture map
image

The Texture Map Image Item is used to "drape" an image over the surface of the 3D Grid.

Synch ortho
levels with all
grids

When using MODFLOW-LGR with parent and child grids, GMS will find and display the appropriate level for all grids when
the level of the active grid changes. Otherwise only the active grid level will change.

Contours Most of the objects supported by GMS can be contoured by turning on the Contour Options in the Display Options dialog.
When an object is contoured, the values associated with the active data set for the object are used to generate the contours.

Specified Dataset Allows the user to display the contours of a second dataset that is specified by the user. All contouring options are the same for
both the specified and active datasets.

Vectors If the Vectors item in the Display Options dialog is selected for an object (TIN, Grid, or Mesh), vector plots can be generated
using the active vector data set for the object. One vector is placed at each node, cell, or vertex.

Iso-surfaces If the Iso-Surfaces item in the Display Options dialog is selected for an object (3D Grid or 3D Mesh), iso-surfaces will be
generated. An iso-surface is the 3D equivalent of a contour line. While a contour line is a line of constant value extracted from
a surface, an iso-surface is a surface of constant value extracted from a 3D dataset.

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module%233D_Grid_Types
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3D Grid Tool Palette
The following tools are contained in the dynamic portion of the Tool Palette when the 3D Grid Module is active.
Only one tool is active at any given time. The action that takes place when the user clicks in the Graphics Window
depends on the current tool. The following table describes the tools in the 3D Grid tool palette.

Tool Tool Name Description

Select Cells The Select Cells tool is used to select individual grid cells. Multi-selection can be performed by holding down the Shift key
while selecting or by dragging a rectangle to enclose the cells to be selected. The ijk indices of the selected cell are displayed
in the Edit Window.

Only visible cells can be selected. Cells which have been hidden cannot be selected. Inactive cells can only be selected when
they are being displayed by turning on the Inactive Cells item in the Display Options dialog.

When selecting cells by dragging a box, all cells that lie within the box are selected. When selecting cells by clicking on
individual cells with the cursor, only cells on the exterior of the visible portion of the grid are selected. Cells in the interior of
the grid can be selected individually by first hiding the layers, rows, or columns adjacent to the cells.

Select Node The Select Node tool is used select nodes and to interactively edit cell boundary coordinates by clicking on the intersection of
two cell boundaries and dragging the boundaries with the mouse button held down. The coordinates of the cell boundary
intersection are displayed in the Edit Window as the boundaries are dragged. The coordinates of a selected boundary
intersection can also be edited by directly entering the coordinates in the Edit Window.

When dragging a boundary intersection, the intersection is moved in the plane of the face where the point was clicked. For
example, when a boundary intersection on the top of the grid is dragged, the intersection is constrained to move in the XY
plane. If a boundary intersection on the side of the mesh perpendicular to the X axis is dragged, the intersection is constrained
to move in the YZ plane.

If the Control key is depressed when dragging a boundary intersection in a view other than plan view, the intersection is
constrained to move in a plane parallel to the viewing plane.

Select
Material
Zones

The Select Material Zones tool is used to select all cells of the grid that have the same material type. This tool is useful for
hiding or isolating zones in the grid corresponding to a material type. When this tool is active, an icon appears on the grid
display for each of the material types. A material zone is selected by selecting the icon.

Select i The Select i tool is used to select an entire "row" (set of cells with the same i index) of cells at once. Multi-selection can be
performed by holding down the Shift key while selecting. The i index of the selected row is displayed in the Edit Window.

Select j The Select j tool is used to select an entire "column" (set of cells with the same j index) of cells at once. Multi-selection can be
performed by holding down the Shift key while selecting. The j index of the selected column is displayed in the Edit Window.

Select k The Select k tool is used to select an entire "layer" (set of cells with the same k index) of cells at once. Multi-selection can be
performed by holding down the Shift key while selecting. The k index of the selected layer is displayed in the Edit Window.

Select Cross
Sections

Once a set of cross sections has been created, each cross section can be selected using the Select Cross Sections tool. Selected
cross sections can be deleted, or they can be made visible or invisible using the Hide and Show commands.

When this tool is active, a cross section icon appears on each cross section. A cross section is selected by selecting the icon.
When a different tool is selected, the icons disappear. When there are several cross sections, it is often easier to differentiate
cross section icons in plan view (assuming the cross sections were created in plan view). As a general rule the icons are placed
in the center of the first line segment used to cut the cross section.

Select
Particle
Starting
Locations

Particle Starting Locations, used in particle tracking (MODPATH), can be selected with the Select Particle Starting Locations
tool. Selected particles can be deleted. Statistical information for the selected particles, such as the path length and time, is
displayed in the status bar.

Add i
Boundary

The Add i Boundary tool is used to insert a new i boundary into the grid. The new boundary is inserted at the cursor location
when the mouse button is clicked. Inserting a new cell boundary changes the dimensions of the grid and all datasets associated
with the grid are deleted. If the control key is held down while executing this command, the row will be evenly divided.

Add j
Boundary

The Add j Boundary tool is used to insert a new j boundary into the grid. The new boundary is inserted at the cursor location
when the mouse button is clicked. Inserting a new cell boundary changes the dimensions of the grid and all datasets associated
with the grid are deleted. If the control key is held down while executing this command, the column will be evenly divided.
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Add k
Boundary

The Add k Boundary tool is used to insert a new k boundary into the grid. The new boundary is inserted at the cursor location
when the mouse button is clicked. Inserting a new cell boundary changes the dimensions of the grid and all datasets associated
with the grid are deleted. If the control key is held down while executing this command, the layer will be evenly divided.

Create Cross
Section

The Create Cross Section tool is used to create cross sections in a 3D. Cross sections are formed when the user enters a
polyline. A polyline is entered by clicking on several points and double-clicking on the final point when the line is finished.
The Delete or Backspace key may be used to remove a point from the polyline, and the ESC key can be used to abort the
process. A cross section or fence diagram is then computed by cutting perpendicular to the current viewing orientation
through the currently visible cells of the grid. While most cross sections are created with the grid in plan view, any viewing
orientation can be specified. Datasets are automatically interpolated from the 3D grid to the cross sections for generation of
contour and color fringe plots.

Classify Material Zones
The Classify Material Zones dialogs allows the user to assign materials to a grid or mesh. The source of the materials
can be solids or a different grid or mesh.

Select background object
The background object defines the source of the materials to be assigned to the grid or mesh.

Classify algorithm
Two options are available to assign materials to the grid or mesh: Centroid and Predominant material.
When the Centroid method is used, the centroid of the grid cell or mesh element is calculated. Then the location of
the calculated centroid is found in the background object (grid, mesh, or solid) and the material at that location in the
background object is assigned to the grid cell or mesh element. If the calculated centroid is outside of the
background object then the material of the grid cell or mesh element is not changed.
When the Predominant material method is used to assign materials to a grid from a solid the following process
occurs. A vertical ray from the center of the cell is intersected with the Solids. The top and bottom of the grid cell is
then compared with intersected solids to determine the length of each solid within the cell. Then all of the "solid
lengths" with the same material id are combined. The material id with the greatest length in the cell is assigned to the
cell. If more than one material has the same length in the cell then the material with the lowest id is assigned to the
cell.

Material set name
The material set name is used to specify the name of the new material set as it appears in the project explorer.

http://www.xmswiki.com/xms/index.php?title=File:Tool_AddKRow.GIF
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3D Grid Viewing Modes

When a 3D cell-centered grid is in memory, two viewing modes are available: General Mode and Orthogonal Mode.
The general mode is the default mode and it is the mode used when a cell-centered 3D grid is not in memory. In
general mode you can view the grid from top, front, or side view or from any oblique view. With the orthogonal
view, the viewing direction are restricted to three views: looking down one of the i, j, or k axes. As you look down
an axis, you view one row, column, or layer at a time. Oblique views and shading are not available in the orthogonal
mode. The default viewing mode for cell-centered 3D grids is the orthogonal mode. Thus, whenever a new
cell-centered grid is created or read from a file, GMS automatically goes into the orthogonal viewing mode
There are two main advantages of the orthogonal mode:
•• It is a convenient way to view and manipulate layered models such as MODFLOW.
•• Since you only view one row, column, or layer at a time, there are fewer things to display. Thus, redrawing a grid

is much faster.

Switching Modes
A command is provided in the View menu for switching between the orthogonal and general viewing modes. If the
current mode is orthogonal, the menu command is titled Ortho Mode will be selected. If the current mode is general,
the command is titled General Mode will be selected. There is also a toolbar Macro that can be used to switch the
mode .

Mini-Grid Plot
When in the orthogonal mode, the Mini-Grid Plot is activated in the Tool Palette. The plot shows which row,
column, or layer is currently being displayed. The edit field and arrows just beneath the plot can be used to change
the current row, column, or layer. To change the view, select one of the View Along I Axis, View Along J Axis, or
View Along K Axis macros at the bottom of the Tool Palette.

True Layer Mode
With MODFLOW models, a special option called the True Layer mode is available. If this mode is selected, the user
provides a set of top and bottom elevation arrays for each layer. These arrays can be used to display the vertical
variations in the stratigraphy when in one of the side views in orthogonal viewing mode or when in oblique view in
general mode.

http://www.xmswiki.com/xms/index.php?title=GMS:Tool_Palettes
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Converting 3D Grids to Other Data Types

3D Grid data can be converted to other types of data in GMS such as 2D grids, 2D scatter points, 3D Meshes, or 3D
scatter points. 3D Grid data is converted using the following commands in the Grid menu:

Grid → 3D Scatter Points
The Grid → Scatter Points command in the Grid menu in the 3D Grid Module is used to create a new scatter point
set using the nodes or cells of a 3D grid. A copy is made of each of the datasets associated with the grid and the
datasets are associated with the new scatter point set.

Grid → 3D Mesh
A new 3D finite element mesh can be created from a 3D grid by selecting the Grid → Mesh command from the Grid
menu in the 3D Grid menu. An eight node quadrilateral element is created from each cell in the grid.

Grid → 2D Grid
A new 2D grid can be created from a 3D grid by selecting the Grid → 2D Grid command from the Grid menu in the
3D Grid module. This creates a 2D grid which matches the 3D grid, i.e., one cell is created in the 2D grid for each
vertical (ij) column in the 3D grid. This command is typically used in conjunction with the 3D Data → 2D Data
command.

MODFLOW Layers → 2D Scatter Points
The MODFLOW Layers → 2D Scatter Points command in the Grid menu of the 3D Grid module is used for
regional to local model conversion. It is only available if the true layer mode is being used with a MODFLOW
model. When this command is selected, a new 2D scatter point set is created and a scatter point is created at the
centroid of each vertical column of cells in the 3D grid. A dataset is then created on the scatter point set for the top
and bottom elevations of each layer and for the computed head values (if a MODFLOW solution is in memory). The
MODFLOW head data set is chosen in the following way: If a modflow head data set is the active dataset then GMS
uses that dataset for the starting heads. If the active dataset is in a modflow solution but is not a head data set then
GMS tries to use the head dataset in the active solution. If neither of the first 2 cases works then GMS just goes
through the list of datasets and uses the last modflow head dataset that it finds (most likely the last solution that was
read in). At a later point in time, these data sets can be interpolated from the scatter points to the cell centers of a
smaller, local grid.
This dialog allows the user to create a scatter point set and data sets of the current MODFLOW simulation.
The user can limit the number of scatter points created by turning on the Only create scatter points within selected
coverage option and selecting the appropriate coverage. This is often used when converting between a regional
model and a local scale model.
•• Layer Subdivision

The layers of the current MODFLOW simulation can be subdivided by specifying the Number of local model
layers for each layer in the current 3D grid.
The user can select which MODFLOW datasets to create by turning off/on the toggles below the Create
datasets of text. Datasets for layer elevations, flow package data (HK, HANI, VK, SY, SS...), Recharge, and
Heads can be created. The user must select a 3D grid dataset in order to create a dataset for the Heads (most
often this will be the MODFLOW solution from the regional model).
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The Recharge and Head datasets can be transient if the regional model was transient. The user can also
select a Start and End time to limit the number of time steps for these datasets.

•• Bias Layer 1
An option to bias the thickness of the new layer 1 is also available. This can be useful if equally subdividing
layer 1 of the regional model would result in cells where the elevation would be above the computed heads.
Thus, the user can choose to bias the thickness of the new layer 1 to ensure that the top layer in the new model
will not be dry.

3D Data → 2D Data
The 3D Data → 2D Data command in the Data menu of the 3D Grid module is used to create datasets on a 2D grid
created using the Grid to 2D Grid command. These two commands are useful for creating a 2D representation of a
3D dataset for contouring.
The 3D Data → 2D Data command brings up the 3D Dataset → 2D Dataset dialog. The button at the top of the
dialog is used to select which 3D dataset is to be converted to a 2D dataset. The drop down box lists each of the
options available for converting each column of 3D data values to a single 2D data value. The figure below shows an
example of using the 3D Data → 2D Data command.

Watertable Elevations From a MODFLOW
Simulation

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module%23Converting_3D_Grids_to_Other_Data_Types
http://www.xmswiki.com/xms/index.php?title=File%3ASample_water_table.GIF
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Exporting Grids
2D and 3D grids can be exported from GMS in various formats by right-clicking on the grid in the Project Explorer
and selecting the Export command. The options available include:

Exporting 2D grids
1.1. Text GMS 2D Grid File (*.2dg)

This is an older GMS grid file format that is described in this document [1].
2.2. ARC/INFO Ascii Grid File (*.asc)

This is a raster format that can be opened in ArcMap. Because it's a raster, you can only use this option with
cell-centered grids where all cells are the same size.

Exporting 3D grids
1.1. Text GMS 3D Grid File (*.3dg)

This is an older GMS grid file format that is described in this document [1].
2.2. Shapefile

An ESRI ArcGIS compatible shapefile will be exported containing 2D polygons for all 3D grid cells in all grid
layers. The attribute table fields include:
•• cell ID
•• cell I
•• cell J
•• cell K
•• grid cell activity
•• scalar dataset values (you get to chose which datasets to save)
•• dataset activity (if it exists)
A simple definition query using the grid cell activity and K fields can be created in ArcMap to see one layer of
the grid at a time.

http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://gmsdocs.aquaveo.com.s3.amazonaws.com/fform30.pdf
http://gmsdocs.aquaveo.com.s3.amazonaws.com/fform30.pdf
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Cell Properties
The cell properties dialog allows the user to edit cell properties. Most cell properties are associated with a model
such as MODFLOW or MT3D. If no models exist in the GMS project then the cell properties dialog will only allow
editing of the material assigned to the grid cell.

MODFLOW
Several input arrays defining parameters such as starting head, IBOUND, hydraulic conductivity, and transmissivity
are defined in the Global/Basic and BCF, LPF, or HUF packages. These arrays can be edited in the Basic and
BCF/LPF/HUF Package dialogs, or they can be initialized using a conceptual model in the Map module. In many
cases however, it is necessary to view or edit the values on a cell-by-cell basis. This can be accomplished using the
Cell Properties command in the MODFLOW menu.
Before selecting the Cell Properties command, a set of cells should be selected using the cell selection tools. Once
the command is selected, the MODFLOW Cell Attributes dialog appears.
The parameters for the selected cells are changed by typing in new values in the edit fields. If more than one cell is
selected when the Cell Properties command is selected, the available edit fields will be left blank (unless all values
are the same for that parameter). To edit one of the parameters, click on the desired text edit field, enter the new
value and click on the OK button. When the OK button is selected, only the parameters whose edit fields that have
data are changed. This makes it possible to change one of the available parameters (e.g., transmissivity) for all of the
selected cells while leaving the other parameters unchanged.
NOTE: When you are using materials to define the MODFLOW model, the Cell Properties dialog will show the
material properties relating to the material of the selected cell. You will not be able to edit these values on a
cell-by-cell basis, but you can either edit the material type for this cell if the active material set is the default material
set, or you can change the material properties for the material (which affects every cell that uses that material).

http://www.xmswiki.com/xms/index.php?title=GMS:IBOUND
http://www.xmswiki.com/xms/index.php?title=GMS:Global_Options/Basic_Package
http://www.xmswiki.com/xms/index.php?title=GMS:BCF_Package
http://www.xmswiki.com/xms/index.php?title=GMS:LPF_Package
http://www.xmswiki.com/xms/index.php?title=GMS:HUF_Package
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW_Conceptual_Model_Approach
http://www.xmswiki.com/xms/index.php?title=GMS:Map_Module
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW
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MT3DMS/RT3D/SEAM3D
MT3D inputs that vary on a cell by cell basis can also be editing using this dialog and editing the data in the MT3D
tab.

3D Grid Cell Properties dialog showing the MODFLOW tab.

http://www.xmswiki.com/xms/index.php?title=File%3A3DGridCellProp.jpg
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Active/Inactive Cells
Each of the cells in a cell-centered grid can be active or inactive. An inactive cell is a cell that is not part of the
computational domain. An inactive cell is ignored when contours or vectors are displayed on the grid. Several
methods are available for changing the active/inactive status of cells.
•• IBOUND/ICBUND Arrays

The active/inactive status of cells can also be controlled with model parameters. For example, MODFLOW
uses an array of values known as the IBOUND array, to indicate what is active and what is inactive. If dataset
flags are not currently present in the active dataset, and a MODFLOW simulation is currently in memory, the
active/inactive status of cells will be determined by the IBOUND array. The ICBUND array in MT3DMS also
has an effect on the active/inactive flags.

•• Activate Polygon Region
Active/inactive status of cells can be set using the Activate Cells in Coverage command in the Map module.
This command checks each cell in the grid to see if it is within the polygons defined in the
MODFLOW/MT3DMS local Source/sink type coverage. All cells within the coverage are made active and all
cells outside the coverage are made inactive. This command just modifies the IBOUND array in MODFLOW.
If there is no MODFLOW model in memory, the command can hide the grid cells instead of making them
inactive.

•• Dataset Flags
Often, the status of the cells of a finite difference grid will be determined from the solution to a numerical
analysis. For example, a cell may go dry during a MODFLOW simulation, making the cell inactive. Two types
of solution files supported by GMS may include active/inactive flags: GMS dataset files and MODFLOW
solution files. After importing such a dataset, the active/inactive flags are stored with the datasets (or with the
time steps of a transient dataset). When a dataset is selected as the active dataset, the flags (if they exist) are
checked and any cell which is inactive is ignored when contouring and fringing. Active/inactive flags
associated with datasets take precedence over any other method of specifying active/inactive status. When the
dataset is switched or deleted, the active/inactive flags for the grid revert to their previous values.

•• Active/Inactive Flags Dialog
In some cases, a dataset may not explicitly contain active/inactive flags, but the flags can be inferred from one
or more key values. For example, a value of -999 in a dataset may mean that the cell is dry or inactive. A set of
key values can be defined to set up the active/inactive flags for a dataset using the Active/Inactive Flags
dialog. The Active/Inactive Flags dialog is accessed in the Dataset Info Dialog. The active/inactive status of
the cells is determined from the specified key values in the list. Any number of key values may be specified.

http://www.xmswiki.com/xms/index.php?title=GMS:IBOUND
http://www.xmswiki.com/xms/index.php?title=GMS:ICBUND_Array
http://www.xmswiki.com/xms/index.php?title=GMS:Activate_Cells_in_Coverage
http://www.xmswiki.com/xms/index.php?title=GMS:Map_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Dataset_Files
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Named Layer Ranges

Starting at version 8.0, GMS allows you to create named layer ranges via the Grid|Named Layer Ranges menu
command. A layer range has a name, a material, and a minimum and maximum layer. If named layer ranges are
defined, GMS will create a material set called "Named Layer Ranges" that matches the ranges defined in the dialog
(if the material set already exists it is simply updated). If the Update grid on OK toggle is on, GMS will make the
"Named Layer Ranges" material set the active set. You can turn on a legend showing the named layer ranges.
Named layer ranges can be used in T-PROGS to target a subset of grid layers.

http://www.xmswiki.com/xms/index.php?title=GMS:Materials
http://www.xmswiki.com/xms/index.php?title=GMS:Material_Set
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Display_Options
http://www.xmswiki.com/xms/index.php?title=GMS:T-PROGS
http://www.xmswiki.com/xms/index.php?title=File%3ANamed_layer_ranges.png
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Redistribute Grid Cells

The number of 3D grid rows, columns or layers can be changed via the Redistribute Grid Cells dialog. This dialog is
accessed by selecting rows, columns or layers using the Select i, Select j or Select k tools, right-clicking and clicking
the Redistribute menu command. The Redistribute Grid Cells dialog indicates the number of ranks (rows, columns
or layers) that are selected and allows you to enter a new number. Entering a new number will cause GMS to
increase or decrease the number of ranks. The new ranks are distributed evenly in the selected area and any model
boundary conditions are positioned as close to their old locations as possible.
Other ways to alter grid rows, columns and layers:
• Grid ranks can be inserted manually using the Add i Boundary, Add j Boundary and Add k Boundary tools.
• Grid ranks can be merged manually using the Select i, Select j or Select k tools, right-clicking and selecting the

Merge command.
• Redistribute Layers menu command.

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:Redistribute_Layers
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Redistribute Layers

One way to alter 3D grid layer thicknesses is via the Redistribute Layers dialog accessed via the Grid | Redistribute
Layers menu command. This dialog allows you to specify a constant elevation for the top and bottom of the grid and
edit the relative thicknesses of the grid layers.
Other ways to alter grid layer thicknesses:
• dragging with the Select Node tool
• Redistribute Grid Cells popup menu command.

The Redistribute Layers dialog

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:Redistribute_Grid_Cells
http://www.xmswiki.com/xms/index.php?title=File%3ARedistributeLayers.jpg
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3D Grid Commands
The Grid menu becomes available when the 3D Grid module is active. The menu has one submenu; the Convert To
submenu. Below is a list of commands available in the Grid menu.
•• Create Grid...

Brings up the Create Finite Difference Grid dialog.
•• Merge Cells

This command will combine selected cells.
•• Redistribute Layers...
•• Named Layer Ranges...

Brings up the dialog better organize materials in multiple layers.
•• Find Cell...

User may find a cell based on "Cell ID" or "IJK" coordinates.
•• Find Node...

User may find a node based on "Cell ID" or "IJK" coordinates.
•• Iso-surface Options...

Brings up the Iso-surface Options dialog.
•• Iso-surface Volumes...

Brings up the Iso-surface Volumes dialog.
• Convert To >

• Grid → 3D Scatter Points

Creates a scatter point set with a point on the center of each cell with the value of the cell.
• Grid → 3D Mesh

Creates a mesh typically from the cell centered values in the grid for the different layers. The first dialog
allows the user to choose between the cell centers or the cell corners to create the mesh. A disclaimer is
given that data values are given at the cell center and that data sets will not be converted.

• Grid → 2D Grid

Creates a flat grid from the 3D grid dimensions at an elevation given by the user.
• MODFLOW Layers → 2D Scatter Points...

Converts all MODFLOW Layers that have values into scatter point sets.
• Layer Contours → Arcs

Converts layer contours into arcs that can be manipulated as drawing objects.
• 3D data → 2D data

Converts the 3D data to 2D data according to a user defined option (average, highest active value,
maximum, minimum, sum, and value from k-layer) to get a single value from the multiple layers.

•• New Material Set

Creates a new material set in the project explorer.
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Related Topics
•• 3D Grid Module

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
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5.9. 3D Scatter Point Module

3D Scatter Point Module

The 3D Scatter Point module is used to interpolate from groups of 3D scatter points to meshes, grids, or TINs.
Several interpolation schemes are supported including kriging.
Interpolation is useful for setting up input data for analysis codes and it is also useful for site characterization.

Interpolation of TCE Data to a 3D Grid

http://www.xmswiki.com/xms/index.php?title=GMS:Kriging
http://www.xmswiki.com/xms/index.php?title=GMS:Interpolation
http://www.xmswiki.com/xms/index.php?title=File%3ASample_Interp.gif
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3D Scatter Point Display Options

The properties of all 3D scatter data that GMS displays on the screen can be controlled through the 3D Scatter tab of
the Display Options dialog. This dialog is opened by right-clicking on the  3D Scatter Data entry in the Project
Explorer and selecting the Display Options command. It can also be accessed from the from the Display menu or
the  Display Options macro. The following table describes the display options available for the 3D Scatter Point
module.

Display
Option

Description

Active scatter
point set

The name of the active scatter point set is listed at the top of the dialog. The symbol selected using the Scatter point symbols
option (described below) applies to the active scatter point set. This makes it possible to use a different set of symbols for the
points in each set so that the sets are easily distinguishable.

Scatter point
symbols

The Scatter point symbols item is used to display a symbol at the location of each scatter point. The widget to the left of the toggle
is used to bring up a dialog listing the available symbols. The color of each of the scatter points in a set may be changed in this
dialog also.

The color of the scatter points can be adjusted according to the following options:

1. Specified – used the color specified next to the scatter point symbols
2. Data – the color ramp is used to assign a color to each of the symbols according to the value of the active scalar dataset

Inactive scatter
points

Individual scatter points can either be active or inactive. The Inactive scatter points option is used to show inactive scatter points
and to set their color.

Scatter point
scalar values

The Scatter point scalar values option is used to display the value of the active dataset next to each of the scatter points.

Scatter point
labels

The Scatter point labels item is used to display the scatter point label next to each scatter point.

Scatter point
numbers

The Scatter point IDs item is used to display the scatter point ID next to each scatter point.

Symbol legend The Symbol legend item is used to display a symbol legend listing each of the scatter point sets by name and showing the symbol
associated with the scatter point sets.

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Scatter_Point_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Display_Options
http://www.xmswiki.com/xms/index.php?title=File:3DScatterFolder.GIF
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=File:Dispopts.gif
http://www.xmswiki.com/xms/index.php?title=GMS:Active/Inactive_Points
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The Display Options dialog showing the 3D Scatter Point Set tab.

http://www.xmswiki.com/xms/index.php?title=File%3ADisplay3DScatter.jpg
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3D Scatter Point Tool Palette

The following tools are active in the dynamic portion of the Tool Palette whenever the 3D Scatter Point Module is
active. Only one tool is active at any given time. The action that takes place when the user clicks in the Graphics
Window with the cursor depends on the current tool. The table below describes the tools in the 3D Scatter Set tool
palette.

Tool Tool
Name

Description

Select
Scatter
Point

The Select Scatter Point tool is used to select individual scatter points for editing using the Edit Window. Scatter points can also
be dragged with the mouse. Scatter points can be deleted. With extremely large sets of scatter points, it may become difficult to
identify a scatter point with a particular ID, even if the scatter point IDs are being displayed. In such cases, the Find Point
command in the Scatter Points menu can be used to quickly locate a point. The command prompts the user for the ID of the
desired point and the point is selected.

Select
Scatter
Point Set

The Select Scatter Point Set tool is used to select entire scatter point sets for deletion or to designate the active scatter point set.
When this tool is active, an icon appears at the centroid of the set for each of the scatter point sets. A scatter point set is selected
by selecting the icon for the set.

Create
Scatter
Point

This tool is used to interactively create scatter points by clicking in the GMS graphics window.

http://www.xmswiki.com/xms/index.php?title=GMS:Tool_Palettes
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Scatter_Point_Module
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectVertices.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectScatterSet.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_CreateVertices.GIF
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Interpolating with 3D Scatter Points

Scatter point sets are used for interpolation to other data types such as TINs, grids, and meshes. A 3D grid can be
created which will just enclose the scatter points by using the Bounding Grid command in the Scatter Points menu.
Interpolation is useful for such tasks as contouring or setting up input data to a model. Since no interpolation scheme
is superior in all cases, several interpolation techniques are provided in GMS.
The basic approach to performing an interpolation is to select an appropriate interpolation scheme and interpolation
parameters, and then interpolate to the desired object using one of the 3D Interpolation Commands.
The interpolation options are selected using the Interpolation Options dialog accessed through the Interp. Options
command in the Interpolation menu. Once a set of options is selected, those options are used for all subsequent
interpolation commands. Interpolation options are saved in the project file.

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Scatter_Point_Module%23Bounding_Grid
http://www.xmswiki.com/xms/index.php?title=GMS:Interpolation
http://www.xmswiki.com/xms/index.php?title=GMS:Interpolation_Commands
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Interpolation_Options
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Converting 3D Scatter Points to Other Data
Types

3D Scatter Points may be converted to 3D Mesh Nodes or Observation Points by using the following commands
available either in the Scatter Points menu or by right clicking on a scatter set in the Project Explorer:

Scatter Points → Mesh Nodes
The Scatter Points → Mesh Nodes command is used to convert each of the scatter points to a 3D mesh node. The
nodes can then be used to generate a mesh using the Tessellate command in the Mesh menu. The Mesh menu can be
made visible by selecting the 3D Mesh module.

Scatter Points → Obs. Pts.
The Scatter Points → Obs. Pts. command in the Scatter Points menu of the 3D Scatter Point module creates a new
observation coverage with one observation point for each of the 3D scatter points in the active scatter point set. The
measured values for the new observation points are taken from the scatter set's active dataset values.

MODPATH Starting Locations
The Convert To → MODPATH Starting Locations command creates MODPATH starting locations from the 3D
scatter sets selected in the Project Explorer. A new particle set is created for each 3D scatter point set. This command
is available by right-clicking on a 3D scatter set in the Project Explorer. MODPATH starting locations can also be
converted to 3D scatter points via the MODPATH menu.

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Observations
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:MODPATH
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:Exporting_Pathlines%23Starting_Locations_-%3E_3D_Scatter_Points
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Bounding Grid

In many cases, it is useful to interpolate to a 3D grid which just contains the points from a 3D scatter set. The
Bounding Grid command was designed in order to simplify the creation of such a grid. Selecting the Bounding Grid
command from the Scatter Points menu brings up the Create Grid dialog pre-filled with grid dimensions set at 10%
beyond the bounds of the active scatter point set.

3D Scatter Point Commands
The Scatter Points menu become available when the 3D Scatter Point module is active. The menu has one submenu;
the Interpolation submenu. The menu has the following commands:
•• New Scatter Point Set

Creates a new dataset.
•• Lock All Scatter Points

Prevents adjusting the location of scatter points.
•• Scatter Point Settings...

Opens the Scatter sets tab under the Preferences dialog.
•• Find Point...

User may find a point based on ID number or text label.
• Interpolation >

•• Interpolation Options...

Sets the interpolation options used when interpolating to other objects. The interpolation options are
saved with the project.

• Interpolate → Active TIN

Interpolate the active dataset on the active scatter set to the active TIN.
• Interpolate → 2D Mesh

Interpolate the active dataset on the active scatter set to the 2D mesh.
• Interpolate → 2D Grid

Interpolate the active dataset on the active scatter set to the 2D grid.
• Interpolate → 3D Mesh

Interpolate the active dataset on the active scatter set to the 3D mesh.
• Interpolate → 3D Grid

Interpolate the active dataset on the active scatter set to the 3D grid.
• Interpolate → UGrid

Interpolate the active dataset on the active scatter set to the active UGrid.
•• Gaussian Simulation Options...
•• Run Gaussian Simulation
•• Jackknifing...
•• Summary...

http://www.xmswiki.com/xms/index.php?title=GMS:Interpolation_Commands
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Brings up the Jacknifing Summary dialog.
•• Bounding 2D Grid...

Creates a 2D Grid that bounds or contains all of the scatter points in the active set.
•• Bounding 3D Grid...

Creates a 3D Grid that bounds or contains all of the scatter points in the active set.
• Scatter Points → Mesh Nodes

Creates nodes from the scatter points for a 2D mesh.
• Scatter Points → Obs. Pts.

Creates Observation Points from the active dataset. A coverage that is set for observation data must
already exist.

•• Merge Scatter Point Sets

Creates a merged scatter set from two or more scatter sets selected with the Select Scatter Sets tool.

Related Topics
•• 3D Scatter Point Module

http://www.xmswiki.com/xms/index.php?title=GMS:3D_Scatter_Point_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Scatter_Point_Module
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5.10. Map Module

Map Module

The Map module provides a suite of tools for using Feature Objects to build conceptual models.
Feature objects are used to provide some GIS-like capabilities within GMS. Feature objects include points, arcs, and
polygons. Feature objects can be grouped into layers or coverages. A set of coverages can be constructed
representing a conceptual model of a groundwater modeling problem. This high level representation can be used to
automatically generate MODFLOW and MT3DMS numerical models. Feature objects can also be used for
automated mesh generation.

http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects
http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects%23Conceptual_Models
http://www.xmswiki.com/xms/index.php?title=File%3AEasttex.jpg


Feature Objects 182

Feature Objects

WARNING: Article could not be rendered - ouputting plain text.
Potential causes of the problem are: (a) a bug in the pdf-writer software (b) problematic Mediawiki markup (c) table
is too wide

Feature objects in GMS have been patterned after Geographic Information Systems (GIS) objects and include points,
nodes, arcs, and polygons. Feature objects can be grouped together into coverages, each coverage defining a
particular set of information. Since feature objects are patterned after GIS objects, it is possible to import and export
feature objects to a GIS such as Arc/Info or ArcView. The primary use of feature objects is to generate a high level
conceptual model representation of a site. In such a model, items such as rivers, drains, wells, lakes are represented
with points, arcs, and polygons. Attributes such as conductance, pumping rates, and elevations are defined with the
objects. This conceptual model is then used to automatically generate a grid or mesh and assign the boundary
conditions and model parameters to the appropriate cells. Thus, the user can focus on a simplified, high level
representation of the model and little or no tedious cell-by-cell editing is required. The feature object approach can
be used to build models for SEEP2D, FEMWATER, MODFLOW, MT3DMS, RT3D, and SEAM3D. Feature objects
are also used to construct cross sections. Object Types The definition of feature objects in GMS follows the
paradigm used by typical GIS software that supports vector data. The basic object types are points, nodes, vertices,
arcs, arc groups, and polygons. The relationship between these objects is illustrated in the following figure. Feature
Object Types.Points Points are XY locations that are not attached to an arc. Points have unique IDs and can be
assigned attributes. Points are often used to represent wells. Points are also used when importing a set of XY
locations for the purpose of creating arcs or polygons. Arcs Arcs are sequences of line segments or edges which are
grouped together as a single "polyline" entity. Arcs have unique IDs and can be assigned attributes. Arcs are grouped
together to form polygons or are used independently to represent linear features such as rivers. The two end points of
an arc are called "nodes" and the intermediate points are called "vertices". Create Arc GroupThis command is used to
create an arc group from a set of selected arcs. Once the arc group is created, it can be selected using the Select Arc
Group tool. Properties can be assigned to the arc group as a whole, and the arc group can be selected to display the
computed flow through the arc group. An arc group is deleted by selecting the arc group and selecting the Delete
key. Deleting an arc group does not delete the underlying arcs.Reverse Arc DirectionEach arc has a direction. One
node is the "from" node, the other node is the "to" node. For most applications, the direction of the arc does not
matter. However, when the arc is used to define a MODFLOW stream network, the direction of the arc becomes
significant. The Reverse Arc Direction command can be used to change the direction (upstream to downstream) for a
stream type arc.Nodes Nodes define the beginning and ending XY locations of an arc. Nodes have unique IDs and
can be assigned attributes. Vertices Vertices are XY locations along arcs in between the beginning and ending nodes.
They are used solely to define the geometry of the arcs. Vertices do not have IDs or attributes. Redistribute
VerticesThe primary function of the vertices of an arc is to define the geometry of the arc. In most cases, the spacing
of the vertices does not matter. However, if the arcs are to be used for automatic mesh generation, the spacing of the
vertices is important. In this case, the spacing of the vertices defines the density of the elements in the resulting
mesh. Each edge defined by a pair of vertices becomes the edge of an element. The mesh gradation is controlled by
defining closely spaced vertices in regions where the mesh is to be dense and widely spaced vertices in regions
where the mesh is to be coarse. When spacing vertices along arcs, the Redistribute vertices command in the Feature
Objects menu can be used to automatically create a new set of vertices along a selected set of arcs at either a higher
or lower density. The desired arc should be selected prior to selecting the Redistribute vertices command. The
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Redistribute vertices command brings up the Redistribute Vertices dialog. The following options are available for
redistributing vertices:Linear Interpolation – If the Linear interpolation option is specified, then either a number of
subdivisions or a target spacing can be given to determine how points are redistributed along the selected arcs. In
either case, the new vertices are positioned along a linear interpolation of the original arc.Spline Interpolation – If the
Spline interpolation option is specified, vertices are redistributed along a series of cubic splines defined by the
original vertices of the selected arcs. The difference between the linear and spline interpolation methods is illustrated
below:Redistributing Vertices. (a) Original Arc (b) Linear Interpolation (c) Spline Interpolation.Vertex to NodeIn
some cases, it is necessary to split an arc into two arcs. This can be accomplished using the Vertex ↔ Node
command. Before selecting this command, a vertex on the arc at the location where the arc is to be split should be
selected. The selected vertex is converted to a node and the arc is split in two.The Vertex ↔ Node command can also
be used to combine two adjacent arcs into a single arc. This is accomplished by converting the node joining the two
arcs into a vertex. Two arcs can only be merged if no other arcs are connected to the node separating the arcs.
Otherwise, the node must be preserved to define the junction between the branching arcs.Arc Groups An arc group is
a set of arcs that has been marked as a group by the user. As an arc group, attributes can be assigned to the entire
group rather than to individual arcs. An arc group can also be selected as a single unit. Arc groups are primarily used
for flow observations. Polygons Polygons are a group of connected arcs that form a closed loop. A polygon can
consist of a single arc or multiple arcs. If two polygons are adjacent, the arc(s) forming the boundary between the
polygons is shared (not duplicated). Polygons may not overlap. However, a polygon can have a hole defined by
having a set of closed arcs defining interior polygons. An example of such a case is shown in the figure below where
three arcs are used to define two polygons. Polygon A is made up of arcs 1, 2, 3 and 4, whereas polygon B is defined
by a single arc (arc 2). For polygon A arcs 1, 3, and 4 define the exterior boundary whereas arc 2 defines a hole.
Polygons have unique IDs and can be assigned attributes. Polygons are used to represent material zones, lakes,
variable head zones, etc. Polygon With Holes.Build PolygonsWhile most feature objects can be constructed with
tools in the Tool Palette, polygons are constructed with the Build Polygons command. Since polygons are defined by
arcs, the first step in constructing a polygon is to create the arcs forming the boundary of the polygon. Once the arcs
are created, they should be selected with the Select Arc tool, and the Build Polygons command should be selected
from the Feature Objects menu. If the selected arcs do not form a valid loop, an error message is given.The Build
Polygons command can be used to construct one polygon at a time or to construct several polygons at once. If the
selected arcs form a single loop, only one polygon is created. If the arcs form multiple loops, a polygon is created for
each unique (non-overlapping) loop. If no arcs are selected, all of the currently defined arcs in the active coverage
are used to create polygons.Coverages Feature objects are grouped together into coverages. Each coverage represents
a particular set of data. For example, one coverage can be used to define recharge zones, and another coverage can
be used to define zones of hydraulic conductivity. Conceptual Models In a generic sense, a conceptual model is a
simplified, high level model of a site. In GMS, a conceptual model object consists of a set of coverages which are
tied to a particular numerical model like MODFLOW or FEMWATER. The coverages below a conceptual model
can have attributes that are related to the numerical model. For example, a coverage below a MODFLOW conceptual
model can have drain or river arcs. Feature Object Properties The Feature Object Properties dialog is used to edit the
properties of Points, Nodes, Arcs, Arc Groups, and Polygons. Three filters are located at the top of the dialog.The
Feature type combo box is used to choose which feature (Point, Arcs...) the spreadsheet displays. The Show combo
box will show only the selected features or all features depending on which option is selected. The BC type combo
box is used to display only certain boundary conditions. For example, if the filter is changed to "well," then only the
wells would be displayed in the spreadsheet. The Show point coordinates toggle is used to display the (x, y, z)
coordinates of each point in the spreadsheet. The Add Point and Delete Point buttons are used to create new points or
remove points from the coverage. The spreadsheet displays an attribute table associated with the current feature type
(Point, Arc...). The columns available in the spreadsheet depend on the options selected in Coverage Setup dialog.
Converting Feature Objects Feature objects can be converted to other data types in GMS such as cross sections and
scatter points. This can be accomplished by either right-clicking on a conceptual model, coverage, grid frame, or by
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selecting a command from the Feature Objects menu. These commands are summarized on the following
pages.GMS:Map to ModulesGMS:Map to Models

Feature Object Commands
The Feature Objects menu becomes available when the Conceptual model, or Map model, is active. The menu has
the following commands:
•• Build Polygons

Creates polygons out of closed arcs.
• Vertices↔Nodes

Switches selected vertices to nodes and vise verse.
• Vertices → Nodes

Switches selected vertices to nodes.
• Nodes → Vertices

Switches selected nodes to vertices.
•• Redistribute Vertices...

Redistributes the amount of vertices on a selected arc using a user input value for spacing.
•• Create Arc Group

Creates the select multiple arcs as one. All arcs are still separate arcs, but one group.
•• Reverse Arc Direction

Arcs have a direction that follows the path that they were made. Direction is important with some
parameters and need to be consistent throughout the model.

•• Clean...

Selecting this command brings up the Clean dialog. See Clean Command for more information.
•• Find Feature Object...

Select a feature object using the object ID.
•• New Grid Frame

Creates a new grid frame object in the project explorer.
•• Activate Cells in Coverage(s)

After creating a coverage that defines the model boundary and creating a grid, just the cells that are in
the active coverage with remain active.

• Arc(s) → Cross Section

Opens the Arcs → Cross Sections dialog. See Arc → Cross Sections for more information.
• Map → TIN

This command creates a TIN using each polygon in the coverage.
• Map → 2D Mesh

This command creates a 2D Mesh on the interior of all of the polygons in the current coverage. See Map
to 2D Mesh for more information.

http://www.xmswiki.com/xms/index.php?title=GMS:Clean_Command
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Arc_%E2%86%92_Cross_Sections
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_2D_mesh
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_2D_mesh
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• Map → 2D Grid

Opens the Create Grid dialog. See Map to 2D Grid for more information.
• Map → 3D Grid

Opens the Create Grid dialog. See Map to 3D Grid for more information.
• Map → 2D Scatter Points

Creates a scatter point set from the points and nodes and vertices of the current coverage. See Map to 2D
Scatter Points for more information.

• Map → 3D Scatter Points

Creates a scatter point set from the points and nodes and vertices of the current coverage. See Map to 3D
Scatter Points for more information.

• Map → MODFLOW

Opens the Map → MODFLOW Options dialog. See Map to MODFLOW for more information.
• Map → SEAM3D
• Map → FEMWATER

This command assigns the wells, boundary conditions, and recharge zones assigned to the points, arcs,
and polygons. See Map to FEMWATER for more information.

• Map → SEEP2D
• Map → WASH123D
• Map → ADH
•• Copy to Coverage...

Opens a dialog allowing for selection of one or more coverages which selected feature objects will be
copied to. This may result in overlapping and/or intersecting objects.

Related Topics
•• Map Module
•• Conceptual Model

http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_2D_Grid
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_3D_Grid
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_2D_Scatter_Points
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_2D_Scatter_Points
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_3D_Scatter_Points
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Modules%23Map_to_3D_Scatter_Points
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_MODFLOW
http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_Models%23Map_to_FEMWATER
http://www.xmswiki.com/xms/index.php?title=GMS:Map_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Conceptual_Model
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Conceptual Model

A conceptual model is a group of coverages that are linked to a particular numerical model such as MODFLOW.
Once a conceptual model has been defined, coverages can be created beneath the conceptual model. The properties
available in the coverage setup dialog depend on the model associated with the conceptual model.

Conceptual Model Properties
Each conceptual model has a name and a numerical model. Then depending on the numerical model other properties
can be assigned. The following is a list of the numerical model and additional properties that are assigned to the
conceptual model.
MODFLOW – The flow package can be LPF, BCF, or HUF for a MODFLOW conceptual model. Optionally,
transport can be included with the MODFLOW conceptual model. If transport is turned on then the transport model
must be selected (MT3DMS, RT3D, SEAM3D), and species and/or reaction parameters need to be entered.
FEMWATER – A FEMWATER conceptual model has the option of simulating flow and/or transport.
MODAEM – No additional properties are set for a MODAEM conceptual model.
WASH123D – A WASH conceptual model has the option of simulating 3D subsurface flow and/or 3D subsurface
tranport and/or 2D overland flow. If the 3D subsurface transport option is turned on, then chemicals must be created.
SEEP2D – No additional properties are set for a SEEP2D conceptual model.
ART3D – Species must be defined with an ART3D conceptual model.
Horizons – No additional properties are set for a Horizon conceptual model.

http://www.xmswiki.com/xms/index.php?title=GMS:Coverages
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW
http://www.xmswiki.com/xms/index.php?title=GMS:MT3DMS
http://www.xmswiki.com/xms/index.php?title=GMS:RT3D
http://www.xmswiki.com/xms/index.php?title=GMS:SEAM3D
http://www.xmswiki.com/xms/index.php?title=GMS:FEMWATER
http://www.xmswiki.com/xms/index.php?title=GMS:MODAEM
http://www.xmswiki.com/xms/index.php?title=GMS:SEEP2D
http://www.xmswiki.com/xms/index.php?title=GMS:ART3D
http://www.xmswiki.com/xms/index.php?title=GMS:Horizon_Conceptual_Model
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Feature Object Display Options

The properties of all feature object and coverage data that GMS displays on the screen can be controlled through the
Map tab of the Display Options dialog. This dialog is opened by right-clicking on the  Map Data entry in the
Project Explorer and selecting the Display Options command. It can also be accessed from the from the Display
menu or the  Display Options macro. The objects on the left of the dialog are common to all coverages, regardless
of the coverage type, and are always available in the Display Options dialog. The options on the right of the dialog
depend on the coverage type. The following table describes the general display options available for the Map
module.

Display
Option

Description

ID If this option is selected, the ID of each of the feature objects is displayed next to the object. The graphical attributes of the text
used to display the IDs are edited using the fields on the right side of the dialog.

Labels If this option is selected, the name of points is displayed next to the object. The graphical attributes of the text used to display the
Labels are edited using the fields on the right side of the dialog.

Points This option is used to display points. The graphical attributes of the points (symbol, color, size, etc.) depend on the coverage type
and are edited using the fields on the right side of the dialog.

Nodes This option is used to display nodes. The graphical attributes of the nodes (symbol, color, size, etc.) depend on the coverage type
and are edited using the fields on the right side of the dialog.

Vertices This option is used to display the vertices of arcs. A small dot is placed on the arcs at the location of each of the vertices. The color
of the vertices is the same as the color of the arcs.

Arcs This option is used to display arcs. The graphical attributes of the arcs (color, line style, thickness, etc.) depend on the coverage
type and are edited using the fields on the right side of the dialog.

Polygons (fill) If this option is selected, polygons are displayed filled. The graphical attributes of the polygons (fill color) depend on the coverage
type and are edited using the fields on the right side of the dialog. The Polygon fill can also be specified as an attribute.

Transparency can also be set on the polygon fill using the edit box below the option.

Legend The Legend item can be used to display a legend listing each of the feature object types being displayed and showing what
graphical attributes (symbol, line style, fill color and pattern) are being used to display each type.

Grid frame This option is used to toggle the display of the Grid Frame.

Show inactive
coverages

When several coverages are present, the display of coverages can become confusing. You can choose to not display inactive
coverages or change the color attributes on inactive coverages

Each of the feature objects in a coverage has a set of display options (color, line style, etc.) that can be edited in the Display
Options dialog. However, these colors are only used to display the objects in the active coverage. All of the objects in the inactive
coverages are displayed using either Coverage colors or the Inactive coverage color depending on the selected option.

Arc direction
arrows

This option controls the display of an arrow which shows the arc direction. The pixel length of the arrow can be specified.

Well screens This options controls the display of the well screens. The width of the well screen can be adjusted in the Width edit field below the
toggle.

Calibration
targets

This options controls the display of the calibration targets used in the model calibration process. Calibration targets are drawn next
to their corresponding map data (point, arc, polygon).

The calibration target is drawn such that the height of the target is equal to twice the confidence interval (+ interval on top, −
interval on bottom). The Scale edit field allows the user to change the general length and width of the targets independent of the
range of the active dataset.

Segment ID This option controls the display of the segments IDs. The font color and size for the segment can also be adjusted.

http://www.xmswiki.com/xms/index.php?title=File:MapFolder.GIF
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=File:Dispopts.gif
http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects%23Arcs
http://www.xmswiki.com/xms/index.php?title=GMS:Calibration_Targets
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The Display Options dialog showing the Map tab.

http://www.xmswiki.com/xms/index.php?title=File%3ADisplayMap.jpg
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Feature Object Tool Palette

Several tools are provided in the Tool Palette for creating and editing feature objects. These tools are located in the
dynamic portion of the Tool Palette and are only available when the Map module is active. The table below
describes the feature object tools.

Tool Tool Name Description

Select Tool Generic selection tool that selects existing feature objects, including: nodes, vertices, arcs, and polygons. A selected object can
be deleted, moved to a new location, or operated on by one of the commands in the Feature Objects menu. The coordinates of
selected points/nodes can be edited using the Edit Window. Double-clicking on a object with this tool brings up that objects
attribute dialog.

Select
Point/Node

Selection tool that will only select existing points or nodes. A selected point/node can be deleted, moved to a new location, or
operated on by one of the commands in the Feature Objects menu. The coordinates of selected points/nodes can be edited
using the Edit Window. Double-clicking on a point or node with this tool brings up the Point or Node Attribute dialog.

Select
Vertex

Selection tool that will only select existing vertices on arcs. Once selected, a vertex can be deleted, moved to a new location, or
operated on by one of the commands in the Feature Objects menu. The coordinates of a selected vertex can be edited using the
Edit Window.

Select Arc Selection tool that will only select existing arcs to perform operations such as deletion, redistribution of vertices, or building
polygons. Double-clicking on an arc with this tool brings up the Arc Attributes dialog.

Select Arc
Group

Selection tool that is used to select an arc group to assign attributes or to display the computed flux on the arc group. An arc
group is created by selecting a set of arcs and selecting the Create Arc Group command. An arc group is deleted by selecting
the arc group and selecting the Delete key or by selecting the Delete command in the Edit menu. Deleting an arc group does
NOT delete the underlying arc objects.

Select
Polygon

Selection tool that will only select previously created polygons for operations such as deletion, assigning attributes, etc. A
polygon is selected by clicking anywhere in the interior of the polygon. Double-clicking on a polygon with this tool brings up
the Polygon Attributes dialog.

Select Grid
Frame

Selection tool used to select grid frames, allowing for the editing of the grid frame. Once the grid frame is selected, the
placement and size of the grid frame can be edited by clicking on small rectangles and dragging.

Create Point Creates new points. A new point is created for each location the cursor is clicked on in the Graphics Window. Once the point is
created, it can be repositioned or otherwise edited with the Select Point/Node tool.

Create
Vertex

Creates new vertices along existing arcs. This is typically done to add more detail to the arc. A new vertex is created for each
location the cursor is clicked on in the Graphics Window that is within a given pixel tolerance of an existing arc. Once the
vertex is created, it can be repositioned with the Select Vertex tool.

Create Arc Creates new arcs. An arc is created by clicking once on the location where the arc is to begin, clicking once to define the
location of each of the vertices in the interior of the arc, and double-clicking at the location of the end node of the arc.

As arcs are created, it is often necessary for the beginning or ending node of the arc to coincide with an existing node. If you
click on an existing node (within a given pixel tolerance) when beginning or ending an arc, that node is used to define the arc
node as opposed to creating a new node. If you click on a vertex of another arc while creating an arc, that vertex is converted to
a node and the node is used in the new arc. If you click within a given tolerance of an arc edge, a new node is inserted in the
arc. If you click on an existing point while creating an arc, the point is converted to a vertex, unless it is the beginning or
ending location of an arc, in which case it is converted to a node.

While creating an arc, it is common to make a mistake by clicking on the wrong location. In such cases, hitting the Backspace
key backs up the arc by one vertex. The ESC key can also be used to abort the entire arc creation process at any time.

http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectNode.gif
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectVertex.gif
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectArc.gif
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectArcGroup.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectPoly.gif
http://www.xmswiki.com/xms/index.php?title=File:Tool_GridFrame.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_CreateVertices.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_CreateVertex.gif
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=File:Tool_CreateArc.gif
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Coverages

Feature Objects in the Map module are grouped into coverages. Coverages are grouped into conceptual models.
A coverage is similar to a layer in a CAD drawing. Each coverage represents a particular set of information. For
example, one coverage could be used to define recharge zones and another coverage could be used to define zones of
hydraulic conductivity. These objects could not be included in a single coverage since polygons within a coverage
are not allowed to overlap and recharge zones will typically overlap hydraulic conductivity zones.
Coverages are managed using the Project Explorer. Coverages are organized below conceptual models. When GMS
is first launched, no coverage exists. If no coverage exists and the user creates feature objects then a new coverage
will automatically be created. When multiple coverages are created, one coverage is designated the "active"
coverage. New feature objects are always added to the active coverage and only objects in the active coverage can be
edited. The figure below shows several coverages in the Project Explorer. The active coverage is displayed with a
color icon and bold text. A coverage is made the active coverage by selecting it from the Project Explorer. In some
cases it is useful to hide some or all of the coverages. The visibility of a coverage is controlled using the check box
next to the coverage in the Project Explorer.
A new coverage can be created by right-clicking on a folder or conceptual model and selecting the New Coverage
command in the pop-up menu.

Right-clicking on a coverage brings up a menu with the following options: Delete, Duplicate, Rename, Coverage
Setup, Attribute Table, the Map To submenu, Transform, Export, and Properties. The Delete, Duplicate, and Rename
commands are self explanatory.

Coverage Setup
The Coverage Setup command brings up the Coverage Setup dialog. This dialog controls the properties that are
assigned to feature objects. The feature object properties have been divided into 3 general categories:
Sources/Sinks/BCs, Areal Properties, and Observation Points. Under the Sources/Sinks/BCs the user can select
which source/sinks he would like to include in the coverage (like wells, rivers, drains, etc). Areal Properties includes
recharge, ET, hydraulic conductivity, and other properties that are assigned to polygonal zones. Observation Points
control which datasets have associated observation data.
The Coverage type is used for WASH123D conceptual models to set the coverage to be a 3D or a 2D coverage.

http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects
http://www.xmswiki.com/xms/index.php?title=GMS:Conceptual_Model
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=File%3ATree_Map.gif
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The Default layer range is used with MODFLOW conceptual models to default the "from layer"/"to layer"
assignments for boundary conditions.
The Use to define model boundary toggle is used with MODFLOW and MODAEM. This means that the polygons in
this coverage are used to define the active area of the model.

3D grid layer option for obs. pts
The 3D grid layer option for obs. pts. is used to set the input option for observations associated with MODFLOW
conceptual models. The MODFLOW observation package can handle observations that include multiple cells.Three
options are available for determining which layer the observation point will be located:
• by z location – When the "by z location" option is selected, the computed value for the observation point (that

will be compared with the observed value) will be taken from the cell that corresponds with the elevation value
assigned to the observation point.

• by layer number – If you select the "by layer number" option in the coverage setup, the computed value will be
taken from the cell that corresponds to the layer that is specified in the observation point coverage properties.

• Use well screen – This option may be used when the model includes wells with screens. GMS finds the cell or
cells that intersect the screened interval the user has entered.

The Default elevation field can be used to define the initial Z elevation of new objects created in a coverage. By
assigning a different elevation to each of the coverages, the coverages can be displayed as a stack of layers in oblique
view.

Feature Object Attribute Table
All feature object properties are edited using a single spreadsheet. This makes it possible to cut and paste feature
object data using the clipboard and it makes it easier to edit entire columns of data at once. Filters at the top of the
dialog control what type of objects are displayed.

Map To Submenu
Coverages can be mapped to other geometric objects or Numerical models by selecting the corresponding command
from the Map to Submenu.
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Grid Frame

A grid frame is an outline showing where a grid will be created. The grid frame can be used to create a grid at a
particular location, size and orientation. The Feature Objects | New Grid Frame command is used to create the grid
frame. When the Map → 3D Grid command is selected, the grid will be created using the grid frame.
The Grid Frame tool  can be used to move, size and rotate the grid frame. Double-clicking on the grid frame will
bring up the Grid Frame Properties dialog which can also be used to move, size and rotate the grid frame.

Displaying the Grid Frame
The display of the grid frame can be turned on or off by checking (unchecking) the toggle next to the Grid Frame in
the Project Explorer or by using the Grid Frame option in the Feature Objects Display Options dialog.

http://www.xmswiki.com/xms/index.php?title=File:Tool_GridFrame.GIF
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Object_Display_Options
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Clean Command

The Clean command is used to fix errors in feature object data. The Clean command only applies to the active
coverage. Selecting the Clean command brings up the Clean dialog. The clean options are as follows:
• Snap Nodes – Any two nodes (or points) separated by a distance which is less than the specified distance

tolerance are combined to form a single node.
• Snap Selected Nodes – This option is the same as the previous option but only the selected nodes are checked.

When this option is checked you will be prompted to select a snapping point; you must click on the graphics
window to indicate the snapping point.

• Intersect Arcs – All arcs are checked to see if they intersect. If an intersection is found, a node is created at the
intersection and the arcs are split into smaller arcs.

• Intersect Selected Arcs – This option is the same as the previous option but only selected arcs are checked for
intersections.

• Remove Dangling Arcs – A check is made for dangling arcs (arcs with one end not connected to another arc)
with a length less than the specified minimum length. If any are found they are deleted.

Temporal Discretization
Many of the parameters associated with feature objects can be specified as either constant or transient values.
Transient values are defined as a simple list of time/data pairs using the XY Series editor. The time series represents
a piece-wise linear curve indicating how the parameter varies with time. When the Map → MODFLOW command is
selected, these curves must undergo temporal discretization. Temporal discretization is a process of converting
general time series into discrete values that apply over specific time ranges (stress periods). Transient parameters
associated with feature objects are stored in an xy series. An xy series is a general-purpose object used in GMS to
represent curves of data (in this case a time series). An xy series is manipulated by GMS with regards to feature
objects in three different ways: extrapolation, interpolation, and integration.

Extrapolation
Because the user is free to enter any time values for the x parameter of an xy series, it is possible that the xy series as
entered does not cover the same time range as the stress periods. In this case it may be necessary to extrapolate a
value for the xy series at a time before or after the first or last entered value. In GMS the simplest approach has been
used. If a value is required for a time previous to the times defined by the xy series, the first value is used. Likewise
for a time that is later than the all of the times in the xy series, the last value is used. Since this behavior might hide
an error in the input parameters, GMS will warn the user if any xy series does not cover the time range defined by
the stress periods.

Interpolation
It is also sometimes necessary to create an xy series that is a composite of two other xy series. This is the case when
obtaining transient values for an intermediate point along an arc segment that has differing transient parameters at
both nodes at the ends of the arc. To perform this type of interpolation, a new xy series is constructed that is the
union of the x times from the two original series. The y values that correspond to the time step in each of the series
are used to obtain a new y value for the intermediate point:

http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects
http://www.xmswiki.com/xms/index.php?title=XY_Series_Editor
http://www.xmswiki.com/xms/index.php?title=XY_Series_Editor
http://www.xmswiki.com/xms/index.php?title=GMS:Stress_Periods
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Where F is the y-value along the new xy series, y1 and y2 are the two node xy series and hn is the interpolation
weighting parameter.
As an example, when one node of an arc has a constant parameter and the other has a transient parameter, the
constant parameter is converted into an xy series with only one point. By using the extrapolation assumption above,
it is then possible to perform a transient interpolation using two transient series.

Integration
MODFLOW and MT3DMS both use the concept of Stress Periods to define the times that stresses may be applied.
A stress period is a time interval during which all external stresses are constant. Because an xy series is not
constrained to be constant over a time interval, it is necessary to obtain a representative value from the xy series that
will approximate this condition.
GMS uses integration of the curve defined by the xy series to obtain the average value over the stress period. This
average value is then assigned to the stress period.

Time Units
When entering a time series in the Map module using the XY Series Editor, you can use relative times (i.e., 0.0, 3.2,
5.4 etc.), or dates/times (1/1/2004 12:00:00 AM, 2/13/2004 2:01:00 PM etc.).

http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW
http://www.xmswiki.com/xms/index.php?title=GMS:MT3DMS
http://www.xmswiki.com/xms/index.php?title=GMS:Stress_Periods
http://www.xmswiki.com/xms/index.php?title=File:Discretization01.jpg
http://www.xmswiki.com/xms/index.php?title=GMS:Map_Module
http://www.xmswiki.com/xms/index.php?title=XY_Series_Editor
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Map to Models
Map to MODFLOW

See Map to MODFLOW

Map to FEMWATER

Once the 3D mesh is constructed, the final step in converting the FEMWATER conceptual model to a mesh-based
numerical model is to select the Map → FEMWATER command in the Feature Objects menu. This command
assigns the wells, boundary conditions, and recharge zones assigned to the points, arcs, and polygons in the
conceptual model to the nodes and element faces of the 3D mesh. At this point, the basic analysis options (steady
state vs. transient, output control, material properties, etc.) must still be assigned using the tools in the FEMWATER
menu. Once these basic options have been assigned, the model can be saved and FEMWATER can be launched.

Map to MT3DMS

After the conceptual model is constructed, the Map → MT3DMS command can be used to convert the conceptual
model to an MT3DMS numerical model. Before the Map → MT3DMS command can be selected, the MT3DMS
data must be initialized. The MT3DMS data are initialized with the following steps:
1. Switch to the 3D Grid module
2. Select the New Simulation command from the MT3D menu.
3. Open the Basic Transport Package dialog and set up the stress periods you wish to use in the simulation.
Once the MT3DMS data are initialized, the Map → MT3DMS command becomes undimmed and can be selected.
Because MT3DMS already assumes a default concentration of zero for an unspecified point source sink, GMS does
not create a source/sink if the concentration for the feature object has been specified as a constant value of zero.

http://www.xmswiki.com/xms/index.php?title=GMS:Map_to_MODFLOW
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW_Conceptual_Model_Approach
http://www.xmswiki.com/xms/index.php?title=GMS:MT3DMS
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Basic_Transport_Package_Dialog
http://www.xmswiki.com/xms/index.php?title=GMS:Basic_Transport_Package_Dialog
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Map to Modules

Arc → Cross Sections
The default method for generating cross sections through solids, 3D meshes, or 3D grids it to interactively
enter a line or a polyline in the Graphics Window while the Make Cross Section tool is active (Solid module,
3D Grid module, 3D Mesh module). This line is then projected perpendicular to the screen (parallel to the
viewers viewing angle) and is intersected with the 3D objects to generate the cross section. In some cases, it is
useful to precisely locate the cross section. Furthermore, it is often necessary to repeatedly generate a cross
section at the same location. In such cases, the Arcs → Cross Sections command can be used to precisely
control the location of a cross section.
When the Arcs → Cross Sections command is selected, the Arcs → Cross Sections dialog appears. The top
part of the dialog is used to specify which of the arcs are to be used to create the cross sections. Either all of
the arcs are used or only the selected arcs. Since cross sections can be cut through any 3D object, the items in
the lower section of the dialog are used to designate which of the 3D objects will be used to cut the cross
sections. If one of the types listed does not currently exist, the corresponding item is dimmed.
When the OK button is selected, a cross section is constructed for each of the designated arcs. As is the case
when the Make Cross Section tool is used, the cross sections are constructed by projecting the arcs parallel to
the viewing angle. For example, to create vertical cross sections, the image should be in plan view prior to
selecting the Arcs → Cross Sections command.

Map → TIN
This command creates a TIN using each polygon in the coverage.

Map to 2D Mesh
Once a set of feature objects has been created for a SEEP2D or a FEMWATER conceptual model, the Map →
2D Mesh command can be used to generate a 2D finite element mesh from the objects. The Map → 2D Mesh
command creates a 2D Mesh on the interior of all of the polygons in the current coverage. The figure below
shows a cross section of a dam built using the Feature Objects in the Map Module. The second figure shows a
2D Mesh created from the polygons.

Cross Section of a Dam built with Arcs and
Polygons in the Map Module

2D Mesh created from Map Objects using Map
→ 2D Mesh command

http://www.xmswiki.com/xms/index.php?title=GMS:Solid_Module_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Mesh_Tool_Palette
http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects
http://www.xmswiki.com/xms/index.php?title=File%3ADam_xsect.gif
http://www.xmswiki.com/xms/index.php?title=File%3ADam_mesh.gif
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Map to 2D Grid
The Map → 2D Grid command is used to construct a 2D grid using the feature objects in a 2D Grid Coverage.
When the Map → 2D Grid command is selected, the Create Grid dialog appears. If a grid frame has been
defined, the size and location of the grid frame are used to initialize the fields in the Create Grid dialog. In
most cases, these values will not need to be changed and the user can simply select the OK button to create the
grid. If a grid frame has not been defined, the size and location of the grid are initialized so that the grid just
surrounds the currently defined feature objects. If desired, the grid dimensions can be edited prior to selecting
the OK button to create the grid.
If one or more refine points are defined in the conceptual model, the number of rows and columns in the grid
will be automatically determined when the grid is created. Thus, these fields cannot be edited by the user and
will be dimmed. If refine points are not defined, the user must enter the number of rows and columns.

Map to 3D Grid
Once the feature object coverages defining a conceptual model have been completely defined, the conceptual
model is ready to be converted to a numerical model. The first step in this conversion process is to create a
grid using the Map → 3D Grid command. Typically, the Grid Frame command is used prior to this command
to define the location and dimensions of the grid.
When the Map → 3D Grid command is selected, the Create Grid dialog appears. If a grid frame has been
defined, the size and location of the grid frame are used to initialize the fields in the Create Grid dialog. In
most cases, these values will not need to be changed and the user can simply select the OK button to create the
grid. If a grid frame has not been defined, the size and location of the grid are initialized so that the grid just
surrounds the currently defined conceptual model. Once again, in most cases, no changes will need to be made
and the user can typically immediately select the OK button to create the grid.
If one or more refine points are defined in the conceptual model, the number of rows and columns in the grid
will be automatically determined when the grid is created. Thus, these fields cannot be edited by the user and
will be dimmed. If refine points are not defined, the number of rows and columns must be entered.

Refine Points

Refine attributes are assigned to points or nodes and are used to automatically increase the grid density around
a point when the grid is constructed. Although refine attributes may be associated with any point or node, they
are usually assigned in conjunction with wells.

Map to 2D Scatter Points
The Map → 2D Scatter Points command creates a scatter point set from the points and nodes and vertices of
the current coverage. The process is different for observation coverages and non-observation coverages.
Non-observation Coverages – With non-observation coverages, a single elevation dataset is created for the
2D scatter points representing the Z location of all the points, nodes and vertices.
Observation Coverages – With observation coverages, the Observation Points → Scatter Points dialog
appears. This dialog allows you to create a dataset for the 2D scatter points from one of the measurements
associated with the observation points.
Measurement – A dataset is created for the 2D scatter points from the measurement selected in the dialog.
The model associated with the selected measurement (if any) is shown, along with whether the measurement is
steady state or transient.
Time Step Times – This section of the dialog is only available if the selected measurement is transient. It 
allows you to define the number of time steps, and the time step times to be created for the scatter point

http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects%23Points
http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects%23Nodes
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module%23Creating_3D_Grids


Map to Modules 198

dataset.
Match all unique times – The Match all unique times option gets the set of unique times from the XY series
of all the observation points. This is the union of all the times. If some XY series use dates/times and others
don’t, this option won’t be available. Otherwise, the times in the spreadsheet will be displayed as either
dates/times or relative times depending on the XY series. The spreadsheet will not be editable. The Use
dates/times toggle will be unavailable but set according to whether the observation point XY series use
dates/times or not. The Reference time section will be unavailable, but if the XY series use dates/times, the
minimum time will be used as the reference time for the scatter point dataset.
Match time steps from model – The Match time steps from model option will only be available if the
measurement is associated with a model, and the model is transient. If so, this will be the default choice and
GMS will get the times to display in the spreadsheet from the stress period and time step info for the model.
The spreadsheet will not be editable. The Use dates/times toggle will be unavailable but set according to
whether the model uses dates/times or not. The Reference time section will be unavailable, but if the model
uses dates/times, the model reference time will be used as the reference time.
Specify times – The spreadsheet of times will be editable with this option and you can copy and paste times
from another program such as a spreasheet. Also, the Initialize Times button becomes available allowing you
to bring up a dialog you can use to create times at a specified interval. If you select the Use dates/times toggle,
the Reference time section will become available and the times in the spreadsheets will be displayed as
dates/times.

Map to 3D Scatter Points
The Map → 3D Scatter Points command was introduced in GMS version 8.3. This command works exactly like the
Map → 2D Scatter Points command except that 3D scatter points are created. One use of the Map → 3D Scatter
Points command is to create scatter points from map data that can then be converted into MODPATH starting
locations.

http://www.xmswiki.com/xms/index.php?title=GMS:Converting_3D_Scatter_Points_to_Other_Data_Types
http://www.xmswiki.com/xms/index.php?title=GMS:Converting_3D_Scatter_Points_to_Other_Data_Types
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5.11. GIS Module

GIS Module
The GIS module allows you to manipulate ESRI type GIS data, such as shapefiles. If you have a license of ArcView
8.x or higher on the computer that GMS is installed on, there are additional features available in the GIS module, but
you don't have to have an ArcView 8.x license installed to access the basic features.
The following table shows what features are available with and without a license of ArcView 8.x.

Feature With ArcView Without ArcView

Efficient management of large datasets X X

Graphical selection of features X X

Conversion of selected GIS objects to GMS feature objects X X

Viewing attribute tables X X

Joining additional attribute tables based on a key field X X

Display like ArcView X X

Display in a simplified, single color X X

Support for shapefiles X X

Support for coverages, geodatabases, images, CAD, grids X

Selection queries X

Symbology X
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GIS Display Options
The properties of all GIS data that GMS displays on the screen can be controlled through the Shape Files tab of the
Display Options dialog. This dialog is opened by right-clicking on the  GIS Data entry in the Project Explorer and
selecting the Display Options command. It can also be accessed from the from the Display menu or the  Display
Options macro. The following table describes the display options available for the GIS module.

Display
Option

Description

Points Controls the display of points in shape files in the Graphics Window. The size and color of the points can be adjusted using the
button to the right of the Points toggle.

Lines Controls the display of lines in shape files in the Graphics Window. The line type, width, and color can be adjusted using the button
to the right of the Lines toggle.

Polygons Controls the display of polygons in shape files in the Graphics Window. The polygon line type, width, and color can be adjusted
using the button to the right of the Polygons toggle.

Selection
color

Controls the selection color used when GIS shape file objects are selected in the Graphics Window.

The Display Options dialog showing the GIS tab.

http://www.xmswiki.com/xms/index.php?title=File:GISFolder.GIF
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=File:Dispopts.gif
http://www.xmswiki.com/xms/index.php?title=File%3ADisplayGIS.jpg
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GIS Tool Palette
The following tools are active in the dynamic portion of the Tool Palette whenever the GIS module is active. Only
one tool is active at any given time. The action that takes place when the user clicks in the Graphics Window with
the cursor depends on the current tool. The table below describes the tools in the GIS tool palette.

Tool Tool Name Description

Select
Features

The Select Features tool is used to select feature objects in the Graphics Window. This tool is only available if ArcView is
installed locally on the user's desktop.

Identify The Identify tool is used to select GIS objects and display information relating to that object in an Identify Results dialog.
This tool is only available if ArcView is installed locally on the user's desktop.

Select
Elements

The Select Elements tool is used to select shape objects in the Graphics Window.

Enabling ArcObjects
ArcObjects is a development platform provided by ESRI that allows developers of other applications (such as GMS)
to incorporate ArcView/ArcGIS capability directly within their application. GMS can use ArcObjects to access some
of the same functionality in GMS that is available in ArcView, providing you are running on a computer that has a
current license of ArcView.
The Data | Enable ArcObjects command queries the ESRI license manager for ArcView/ArcGIS to see if a license
exists. If a valid license is found then the ArcView functionality within GMS is enabled and you will be allowed
access. If a license is not found then the ArcView specific features remain unavailable.
ArcObjects® is a development platform provided by ESRI® [1] that allows developers of other applications to
incorporate ArcView/ArcGIS® capability directly within their application. ArcObjects® is used to incorporate
ArcView® functionalities into XMS software. This allows users to use ArcView® functionality within XMS
software. In order to use ArcView® functionality, a current license of ArcView® must be installed. Without a
license, much of the same functionality is available, the primary differences being that only the shapefile format is
supported, and many of the selection and display capabilities are minimal.

"Error initializing EMRL_LicCheckMod.dll"
If the dll "EMRL_LicCheckMod.dll" fails to register automatically, selecting the Enable ArcObjects command will
bring up the error "Error initializing EMRL_LicCheckMod.dll". Please contact Technical Support". To fix this, you
will need to register the dll manually by following the steps below.
•• 1. Select "Start | Run"
• 2. Type in 'regsvr32 "<directory where GMS 7.0 was installed>\EMRL_LicCheckMod.dll"
     The default location for GMS 7.0 is "C:\Program Files\GMS 7.0".  If the program was installed in the default location, for 

     example, this line in the Run window will be: regsvr32 "C:\Program Files\GMS 7.0\EMRL_LicCheckMod.dll"

•• 3. Select OK
•• 4. Restart GMS 7.0

http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectFeatures.GIF
http://www.xmswiki.com/xms/index.php?title=File:Tool_Identify.GIF
http://www.esri.com/
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GIS to Feature Objects
GIS vector data can be converted to Feature Objects (points, arcs, polygons in coverages) for use in a conceptual
model. Attributes associated with the GIS data can also be mapped over to attributes associated with Feature Objects.
Two commands are available for converting GIS vector data to Feature Objects: GIS | ArcObjects → Feature
Objects(with an ArcObjects license) and GIS | Shapes → Feature Objects. Selecting either of these commands will
bring up GIS to Feature Objects wizard.
Before starting the wizard, you need to make sure to set the appropriate coverage as the active coverage since the
wizard will convert the GIS data to new Feature Objects in the active coverage. Also, if you are mapping over
attributes, you must make sure the GMS coverage attributes are defined before you do the conversion.
If you only wish to convert a portion of you GIS vector data to Feature Objects then select the desired GIS data
before beginning the wizard. If you wish to map all the features you can begin the wizard and you will be asked if
you want to convert all features since none are selected.
Follow the instructions in the mapping wizard to convert the GIS data to Feature Objects.

GIS to Feature Objects Wizard dialog showing the first step in the conversion process.

http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects
http://www.xmswiki.com/xms/index.php?title=GMS:Conceptual_Model
http://www.xmswiki.com/xms/index.php?title=GMS:Conceptual_Model
http://www.xmswiki.com/xms/index.php?title=File%3AGIS_to_Feature_Objects_Wizard_--_Step_1_of_2.jpg
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Add Data

Add Shapefile Data
The Data | Add Shapefile Data command allows you to browse for and open shapefiles as GIS layers in GMS.
Without a license of ArcView on your computer then shapefiles are the only supported format for GIS layers. With a
valid license of ArcView the Data | Add Data command is available and any of the ESRI supported formats can be
opened as GIS data layers.

Add Data
The Data | Add Data command is available when ArcObjects is enabled and uses the same dialog resource to open
GIS data layers that is used by ArcView.

Select Data dialog

When ArcObjects is enabled you are
able to load any of the ESRI supported
formats, including shapefiles,
coverages, geodatabases, grids,
images, CAD files and others, as GIS
data layers in GMS. These data can
then be converted to GMS feature
objects in map coverages.

http://www.xmswiki.com/xms/index.php?title=File%3AAdd_Data_Dialog.jpg
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Arc Hydro Groundwater
Arc Hydro Groundwater [1] is a data model and a suite of tools for groundwater data that is integrated with ESRI's [2]

ArcGIS [3]. GMS can import and export data in a geodatabase consistent with the Arc Hydro Groundwater standard.

Export to Arc Hydro Groundwater
To export data from GMS into an Arc Hydro Groundwater geodatabase you select the File | Save As menu command
and change the file type to Arc Hydro Groundwater Geodatabase. In order for the export to be successful the
following things must be true:
•• ArcObjects must be enabled.
• Your data must be in a non-local projection.

Import from Arc Hydro Groundwater
An Arc Hydro Groundwater geodatabase may be imported into GMS. This is done by enabling ArcObjects and, in
the GIS module, selecting the GIS | Add Data menu command. Selecting the Arc Hydro Groundwater geodatabase
from the Add Data dialog will display the items the geodatabase contains. You may then select which items to
import into GMS.

GIS Commands
The GIS menu appears when GIS data has been loaded into GMS. The menu has a submenu, the Selection submenu,
which contains its own submenu, the Interactive Selection Method submenu. The following commands are available
in the GIS menu:
•• Enable ArcObjects

Loads ArcMap ArcObjects so that ArcMap can run inside of GMS. This command is only available in
32 bit GMS since ArcMap is a 32 bit application. You must have ArcGIS installed with a valid license
(or access to a network license).

•• Add Data...

Calls ArcObjects and uses ESRI's Select Data dialog.
•• Delete Layer(s)...

Brings up a dialog where the user can select from the currently loaded layers and remove them from the
GIS data. ArcObjects only.

A more efficient way to remove layers from a project would be to select the item in the Project Explorer
and select delete.

• ArcObjects → Feature Objects

Converts ArcObjects vector data to Feature Objects using the GIS to Feature Objects wizard.
• Shapes → Feature Objects

Converts Shapefile data to Feature Objects using the GIS to Feature Objects wizard.
• Selection >

•• Select By Attributes...

Brings up ESRI's Query Wizard for selecting based on attribute. ArcObjects only.

http://www.archydrogw.com/ahgw/Main_Page
http://www.esri.com
http://www.esri.com/software/arcgis/
http://www.xmswiki.com/xms/index.php?title=Projections
http://www.xmswiki.com/xms/index.php?title=GMS:Enabling_ArcObjects
http://www.xmswiki.com/xms/index.php?title=GMS:GIS_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Enabling_ArcObjects
http://www.xmswiki.com/xms/index.php?title=GMS:Add_Data
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:GIS_to_Feature_Objects
http://www.xmswiki.com/xms/index.php?title=GMS:GIS_to_Feature_Objects
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•• Select By Location...

Brings up ESRI's Select By Location dialog. ArcObjects only.

•• Clear Selected Features

Clears all selections of GIS data. ArcObjects only.

• Interactive Selection Method >

Allows user to select how ArcObjects will process new selections based on the 4 options listed below.
ArcObjects only.

•• Create New Selection

Mode for handling interactive selection. ArcObjects only.

•• Add to Current Selection

Mode for handling interactive selection. ArcObjects only.

•• Remove from Current Selection

Mode for handling interactive selection. ArcObjects only.

•• Select from Current Selection

Mode for handling interactive selection. ArcObjects only.

•• Options...

Brings up ESRI's Selection Options dialog. ArcObjects only.

•• Selectable Layers...

Allows the user to choose which GIS layers can have selections. ArcOjects only.

•• Visible Layers...

Allows the user to choose which GIS layers are visible. ArcObjects only.

A more efficient way to change the visibility of the GIS layer is to use the check box next to the item in
the project explorer

•• Map Properties...

Brings up the Properties dialog for the ESRI map and shows the current coordinate system.
•• Attribute Table...

Brings up Attribute Table of the selected GIS layer.
•• Join Table to Layer...

Brings up File Browser dialog to choose a dbf file to join to a GIS layer.
•• Transparency...

Allows the user to set the transparency on raster layers or, if using ArcObjects, any GIS layer;
•• Properties...

Brings up the Properties dialog for the selected layer.
•• Convert to 2D Scatter Points

Converts GIS point layers to 2D scatter points.
•• Add Shapefile Data...

Adds a shape file to the GIS data.
•• Clear All Data

Removes all GIS data from the project.
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Related Topics
•• GIS Module

http://www.xmswiki.com/xms/index.php?title=GMS:GIS_Module
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5.12. UGrid Module

UGrid Module

The UGrid module is the newest module in GMS and is used with unstructured grid (UGrid) geometric objects.
Unstructured grids are very flexible. They can include many types of cells including 2D and 3D cells and cells with
any number of faces and nodes. This type of geometric object is used with MODFLOW-USG which uses a finite
volume approach. Eventually UGrids will be used for all the things that 2D Grids and 3D Grids are currently used
for.
Interfaces to the following 3D finite difference models are provided in this module:
•• MODFLOW-USG

http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW-USG
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW-USG
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Creating and Editing UGrids

There are a number of ways to create UGrids. Currently UGrids cannot be edited after they are created.

Importing
UGrids can be imported from a VTK XML file [1] by selecting the File|Open command or by dragging and dropping
the file onto the GMS window. GMS recognizes the ".vtu" extension, which by convention is the extension used for
a VTK XML file containing an unstructured grid.

New UGrid 2D/3D
Right-clicking anywhere in the Project Explorer or on the UGrid Data item will display a menu with New UGrid 2D
and New UGrid 3D commands. These commands bring up the New UGrid dialog which allows you to specify
options for the creation of a new UGrid, and is very similar to the Create Grid dialog for 3D structured grids.

Map → UGrid
The Map → UGrid command creates a UGrid from feature objects. It can be found in the Feature Objects menu, in
the Map toolbar, and in some pop-up menus when right-clicking on items in the Project Explorer (Coverage, Grid
Frame). The command opens the Create UGrid dialog.

Create UGrid dialog.

Map → UGrid Dialog

• Dimension – Specifies whether a 2D or 3D UGrid will be created.
•• UGrid type

• Regular (not refined) – Creates a grid with rectangular cells that
are not refined. Any refinement attributes specified on feature
objects is ignored.

• Quad tree – Creates a grid with rectangular cells that are refined
in a quad tree manner around any points, arcs and polygons
which specify the refinement attribute and refinement size.

• Voronoi – Creates a Voronoi grid with cells of various sizes and
shapes which meet the Voronoi criteria. Only the active coverage
is used and it must contain a polygon because the algorithm uses
the polygon to create a triangular mesh. The mesh is refined
around points that are marked as refine points based on the
specified refinement size. The mesh is constructed to honor all
arc geometry. If refinement is specified as an attribute on arcs or
polygons it is ignored.

• Refine points – If the quad tree option is selected and refine points exist in multiple coverages, specifies which
refine points to use.

•• X, Y, Z number of cells

•• If not using the Voronoi UGrid type, the size and number of cells in the X, Y and Z dimensions can be
specified. For quad tree UGrids, the cell size represents the large, unrefined size. The small, refined size is
determined by the refinement specified at points, arcs and polygons. Also for quad tree UGrids, if the cell size

http://www.vtk.org/VTK/img/file-formats.pdf
http://www.xmswiki.com/xms/index.php?title=GMS:Creating_and_Editing_3D_Grids%23Create_Grid
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=File%3ADialogCreateUGrid.png
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is specified, it represents a target cell size (large, unrefined size); the actual cell size will likely be somewhat
different so that the cells fit within the grid boundaries.

If a grid frame exists, it is used to determine the location of the grid boundaries. If polygons exist and the Regular or
Quad tree options are used, any cells that are not inside a polygon are not included in the UGrid.

Various UGrids created from the same coverage.

Coverage Regular UGrid
Quad Tree UGrid

Voronoi UGrid

Conversion From Other Data Types
The following data types can be converted to UGrids by right-clicking on the object in the Project Explorer and
selecting the Convert To > UGrid command from the pop-up menu.
•• TINs
•• 2D Grids
•• 3D Grids
•• 2D Mesh
•• 3D Mesh
• Polygons in a coverage (Map To > Polygons -> UGrid)
• Polygon shape files in the GIS Module

Horizons
The Horizons → UGrid command (in the TINs and Boreholes menus) uses horizons to create a 3D UGrid.

Extrude Down to 3D UGrid
Right-clicking on a UGrid shows the Extrude Down to 3D UGrid command. If the UGrid has 2D cells, this
command can be used to create a new UGrid with 3D prismatic cells. The user can specify the number of layers and
the thickness of each layer.

3D ￫ 2D
If the UGrid has 3D cells, this command brings up a dialog asking for the layer number from which a UGrid
consisting of 2D cells will be created.

http://www.xmswiki.com/xms/index.php?title=GMS:Grid_Frame
http://www.xmswiki.com/xms/index.php?title=File%3AMapToUGridMap.png
http://www.xmswiki.com/xms/index.php?title=File%3AMapToUGridRegular.png
http://www.xmswiki.com/xms/index.php?title=File%3AMapToUGridQuad.png
http://www.xmswiki.com/xms/index.php?title=File%3AMapToUGridVoronoi.png
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Grid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:2D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:3D_Mesh_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects%23Polygons
http://www.xmswiki.com/xms/index.php?title=GMS:Feature_Objects%23Coverages
http://www.xmswiki.com/xms/index.php?title=GMS:GIS_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Horizons_to_UGrid
http://www.xmswiki.com/xms/index.php?title=GMS:TIN_Module
http://www.xmswiki.com/xms/index.php?title=GMS:Boreholes
http://www.xmswiki.com/xms/index.php?title=GMS:Horizons
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UGrid Viewing Modes

Single Layer View
UGrid cells can be assigned to a layer. The layer for the cell is displayed in the Cell Properties. The Single layer
toolbar can be used to view one layer at a time. This is somewhat analogous to the 3D Grid ortho mode but works for
all viewing angles.

Symbols On Top
When cell faces are turned on, or color filled contours which result in a filled face, the symbols which are normally
displayed at the cell centroid are displayed at the center of the top face of the cell. This allows them to be seen,
although the symbol may still be partially obscured by the filled cell face.

http://www.xmswiki.com/xms/index.php?title=File:SingleLayerToolbar.png
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Converting UGrids to Other Data Types

Currently UGrids cannot be converted to other data types (TINs, meshes etc). They can be exported to a number of
formats.

http://www.xmswiki.com/xms/index.php?title=GMS:Exporting_UGrids
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Exporting UGrids

UGrids can be exported to a file by right-clicking on the UGrid item in the Project Explorer and selecting the Export
command. The supported file formats are:

Format Description

Paraview VTK Binary XML File (*.vtu) Format [1]

Paraview VTK ASCII XML File (*.vtu) Format [1]

Polygon Shapefile (*.shp) The 2D polygons formed by the cells in plan view (elements should be prismatic).

Point Shapefile (*.shp) The centroids of the cells.

http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.vtk.org/VTK/img/file-formats.pdf
http://www.vtk.org/VTK/img/file-formats.pdf
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UGrid Display Options

The display options of UGrid data that GMS displays on the screen can be controlled through the UGrid Data tab of
the Display Options dialog. This dialog is opened by right-clicking on the  UGrid Data item in the Project
Explorer and selecting the Display Options command. It can also be accessed from the from the Display menu or
the  Display Options macro. The following table describes the display options available for the UGrid module.

Display
Option

Description

Cell edges The Cell edges item is used to display the edges of cells. The cells are drawn using the specified color.

Cell faces This option fills the cells with the material color.

Points Points are the corners of cells, or simply 3D points not attached to cells.

UGrid
shell

The UGrid shell item is used to display an edge for each of the edges on the exterior of the set of all cells (visible or invisible) which
corresponds to a discontinuity in the UGrid exterior. This display option provides a helpful spatial context when displaying
iso-surfaces or cross sections.

Feature
angle

The UGrid shell feature angle is used only when the UGrid Shell option is selected. This angle represents a threshold angle at which
an edge of the shell will be displayed. If for example, an angle of 45 degrees is defined, any edge of the UGrid which divides two cell
faces that are at an angle greater than 45 degrees to each other will not be displayed.

Point
numbers

The Point numbers item is used to display the ID associated with each point next to the point.

Cell
numbers

The cell numbers item is used to display the ID associated with each cell at the centroid of the cell.

Scalar
values

The Scalar Values item is used to display the scalar values of the active dataset for each node next to the node.

Contours Most of the objects supported by GMS can be contoured by turning on the Contour Options in the Display Options dialog. When an
object is contoured, the values associated with the active dataset for the object are used to generate the contours.

The Display Options dialog showing the 3D UGrid tab.

http://www.xmswiki.com/xms/index.php?title=GMS:Display_Options
http://www.xmswiki.com/xms/index.php?title=File:UGridFolder.png
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=GMS:Project_Explorer
http://www.xmswiki.com/xms/index.php?title=File:Dispopts.gif
http://www.xmswiki.com/xms/index.php?title=GMS:Contour_Options
http://www.xmswiki.com/xms/index.php?title=File%3ADisplay3DUGrid.jpg
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UGrid Tool Palette

The following tools are contained in the dynamic portion of the Tool Palette when the UGrid Module is active. Only
one tool is active at any given time. The action that takes place when the user clicks in the Graphics Window
depends on the current tool.

Tool Tool
Name

Description

Select
Cells

The Select Cells tool is used to select individual UGrid cells. Multi-selection can be performed by holding down the Shift or Ctrl
key while selecting or by dragging a rectangle to enclose the cells to be selected. The xyz locations of the cell centroid of the
selected cell are displayed in the Edit Window and the ID and other information is displayed in the Status Bar.

Only visible cells can be selected. Cells which have been hidden cannot be selected. Cells where the MODFLOW IBOUND array
equals 0 can only be selected when they are being displayed by turning on the IBOUND = 0 item in the MODFLOW Display
Options dialog.

When selecting cells by dragging a box, all cells that lie within the box are selected. When selecting cells by clicking on individual
cells with the cursor, only cells on the exterior of the visible portion of the grid are selected. Cells in the interior of the grid can be
selected individually by first hiding the layers, rows, or columns adjacent to the cells.

Select
Point

The Select Point tool is used to select points which, if connected to cells, are the corners of cells. The point coordinates are
displayed in the Edit Window.

http://www.xmswiki.com/xms/index.php?title=GMS:Tool_Palettes
http://www.xmswiki.com/xms/index.php?title=GMS:UGrid_Module
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=File:Tool_UGridSelectCell.png
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen%23Status_Bar
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW_Display_Options
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW_Display_Options
http://www.xmswiki.com/xms/index.php?title=File:Tool_SelectVertices.GIF
http://www.xmswiki.com/xms/index.php?title=GMS:The_GMS_Screen
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UGrid Cell Properties

The UGrid Cell Properties dialog allows the user to edit cell properties. Most cell properties are associated with a
model such as MODFLOW-USG. If no models exist in the GMS project then the UGrid Cell Properties dialog will
only allow editing of the material assigned to the grid cell.

MODFLOW
Several input arrays defining parameters such as starting head, IBOUND, hydraulic conductivity, and transmissivity
are defined in the Global/Basic and BCF or LPF packages. These arrays can be edited in the Basic and
BCF/LPF/HUF Package dialogs, or they can be initialized using a conceptual model in the Map module. In many
cases however, it is necessary to view or edit the values on a cell-by-cell basis. This can be accomplished using the
Cell Properties command in the drop-down menu when selecting UGrid cells.
NOTE: When you are using materials to define the MODFLOW model, the Cell Properties dialog will show the
material properties relating to the material of the selected cell. You will not be able to edit these values on a
cell-by-cell basis, but you can either edit the material type for this cell if the active material set is the default material
set, or you can change the material properties for the material (which affects every cell that uses that material).

3D Grid Cell Properties dialog showing the MODFLOW tab.

http://www.xmswiki.com/xms/index.php?title=GMS:IBOUND
http://www.xmswiki.com/xms/index.php?title=GMS:Global_Options/Basic_Package
http://www.xmswiki.com/xms/index.php?title=GMS:BCF_Package
http://www.xmswiki.com/xms/index.php?title=GMS:LPF_Package
http://www.xmswiki.com/xms/index.php?title=GMS:MODFLOW_Conceptual_Model_Approach
http://www.xmswiki.com/xms/index.php?title=GMS:Map_Module
http://www.xmswiki.com/xms/index.php?title=File%3AUGridCellProp.jpg
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UGrid Commands
Various menu commands are available when right-clicking on UGrid items in the Project Explorer.
•• New UGrid 2D...

Brings up the New UGrid dialog.
•• New UGrid 3D...

Brings up the New UGrid dialog.
•• Export...

Brings up a dialog allowing you to export the UGrid to a file.
•• Extrude Down To 3D UGrid...

Brings up a dialog allowing you to specify layer thicknesses to create a 3D UGrid from a 2D UGrid.

• 3D ￫ 2D...

Creates a UGrid with 2D cells from a specified layer of a 3D UGrid.

http://www.xmswiki.com/xms/index.php?title=GMS:Creating_and_Editing_UGrids%23New_UGrid_Dialog
http://www.xmswiki.com/xms/index.php?title=GMS:Creating_and_Editing_UGrids%23New_UGrid_Dialog
http://www.xmswiki.com/xms/index.php?title=GMS:Exporting_UGrids
http://www.xmswiki.com/xms/index.php?title=GMS:Creating_and_Editing_UGrids%23Extrude_Down_to_3D_UGrid
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Article Sources and Contributors
Interpolation  Source: http://www.xmswiki.com/xms/index.php?oldid=55747  Contributors: Jcreer, Ksmith, Tdye

Interpolation Commands  Source: http://www.xmswiki.com/xms/index.php?oldid=70862  Contributors: Alanlemon, Jcreer, Ksmith, Unjedai

3D Interpolation Options  Source: http://www.xmswiki.com/xms/index.php?oldid=73279  Contributors: Jcreer, Ksmith, Unjedai

Steady State vs. Transient Interpolation  Source: http://www.xmswiki.com/xms/index.php?oldid=73280  Contributors: Jcreer, Tdye

Linear  Source: http://www.xmswiki.com/xms/index.php?oldid=73274  Contributors: Jcreer, Ksmith, Unjedai

Inverse Distance Weighted  Source: http://www.xmswiki.com/xms/index.php?oldid=66773  Contributors: Htran, Jcreer

Shepards Method  Source: http://www.xmswiki.com/xms/index.php?oldid=73281  Contributors: Jcreer, Ksmith

Gradient Plane Nodal Functions  Source: http://www.xmswiki.com/xms/index.php?oldid=73282  Contributors: Jcreer, Ksmith, Unjedai

Quadratic Nodal Functions  Source: http://www.xmswiki.com/xms/index.php?oldid=73284  Contributors: Jcreer, Ksmith

Subset Definition  Source: http://www.xmswiki.com/xms/index.php?oldid=73288  Contributors: Jcreer, Ksmith

Computation of Interpolation Weights  Source: http://www.xmswiki.com/xms/index.php?oldid=73293  Contributors: Jcreer, Ksmith

Clough-Tocher  Source: http://www.xmswiki.com/xms/index.php?oldid=66779  Contributors: Jcreer, Ksmith

Natural Neighbor  Source: http://www.xmswiki.com/xms/index.php?oldid=73297  Contributors: Jcreer, Ksmith, Unjedai

Kriging  Source: http://www.xmswiki.com/xms/index.php?oldid=73301  Contributors: Jcreer, Ksmith

Kriging Options  Source: http://www.xmswiki.com/xms/index.php?oldid=73307  Contributors: Jcreer, Ksmith

3D Kriging  Source: http://www.xmswiki.com/xms/index.php?oldid=66108  Contributors: Jcreer, Ksmith

Variogram Editor  Source: http://www.xmswiki.com/xms/index.php?oldid=73323  Contributors: Jcreer, Ksmith

Jackknifing  Source: http://www.xmswiki.com/xms/index.php?oldid=73325  Contributors: Jcreer, Ksmith, Unjedai

TIN Module  Source: http://www.xmswiki.com/xms/index.php?oldid=34951  Contributors: Ksmith

Creating a TIN  Source: http://www.xmswiki.com/xms/index.php?oldid=73329  Contributors: Jcreer, Jdye, Ksmith

Editing a TIN  Source: http://www.xmswiki.com/xms/index.php?oldid=73336  Contributors: Jcreer, Ksmith, Unjedai

TIN Settings  Source: http://www.xmswiki.com/xms/index.php?oldid=73339  Contributors: Jcreer, Tdye

TIN Display Options  Source: http://www.xmswiki.com/xms/index.php?oldid=73343  Contributors: Jcreer, Ksmith, Unjedai

TIN Tool Palette  Source: http://www.xmswiki.com/xms/index.php?oldid=73354  Contributors: Jcreer, Tdye

Converting TINS to Other Data Types  Source: http://www.xmswiki.com/xms/index.php?oldid=73361  Contributors: Bdolinar, Jcreer, Ksmith, Unjedai

Building Solids and 3D Meshes with TINs  Source: http://www.xmswiki.com/xms/index.php?oldid=73364  Contributors: Jcreer, Ksmith, Unjedai

Triangulation  Source: http://www.xmswiki.com/xms/index.php?oldid=73366  Contributors: Jcreer, Ksmith

TIN Files  Source: http://www.xmswiki.com/xms/index.php?oldid=66788  Contributors: Jcreer, Tdye

TIN Commands  Source: http://www.xmswiki.com/xms/index.php?oldid=73367  Contributors: Jcreer, Ksmith, Unjedai

Boreholes Module  Source: http://www.xmswiki.com/xms/index.php?oldid=39700  Contributors: Htran, Jcreer, Unjedai

Creating and Editing Boreholes  Source: http://www.xmswiki.com/xms/index.php?oldid=73371  Contributors: Jcreer, Ksmith, Tdye, Unjedai

Borehole Display Options  Source: http://www.xmswiki.com/xms/index.php?oldid=73373  Contributors: Jcreer, Ksmith, Unjedai

Borehole Tool Palette  Source: http://www.xmswiki.com/xms/index.php?oldid=73379  Contributors: Jcreer, Ksmith, Tdye

Borehole Hydrogeologic Units  Source: http://www.xmswiki.com/xms/index.php?oldid=73383  Contributors: Jcreer, Jdye, Unjedai

Converting Borehole Data  Source: http://www.xmswiki.com/xms/index.php?oldid=73385  Contributors: Jcreer, Ksmith, Tdye, Unjedai

Borehole Cross Sections  Source: http://www.xmswiki.com/xms/index.php?oldid=73390  Contributors: Bdolinar, Jcreer, Ksmith, Unjedai

Borehole Commands  Source: http://www.xmswiki.com/xms/index.php?oldid=73391  Contributors: Jcreer, Ksmith, Unjedai

Horizons  Source: http://www.xmswiki.com/xms/index.php?oldid=66792  Contributors: Alanlemon, Jcreer, Ksmith, Unjedai

Horizon Conceptual Model  Source: http://www.xmswiki.com/xms/index.php?oldid=58639  Contributors: Jcreer, Ksmith, Unjedai

Horizons Applications  Source: http://www.xmswiki.com/xms/index.php?oldid=73409  Contributors: Jcreer, Ksmith, Unjedai

Horizons to HUF  Source: http://www.xmswiki.com/xms/index.php?oldid=73416  Contributors: Alanlemon, Jcreer, Ksmith, Unjedai

Horizons Wizard  Source: http://www.xmswiki.com/xms/index.php?oldid=61382  Contributors: Alanlemon, Jcreer, Ksmith, Unjedai

Horizons to Solids  Source: http://www.xmswiki.com/xms/index.php?oldid=50559  Contributors: Alanlemon, Jcreer, Ksmith, Unjedai

Horizons to 3D Mesh  Source: http://www.xmswiki.com/xms/index.php?oldid=73419  Contributors: Alanlemon, Jcreer, Ksmith, Tdye, Unjedai

Solid Module  Source: http://www.xmswiki.com/xms/index.php?oldid=73420  Contributors: Jcreer, Ksmith

Solid Properties  Source: http://www.xmswiki.com/xms/index.php?oldid=66793  Contributors: Jcreer, Jdye

Solid Primitives  Source: http://www.xmswiki.com/xms/index.php?oldid=73426  Contributors: Jcreer, Ksmith, Wood

Solid Display Options  Source: http://www.xmswiki.com/xms/index.php?oldid=66794  Contributors: Jcreer, Ksmith, Wood

Solid Module Tool Palette  Source: http://www.xmswiki.com/xms/index.php?oldid=73431  Contributors: Jcreer, Unjedai
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Solids to Layered Mesh  Source: http://www.xmswiki.com/xms/index.php?oldid=73432  Contributors: Jcreer, Ksmith

Solids to HUF  Source: http://www.xmswiki.com/xms/index.php?oldid=73435  Contributors: Jcreer, Ksmith

Solids to MODFLOW Command  Source: http://www.xmswiki.com/xms/index.php?oldid=73437  Contributors: Jcreer, Ksmith

Solid Commands  Source: http://www.xmswiki.com/xms/index.php?oldid=61749  Contributors: Jcreer, Ksmith, Unjedai

2D Mesh Module  Source: http://www.xmswiki.com/xms/index.php?oldid=55700  Contributors: Jcreer, Ksmith

Creating a 2D Mesh  Source: http://www.xmswiki.com/xms/index.php?oldid=39725  Contributors: Bdolinar, Jcreer, Ksmith

Editing 2D Meshes  Source: http://www.xmswiki.com/xms/index.php?oldid=39726  Contributors: Jcreer, Ksmith, Unjedai

2D Mesh Settings  Source: http://www.xmswiki.com/xms/index.php?oldid=66796  Contributors: Jcreer, Ksmith, Tdye

2D Mesh Display Options  Source: http://www.xmswiki.com/xms/index.php?oldid=66797  Contributors: Jcreer, Jdye, Ksmith

2D Mesh Tool Palette  Source: http://www.xmswiki.com/xms/index.php?oldid=36008  Contributors: Ksmith, Unjedai

Converting a 2D Mesh to other types of Data  Source: http://www.xmswiki.com/xms/index.php?oldid=39728  Contributors: Jcreer, Ksmith, Tdye, Unjedai

Element types  Source: http://www.xmswiki.com/xms/index.php?oldid=66627  Contributors: Jcreer, Unjedai

2D Mesh Polygon Attributes  Source: http://www.xmswiki.com/xms/index.php?oldid=66798  Contributors: Jcreer, Ksmith

2D Mesh Commands  Source: http://www.xmswiki.com/xms/index.php?oldid=61748  Contributors: Jcreer, Ksmith, Unjedai

2D Grid Module  Source: http://www.xmswiki.com/xms/index.php?oldid=55701  Contributors: Jcreer, Ksmith, Unjedai

2D Grid Types  Source: http://www.xmswiki.com/xms/index.php?oldid=58851  Contributors: Jcreer, Tdye

Creating and Editing 2D Grids  Source: http://www.xmswiki.com/xms/index.php?oldid=66802  Contributors: Bdolinar, Jcreer, Ksmith, Unjedai

2D Grid Display Options  Source: http://www.xmswiki.com/xms/index.php?oldid=66800  Contributors: Jcreer, Ksmith, Tdye, Unjedai

2D Grid Tool Palette  Source: http://www.xmswiki.com/xms/index.php?oldid=37593  Contributors: Tdye, Unjedai

Converting 2D Grids  Source: http://www.xmswiki.com/xms/index.php?oldid=58911  Contributors: Jcreer, Ksmith, Tdye, Unjedai

2D Grid Commands  Source: http://www.xmswiki.com/xms/index.php?oldid=61750  Contributors: Jcreer, Ksmith, Unjedai

2D Scatter Point Module  Source: http://www.xmswiki.com/xms/index.php?oldid=55708  Contributors: Bdolinar, Jcreer, Ksmith, Unjedai

Creating and Editing 2D Scatter Point Sets  Source: http://www.xmswiki.com/xms/index.php?oldid=58925  Contributors: Bdolinar, Jcreer, Ksmith, Unjedai

2D Scatter Point Display Options  Source: http://www.xmswiki.com/xms/index.php?oldid=66803  Contributors: Jcreer, Jdye, Ksmith, Unjedai
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